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About the Name

Why the name “Eudora”?

When I was looking for a name for my new Post Office Protocol mail program,
I thought immediately of the title of a short story I’d read years before:
“Why I Live at the P.O.”  So I named the program after the author of the
story, Eudora Welty.
“Why I Live at the P.O.” can be found in a collection titled A Curtain of
Green  (Harcourt Brace Jovanovich).  I highly recommend reading it, and
anything else you can find by Ms. Welty.  Her stories are funny, sad, and
fascinating; she’s surely one of the great American writers.

                — Steve Dorner

December 1994
80-8050-2
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Eudora User Manual Tutorial

Getting Started
System Requirementsxe "Requirements"§

In order to use the Eudora electronic mail (e-mail) program (hereafter referred to as 
Eudora), the following system requirements must be satisfied:

· IBM PC or compatible (minimum 286 processor)

· Microsoft Windows 3.1 or later

· Ethernet card or modem for serial connection

· WinSockAPI 1.1 compliant networking package

· At least 640K of free RAM

· Account on a computer with a Post Office Protocol version 3 (POP3) server

Installing Eudora
Install Eudora as follows:

1. Create a new directory on your PC for the Eudora files (C:\EUDORA is a 
good choice).

2. Copy the Eudora freeware executable file (WEUDORA.EXE) into the 
directory you created in step 1.

3. Add the following environment variable to your AUTOEXEC.BAT file:

SET TMP=C:\TMP                 (or some temp directory)

Make sure that this directory exists.

4. Run Windows and add Eudora as a Program Item to a new or existing 
Program Group.

If you wish your mail files to reside somewhere other than where the executable 
resides, then you can set the mail directory by specifying the directory as the first 
parameter on the command line of the Program Item that you create for Eudora.

This is also useful if you want to have multiple users on one PC, each with their own 
mail directory.  Eudora will use the directory on the command line first.  If that isn’t 
present, the directory where the executable resides will be used.

Note: Always keep the Help file in the same directory as the executable.  

Eudora Configuration
Once you have installed Eudora, double-click on its icon to open the program.  
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Before you can actually use Eudora, you must give it some necessary pieces of 
information.  To enter this information, select xe "Configuration... 
command"§Configuration... from the Special menu.  The Configuration dialog is 
then displayed.

 

Configuration dialog  
To use Eudora, you must have an account on a computer that runs a POP3 server.  
This is the account to which your e-mail messages are delivered before they are 
transferred to the Eudora program on your PC.  In the xe "POP Account 
setting"§POP account field, type your login name for this account and the full 
(domain) name of the computer, separating them with an “@” sign.  For example, if 
your assigned login name is “carolyn,” and the name of the computer where you 
receive e-mail is “uxh.cso.uiuc.edu,” type "carolyn@uxh.cso.uiuc.edu" in this field.
In the xe "Real Name setting"§Real Name field, type your real name.  Your name, as 
it appears here, is displayed in parentheses after your return address in your outgoing 
mail.  It is also displayed in the sender column of all messages sent by you.

At this point, it is best to leave the other items unchanged and click OK.  You are 
now ready to use Eudora.  For a quick introduction to the program’s basic functions, 
see the Tutorial chapter of this document; for detailed explanations of all available 
Eudora functions, see the Reference chapter.
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Tutorial
Introduction

This tutorial introduces Eudora’s basic functions.  There are a host of other 
operations that are not described here.  For detailed explanations of all available 
Eudora functions, see the “Reference” chapter of this document. 

Creating an Outgoing Message
A good way to familiarize yourself with Eudora is to create an outgoing message.  xe 
"Message:Outgoing"§An outgoing message is one that you send to someone else.  

From the Message menu, select xe "New Message command"§New Message.  A new
xe "Composition window"§composition window is displayed with the blinking cursor 
situated at the start of the To: xe "Field"§field.

 

Composition window
Notice the icon bar of symbols between the title of the window and the To: field.  
You may ignore the icon bar for now; it is explained in the “Reference” chapter.  
Since it is easiest to experiment with Eudora by sending a message to yourself, type 
your own e-mail address in the To: field.  

Note that the xe "Message:Outgoing:From field"§From: field has been automatically 
filled in (and can’t be altered).   This is the message xe "Return address"§return 
address; it should be your own Post Office Protocol (POP) server account address.  

Press the [tab] key or point and click the mouse to move the cursor down to the xe 
"Message:Outgoing:Subject field"§Subject: field.  Typically, this field should contain
some brief text indicating what the message is about.  For this message, type the 
words Test Message.

Move the cursor past the remaining Cc:, Bcc:, and Attachments: fields down into the 
large area below them.  This area is reserved for the actual body of the message.  
Here you may type in whatever text you want.  When you finish your message 
(referred to throughout this tutorial as your test message) the composition window 
should look something like the example below.

 

Example test message, ready to send
Sending a Message 

xe "Message:Outgoing:Sending"§Notice the xe "Send button"§Send button in the 
upper right hand corner of the composition window.  To send a message in its current
state, simply click on this button.  Click it now. 
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Clicking the Send button
The composition window immediately closes, and the xe "Progress 
window"§progress window is momentarily displayed at the top of the screen.  Eudora
uses the progress window to report on the progress of lengthy operations.  In this 
case, it indicates that the message is being transferred out onto the network.

 

Progress window
Checking for and Receiving Mail

xe "Checking mail"§There are two ways to check your POP server to see if you have 
any new mail.  One way is automatic and is determined by the Check for mail every ?
minutes setting in the Configuration dialog.  The alternative is to check for mail 
manually whenever you want by selecting Check Mail from the File menu.  Do this 
manual check now.

xe "Checking mail:Entering password"§xe "Password:Entering"§Each time the 
Eudora program is opened, your password is requested prior to the first mail check, 
whether it is conducted automatically or manually. Upon the first check, such as now,
a dialog is displayed requesting the password of your POP account.  

Note: Your POP account password is provided to you by your system 
administrator.

 

Password dialog 
Type in the password and click OK.  If you make a mistake before clicking OK, 
simply backspace and re-enter the password correctly.  If your password is rejected, 
repeat the manual check by selecting Check Mail from the File menu and re-entering
your password.
Note: Remember that the Eudora password may be case-sensitive 

(depending on your POP server), so it must be typed in exactly or it is 
rejected.  If you are having trouble entering your password, verify that
the [Caps Lock] key is off.

After successfully entering your password, a progress window is momentarily 
displayed at the top of the screen indicating that an attempt to reach your POP 
account is being made.  

 

Progress window
If there is a network problem between you and the POP server, an alert is displayed 
(see below).  Consult with your Eudora support coordinator to rectify the problem.

 

Problem transferring mail
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Note: If you ever have a problem of this type, the numbers in the ()’s are 
very important.  Record these numbers for reference when reporting 
the problem.

Keep selecting Check Mail from the File menu until your test message arrives.  If 
the message doesn’t arrive in a minute or two, notify your Eudora support 
coordinator.  

When mail is found waiting in your POP account, the progress window remains at 
the top of your screen, allowing you to monitor the transfer of messages from the 
POP server to your PC.  

 

Progress window while downloading mail
This is followed by the new mail alert.  

 
New mail alert

Click OK.  The In mailbox window is displayed with your test message summary 
listed inside.

 

Message listed in the In mailbox
Messages are listed in mailbox windows as individual xe "Message 
Summary"§message summaries.  A message summary is divided into fields 
containing the status and priority of the message (these are discussed in the 
“Reference” chapter), the name or address of the sender, the time and date the 
message was sent, its size in K (K = 1024 bytes), and the contents of its Subject: 
field.
To select (highlight) the message summary, single-click anywhere on the summary.  
xe "Mailbox:Opening a message from"§To open the message, double-click on its 
summary.  Do this for your arrived test message to display it on your screen.

 

Test message display
Incoming messages are stored indefinitely in the In mailbox until they are deleted or 
transferred to another mailbox (as described later in this tutorial).
To close the message, either double-click the close box in the upper left hand corner 
of the message window or select Close from the File menu.  The In mailbox can also 
be closed in the same fashion.

Current Messages
Most Eudora commands can be applied either to an open message window or to 
highlighted message summaries in a mailbox window.  This allows Eudora users to 
apply commands (such as Transfer, Forward, and Reply) to messages without 
opening them first.  Whenever the term xe "Current message"§current message is 
used in this tutorial or in the “Reference” chapter, it refers to a message that is open 
and is in the topmost window or whose message summary is highlighted within a 
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mailbox window (see the following examples).  

 

When a message window is front most, it is the current message
 

A selected message summary is current
Examples of current messages
Replying To a Message

xe "Message:Incoming:Replying to"§xe "Reply"§For any current incoming message 
(an xe "Message:Incoming"§incoming message is one that someone has sent to you), 
you may easily initiate a reply message to its sender without having to create a new 
message from scratch.

Open the In mailbox by selecting In from the Mailbox menu.  Single-click on the 
message summary of your test message to highlight it.  From the Message menu, 
select Reply to initiate a reply to this message.

Note: Select Reply, not Reply To; the Reply To menu item is for use with 
the quick recipients list, which is described in the “Reference” chapter.

A new composition window is displayed, with the sender’s address (in this case, your 
own) automatically placed in the To: field of the header.  xe "> markers"§The 
original sender’s text is automatically included in the body of the message (prefixed 
by “>”  at the beginning of each line).  This text may be edited as needed.  You may 
enter more text in the reply message just as in any outgoing message.  At this time, 
move the insertion point to the area below the original message and type in some 
additional text.

 

Replying to a message
Do not send the reply message at this time.  Instead, save it as described in the 
“Saving an Outgoing Message” section.

Saving an Outgoing Message
xe "Message:Outgoing:Saving"§Sometimes it is convenient to save an outgoing 
message either as a safeguard when typing long messages, or for temporary storage 
so you can return to it at a later time for changes or additions before sending it.

To save any current outgoing message, such as your new reply message, select xe 
"Save command"§Save from the File menu.  This doesn’t close the composition 
window but it does save the version of the message (as it appears at the time of the 
save) in the xe "Out Mailbox"§Out mailbox, which holds all outgoing mail.

As long as an outgoing message has not been sent out on the network, you can make 
changes to it.  For example, if you want to also send the message to another person, 
you can add his/her address to the To: field  (any two addresses in a single field must 
be separated by a comma).  Having saved your reply message, close the reply 
message window.  Open the Out mailbox (from the Mailbox menu, select Out) to 
view the message summary.  Saved messages are identified by a bullet (o) in the far 
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left column of the message summary.

 

An outgoing message saved in the Out mailbox
Transferring a Message Between Mailboxes

xe "Mailbox:Transferring messages between"§Eudora helps you to organize your 
incoming mail by allowing you to create new mailboxes and easily transfer messages 
between them.

First, create a new mailbox while simultaneously transferring your test message into 
it.  From the Mailbox menu, select In to open the In mailbox.  Single-click on your 
test message summary to highlight it (making it the current message).  xe 
"Mailbox:Creating during transfer"§Then, select xe "New... command"§New... from 
the Transfer menu.  The New mailbox dialog is displayed.

 

New mailbox dialog
Any name can be typed in the new mailbox title field, but for this example, type 
Testing.  Click OK to create the new mailbox.  Because your test message was 
highlighted when you selected New... from the Transfer menu, it is automatically 
transferred into the Testing mailbox.  To verify this, select Testing from the Mailbox
menu.
Current messages can also be transferred between existing mailboxes.  To 
demonstrate this, move your original test message from the Testing mailbox back 
into your In mailbox.  Highlight the test message summary (click on it once in the 
Testing mailbox window) and then select In from the Transfer menu.

µ §

Message Transfer
 

After Transfer
Transferring a message
Deleting a Message

xe "Message:Deleting"§Messages are stored indefinitely in any mailbox until they are
explicitly deleted or transferred to another mailbox.  Outgoing messages that were 
saved for further changes remain in the Out mailbox until they are either sent or 
deleted.  Any current message can be deleted.

Open your test message from the In mailbox.  Then, select Delete xe "Delete 
command"§from the Message menu.  Next, open the Out mailbox and select (without
opening) the message summary of the reply message you generated previously.  
Again, select Delete from the Message menu to remove the message from the Out 
mailbox. 

As a safeguard, the Delete command doesn’t actually delete messages but transfers 
them to the xe "Trash mailbox"§Trash mailbox.  So, if you suddenly realize you 
mistakenly deleted a message, it can be recovered from and transferred out of the 
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Trash mailbox.  To manually delete messages held in the Trash mailbox, select xe 
"Empty Trash command"§Empty Trash from the Special menu.  
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Introduction

This section provides detailed explanations of all available Eudora functions.

Creating an Outgoing Message
xe "Message:Outgoing:Creating"§xe "Message:Outgoing"§An outgoing message is a 
message you send to someone else.  

To create an outgoing message, select xe "New Message command"§New Message 
from the Message menu.  A new xe "Composition window"§composition window 
entitled No Recipient, No Subject  is displayed with the blinking insertion point 
situated at the start of the To: field.  The composition window consists of the title bar,
the icon bar, the message header, and the message body.

 

The composition window
Title Bar
The title bar xe "Title bar"§provides information about incoming and outgoing 
messages, including the name of the sender (if it is an incoming message) or 
addressee (if it is an outgoing message), the time and date the message was delivered 
or sent, and a brief message summary.  New messages are labeled No Recipient, No 
Subject until they are sent or queued.  Queued message do not have a time stamp 
until they are sent.

Icon Bar
The xe "Icon bar"§icon bar consists of a series of objects that are displayed just under
the title bar.  It allows you to control your message’s priority, override some of your 
preference settings for that message only, and send or queue the message.  There are 
three combo boxes and five buttons.  Each of the five buttons may be turned on or off
for the current message by clicking on it.  If there is a shadow around the button 
(indicating that the button is depressed) the button is turned on.  The popup menus 
and buttons are described below.

 

The Icon Bar
Note: The default settings for the icon bar are determined in the Switches 

dialog (see the “Switches Dialog” section).

Priority Combo Box
xe "Icon bar:Priority combo box"§The leftmost object in the icon bar is the 
Priority combo box.  For most messages, the priority is (Normal).  If you want 
to indicate that your message is of higher or lower priority than a normal 



message, use this combo box.  Priorities are discussed in the “Message 
Priorities” section.

Signature Combo Box
xe "Icon bar:Signature combo box"§xe "Signature:Icon in icon bar"§The 
Signature combo box allows you to automatically attach your signature file to 
the end of each message you send.  Signatures are discussed in the “Creating a 
Signature” section.

Attachment Type Combo Box
xe "Attachment Type:Button in icon bar"§xe "Icon bar:Attachment Type 
combo box"§The Attachment Type combo box allows you to select what 
format documents that you attach to outgoing messages are encoded in:  
Multipurpose Internet Mail Extensionsxe "Multipurpose Internet Mail 
Extensions"§ (MIMExe "MIME"§) or Bin Hex.  MIME is best for recipients 
with MIME (for more information on MIME, see Appendix D) and Bin Hex is 
most compatible with old Macintosh mailers and previous versions of Eudora.

Quoted-Printable Encoding
xe "Quoted-Printable:Button in icon bar"§xe "Icon bar:Quoted-
Printable"§If this button is on, quoted-printable encoding may be used when 
sending messages that contain long lines of text or special characters.  When on,
it is used for all attachments.  It is recommended that this button always be on.

Word Wrap
xe "Icon bar:Word-Wrap"§xe "Word Wrap:Button in icon bar"§If this 
button is on, a carriage return is not required at the end of each line you type in 
an outgoing message; Eudora automatically wraps text to the next line, with line
breaks at roughly 76 characters per line.

Tabs in Body
xe "Icon bar:Tabs in Body"§xe "Tabs:Button in icon bar"§If this button is 
on, hitting the [tab] key within the message body results in xe "Tabs:Replaced 
with spaces"§Eudora inserting enough spaces to move the insertion point to the 
next tab stop (as specified in the Configuration dialog).  This mimics the way 
tabs work on many terminals.  xe "Tab key:Switching fields with"§If this button
is not on, hitting the [tab] key returns the cursor to the To: field of the message 
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header.

Keep Copy 
xe "Icon bar:Keep Copy"§xe "Keep Copies:Button in icon bar"§If this 
button is on, a copy of each sent message is kept in the Out mailbox (their 
summaries are marked with an “S” in the far left column of the Out mailbox 
window, indicating that they have been sent).  These messages are saved until 
they are deleted or transferred to a different folder.

Text As Document 
xe "Icon bar:Text As Document"§xe "Text As Document:Button in icon 
bar"§If this button is on, text files attached to messages are sent as separate 
documents.  If this button is off, text files are incorporated into the message as 
part of the message body.  The default for this button is set by the Always as 
Attachment option in the Switches dialog (see the “Switches Dialog" section).

Send or Queue
xe "Icon bar:Send button"§xe "Icon bar:Queue button"§If the Immediate 
Send option in the Switches dialog is turned on, the rightmost button in the icon
bar is labeled Send.  Clicking the Send button immediately sends the message.  
Otherwise, this button is labeled Queue, and has the same function as the Queue
for Delivery command under the Message menu (upon clicking this button, the 
message window closes and the message is held in the Out mailbox, marked 
ready for delivery).

Message Header
xe "Message:Outgoing:Header"§xe "Message:Outgoing:Body"§Outgoing message 
headers consist of six fields:  To:, From:, Subject:, Cc:, Bcc:, and Attachments:.  
Each field holds a different piece of information.  The To:, Subject:, Cc:, and Bcc: 
fields can be directly edited.

xe "Tab key:Switching fields with"§To move the insertion point from field to field, 
press the [tab] key or click in the desired field with the mouse.  When entering 
information into the fields, you can use the standard Windows text-editing tools 
provided under the Edit menu.  Here is a brief description of the intended contents of 
each field:

To:
xe "Message:Outgoing:To field"§The intended recipient’s e-mail address, or a 
nickname you have defined (see the “Creating and Using Nicknames” section).  
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Multiple addresses are allowed, but must be separated by commas.

From:
xe "Message:Outgoing:From field"§The sender’s e-mail address.  This is usually 
your POP account plus your real name.  You can use a return address other than your 
POP account by entering the desired address in the Return Address field of the 
Configuration dialog (see the “Configuration Dialog” section).

Subject:
xe "Message:Outgoing:Subject field"§Brief text indicating the contents of the 
message.  This field can be left blank (though it is a breach of e-mail etiquette to do 
so).

Cc:
xe "Message:Outgoing:Cc field"§E-mail address or nickname of person to whom a 
copy of the message is to be sent.  Multiple addresses are allowed but must be 
separated by commas.  This field may be left blank.

Bcc:
xe "Message:Outgoing:Bcc field"§“Blind” carbon copy.  Like addresses listed in 
the Cc: field, addresses listed here receive copies of the message.  Unlike addresses 
listed in the Cc: field, addresses listed here do not appear in the message header of the
recipients.  This is useful when you want to send a copy of a message to someone 
without everyone else knowing you did so.  Multiple addresses are allowed but must 
be separated by commas.  This field can be left blank.

Attachments:
xe "Message:Outgoing:Attachments field"§List of documents being sent along 
with the message.  Specify these through the Attach Document command under the 
Message menu (see the “Attachments” section).  To delete an attachment from a 
message, select it by single-clicking on the attachment title and press the [delete] key.
You cannot enter information directly into this field.  This field can be left blank.

Message Body
xe "Message:Outgoing:Body"§After filling in the fields, move the insertion point to 
the space below the message header.  Type the body of the message here.  Feel free 
to use the standard Windows text-editing tools provided under the Edit menu (see the 
“Summary of Menu Commands” section).

xe "Word Wrap"§If the Word Wrap button on the icon bar is turned on, you don’t 
need to press [Enter] at the end of each line of text.  The text wraps to the next line 
automatically.  If this option is not set, be sure to type [Enter] at the end of each line 
or your message may not be legible on the recipient’s computer.  To use tabs in the 
message body, press the Tabs in Body button in the icon bar.
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Saving an Outgoing Message for Later Changes
xe "Message:Outgoing:Saving"§Sometimes it is convenient to save an outgoing 
message either as a safeguard when typing long messages, or so you can return to it 
later to edit or add more text.  

To save the message while the outgoing message window is open, select xe "Save 
command"§Save from the File menu.  The message window does not close, but the 
current version of the message is saved in the Out mailbox.  You might notice that 
the title appearing at the top of the message window changes from No Recipient, No 
Subject to what you typed in the To: and Subject: fields of the message.

xe "Out Mailbox"§If you now close the message (by clicking the close box in the 
upper left-hand corner of the message window, or by selecting Close from the File 
menu), it can be re-opened from the Out mailbox for further changes.  As with any 
message summary listed in a mailbox window, it can be identified by the contents of 
its To: and Subject: fields. xe "Message Summary:Status of message:Sendable"§A 
bullet (o) in the far left column of a message summary listed in the Out mailbox 
indicates that the message is being indefinitely held there and is queueable.  Such 
messages remain in the Out mailbox until they are queued and sent or deleted.

 

A sendable message saved in the Out mailbox
xe "Message:Outgoing:Closing"§If you try to close an outgoing message window 
without specifically saving that version of the message, an alert is displayed asking if 
the message should be saved or the changes discarded.  xe 
"Message:Outgoing:Deleting"§If you select Discard and the message has never been 
saved, the message is deleted. 

 

Closing an unsaved composition window
Sending A Message

One-Step Send
xe "Message:Outgoing:Sending"§xe "Message:Outgoing:Sending, one-step"§If the 
Immediate Send option in the Switches dialog is turned on, select Send Immediately
from the Message menu to immediately send a current message.  xe "Send 
button"§Alternatively, the rightmost button appearing in the icon bar at the top of the 
current message window is labeled Send.  Click this button to send the current 
message.

 

Clicking the Send button
xe "Show Progress option"§If the Show Progress option in the Switches dialog is 
turned on, a progress window is displayed momentarily at the top of the screen 
indicating the progress of the transmission. 
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Progress Window
Two-Step Send
xe "Message:Outgoing:Sending, two-step"§Some people may prefer to compose 
many messages and transmit them all at once.  Eudora lets you queue messages in the
Out mailbox for delivery at a later time (this is particularly handy if you are not 
always connected to your network when using Eudora).  However, this is only 
possible if the xe "Immediate Send option"§Immediate Send option in the Switches 
dialog  is turned off. 

To accomplish the first step for any outgoing current message,  select xe "Queue For 
Delivery command"§Queue For Delivery from the Message menu.   Alternatively, 
the rightmost button appearing in the icon bar at the top of the current message 
window is labeled xe "Queue button"§Queue.  Click this button to queue the current 
message for later delivery.

 

Clicking the Queue button
Either of these selections closes the message window (if it was open), xe 
"Message:Outgoing:Saving"§saves the message in the Out mailbox and marks it as 
queued, meaning ready to be delivered.  Queued messages are marked by a xe 
"Message Summary:Status of message:Queued"§“Q” in the far left column of the Out
mailbox.

 

A Queued message in the Out mailbox
For the second step, select xe "Send Queued Messages command"§Send Queued 
Messages from the File menu.  This sends the queued message (or messages).  xe 
"Show Progress option"§If the Show Progress option in the Switches dialog is turned 
on, a progress window is displayed momentarily at the top of the screen indicating 
the progress of the transmission. 
Timed Messages
xe "Messages:Outgoing:Timed"§It is possible to tell Eudora to send a message at 
some specific time in the future.  To do this for the current outgoing message, select 
xe "Change Queueing... command"§Change Queueing... from the Message menu.  
The Change Queueing dialog is then displayed.

 

Change Queueing dialog
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If you choose xe "Right Now button"§Right Now, the message is sent immediately 
upon clicking the OK button.  If you choose xe "Next timeÉ button"§Next Time 
Queued Messages are Sent, the message is sent the next time queued messages are 
sent.  If you choose xe "On or After button"§On or After, you can use the time and 
date fields to fill in the time when the message should be sent.  The message is saved 
in the Out mailbox with a xe "Message Summary:Status of message:Timed"§Q in the
status column, just as if it were a normal queued message.  However, the message is 
not actually sent until the specified time arrives.
Note: For the message to be sent at the correct time, Eudora must be running

when the message is due to be sent.  If Eudora is not running, the 
message is sent the first time Eudora is run after the selected time has 
passed.

Sending Queued Messages on Check
If the Send on Check option in the Switches dialog is turned on, every time a manual 
or automatic mail check occurs, all queued messages are sent, thus saving you the 
step of selecting xe "Send Queued Messages command:Avoiding"§Send Queued 
Messages.  

Quitting with Queued Messages
xe "Quit command:With queued messages"§If you quit Eudora after you have queued
messages, but without sending them using Send Queued Messages, Eudora gives you 
the opportunity to send the messages before you quit.

 

Quitting with queued messages
xe "Quit command:With timed messages"§If you quit with timed messages, and the 
messages are due to be sent within the next 12 hours, Eudora warns you and gives 
you the opportunity to send them.

 

Quitting with timed messages
Editing a queued message
To edit a queued message, open the Out mailbox and double-click on the desired 
message summary to open its composition window.  Make the necessary edits and re-
queue the new version of the message with the xe "Queue For Delivery 
command"§Queue For Delivery or xe "Change Queueing... command"§Change 
Queueing... commands from the Message menu or the Save command from the File 
menu.  You can also re-queue the message using the Queue button on the icon bar.  
The message is returned to the Out mailbox with a queued status.  xe 
"Message:Outgoing:Closing"§If you close the changed message without choosing one
of these, an alert is displayed asking you to verify the changes.

Changing the Status of a Queued Message
xe "Message:Outgoing:Changing status of"§A message that is queued but as yet 
unsent may be unqueued using the xe "Change Queueing... command"§Change 
Queueing... command.  Open the Out mailbox and select the desired message 
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summary.  Then, select Change Queueing... from the Message menu and click on 
Don’t Send.  This changes the message status from queued (Q) to saved (o).  The 
message is held in the xe "Out mailbox"§Out mailbox until it is either deleted or re-
queued and sent.  

Note: You can also send a message immediately or change it to timed send 
using the Change Queueing... command.

Keeping Copies of Outgoing Messages
xe "Keep Copies"§Once a message is sent, it is put into the Trash mailbox unless the 
Keep Copies option in the Switches dialog is turned on or the Keep Copy button in 
the icon bar is on.  In these cases, the message is left in the xe "Out mailbox"§Out 
mailbox and is annotated with an xe "Message Summary:Status of message:Sent"§S 
in the far left column of the Out mailbox indicating that the message has been sent.

 

Copies of outgoing messages saved in the Out mailbox
Password Protection

xe "Checking mail:Entering password"§xe "Password:Entering"§There is password 
protection on mail checks to your account on the POP server.  Each time the Eudora 
program is opened, your password is requested prior to the first mail check, whether 
it is conducted automatically or manually.  If automatic checking is set (see the 
“Configuration Dialog” section), a dialog requesting your POP server account 
password is displayed upon first opening Eudora.  If automatic checking is disabled, 
the same dialog is displayed at the time of your first mail check. 

 

Password dialog
Type in your password and click OK.  If you make a mistake before clicking OK, 
simply backspace and re-enter the password correctly.  
If your password is rejected, an error message is displayed indicating that you have 
entered the wrong password.  Select Check Mail from the File menu to redisplay the 
password dialog.

 

Wrong password
Note: Remember that the Eudora password may be case-sensitive 

(depending on your POP server), so it must be typed in exactly or it is 
rejected.

xe "Password:Remembering"§xe "Password:Forgetting"§As long as it is running, 
Eudora remembers your password.  If you don’t want it to remember (when, for 
example, you are away from your PC), select xe "Forget Password 
command"§Forget Password from the Special menu.  At your next mail check you 
are prompted for your password again.  

xe "Password:Saving"§Another password-related option is xe "Save Password 
option"§Save Password, which is in the Switches dialog.  This option makes Eudora 
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remember your password from one session to the next (you NEVER have to enter 
your password again, even if you quit and restart Eudora).  This option should only 
be used if your PC is in a secure location.

xe "Password:Changing"§Finally, the xe "Change Password... command"§Change 
Password... command in the Special menu can be used to change your POP server 
password if your POP server machine is running a compatible password-change 
server.  You’ll be asked to enter your old password once, and your new password 
twice.

 

Changing a password with Eudora
Note: For information on password-change servers, see Appendix A of this 

manual.

Checking For and Receiving Mail
xe "Checking mail"§The xe "POP"§POP server is the machine where your mail is 
received and stored until it is transferred to the Eudora program on your PC.  Your 
POP server account is specified in the xe "POP Account setting"§POP Account 
setting in the Configuration dialog (see the “Configuration Dialog” section).

Note: To best understand the functioning of the POP server with respect to 
Eudora, please see Appendix C.

There are two methods to check your designated POP server to see if you have new 
mail.  One method is automatic and the other is manual.  Both methods deliver any 
mail addressed to you from the POP server to your PC.  Before any checks are made,
however, the POP server requests your account password.

Automatic Checking
xe "Checking mail:Automatic"§Eudora automatically checks for mail if you tell it 
how often to do so.  From the Special menu, select Configuration....  The 
Configuration dialog has a field entitled Check For Mail Every ? Minute(s).  Type in 
a value and Eudora automatically checks for mail at the desired interval whenever it 
is running (even if you are using other applications on your PC).  For example, if you
type in 15, Eudora checks for mail every 15 minutes.  In fact, 15 minutes is a good 
minimum intervalxe "Checking mail:Automatic:Minimum interval"§, as checking 
mail more frequently puts an unnecessary load on your POP server. 

Note: If automatic checking is set, the xe "Check Mail command"§Check 
Mail command under the File menu displays the next time that an 
automatic check is scheduled to occur.

When Eudora does an automatic check, you can be notified of new mail in one or all 
of three different ways: an alert dialog, a special sound, or the opening of the In 
mailbox.  These options are turned on or off in the Switches dialog (see the “Switches
Dialog” section).  In addition, if Eudora is minimized when new mail arrives, the 
minimize icon also changes when new mail arrives.

Note: For the sound alert to work, you may need a sound driver for the PC 
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speaker (see “Appendix A” for a source for this driver).
When you receive notice that new mail has arrived, select Eudora from the task list or
press [Alt] + [Tab] to switch to Eudora.  Mail arrives in the In mailboxxe "In 
mailbox"§.  The messages are listed in the order they are received, with the most 
recent message listed last.

 

Unread messages in the In mailbox
If the In mailbox is not already open, select In from the Mailbox menu.  xe "Message
Summary:Status of message:Unread"§Unread messages are designated by a bullet (o)
in the far left column of the message summary.  Double-click anywhere on a message
summary to open the message.  Incoming messages are saved indefinitely in the In 
mailbox until they are deleted or transferred to another mailbox.
Manual Checking
xe "Checking mail:Manual"§You may check for mail manually at any time by 
selecting xe "Check Mail command"§Check Mail from the File menu.  If you 
haven’t successfully entered your password since opening the Eudora program, you 
are prompted for it. 

If the xe "Show Progress option"§Show Progress option in the Switches dialog is 
turned on, the Progress window is displayed momentarily at the top of the screen as 
the POP server is checked.

 

The Progress window during a mail check
If there is a problem reaching the POP server, an error message alert is displayed.  To
rectify the problem, review the POP server settings in the Configuration dialog for 
correctness.  If there is no obvious error, contact your company’s Eudora support 
coordinator.

 

Error while checking mail
Note: If you ever have a problem of this type, the numbers in the ()’s are 

very important.  Record these numbers for reference when reporting 
the problem.

If there is new mail, it is transferred automatically from the POP server to Eudora on
your PC.  If the xe "Show Progress option"§Show Progress option in the Switches 
dialog is turned on, a progress window is displayed at the top of your screen allowing
you to monitor the mail transfer.  

 

Progress window while downloading mail
If the New Mail Notification: Alert option in the Switches dialog is turned on, the 
new mail dialog is displayed, stating that new messages have been delivered.
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New mail dialog
Depending on your settings, the xe "In mailbox"§In mailbox window may display.  
Mail usually arrives in the In mailbox.  xe "Message Summary:Status of 
message:Unread"§Unread messages in the In mailbox are designated by a bullet (o) 
in the far left column of the message summary.  Double-click anywhere on a message
summary to open the message.  Incoming messages are saved indefinitely in the In 
mailbox until they are deleted or transferred to another mailbox.
Leave Mail on Server Option
xe "Leave Mail on Server option"§During a mail check, Eudora normally transfers 
your incoming messages from your account on the xe "POP server"§POP server to 
your PC, and deletes them from the POP server.  This may prove awkward for people
who sometimes want to read mail from a secondary PC.  It results in non-
consolidated storage of messages – if you read mail through a secondary PC, you 
wouldn’t be able to act on that mail from your primary PC.

The Leave Mail on Server option in the Switches dialog solves this dilemma.  If this 
option is turned on, Eudora transfers all of your new messages from the POP server 
to the PC you are presently using (presumably a secondary PC), while keeping copies
of those messages in your account on the POP server. On the next mail check from 
the secondary PC, Eudora xe "Ignoring previously read messages"§ignores the copies
of previously read messages and looks for new ones.  

When using your primary PC, you should turn the Leave Mail on Server option off, 
so that all messages (new ones as well as copies of old ones you read through other 
PC systems) are transferred to and consolidated on the one primary system.  The 
Leave Mail on Server option should be used with care, since it can result in a buildup
of messages on the POP server machine.

xe "Leave Mail on Server option:Status header"§Note: Eudora looks for 
a xe "Status header"§Status: R header to determine if a message has 
been read.  Your POP server must cooperate for this to work; most do.

Skip Big Messages Option
If the xe "Skip Big Messages option"§Skip Big Messages option in the Switches 
dialog is turned on, Eudora does not download large messages (40K or larger).  
Instead, it downloads only the first few lines of such messages and adds a note at the 
bottom stating that the whole message has not been transferred.  This can be useful 
on slow connections.

Note: xe "Skip Big Messages option:Status header and"§Eudora requires 
some help from your POP server to make Skip Big Messages work 
properly.  Specifically, Eudora expects your server to add a xe "Status 
header"§Status: header once Eudora has downloaded the first few 
lines of the message.  Eudora uses that line as a signal that it already 
has the first few lines and doesn’t need to download them again.  

Note: The large message threshold can be changed in the [Miscellaneous] 
section of the EUDORA.INI file using the BigMessageThreshold entry.
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Stopping a Mail Check
xe "Checking mail:Stopping"§If you want to stop a mail check in the middle (because
it is taking longer than anticipated), press the [Esc] key.

Opening a Mailbox to Read a Message
xe "Mailbox:Opening"§To open a mailbox, select the desired mailbox from the list of
mailboxes under the Mailbox menu.  The mailbox window is then displayed.  

 

Opening a mailbox window
To open a “nested” mailbox (one that is contained within a mail folder), select the 
outermost folder from the Mailbox menu (folders are designated by an arrow next to 
their names).  This displays the submenu of mailboxes and/or folders within the outer
folder.  Select the desired mailbox (or continue selecting subfolders until the mailbox
can be selected).

 

Opening a mailbox in a mail folder
If any messages are stored in the mailbox, they are listed as individual message 
summaries.  A message summary usually consists of the message status and priority, 
the sender/recipient of the message, the date it was received, its size and the subject 
heading.  See the “Anatomy of a Mailbox Window” section for descriptions of these 
fields.

 

Message summaries listed in the In mailbox

To open a message, double-click on its message summary, or, if the message 
summary is current (highlighted), press the [xe "Enter key"§Enter] key.

 

Incoming message example
Creating a Mailbox

xe "Mailbox:Creating"§To create a new mailbox, select xe "New... 
command"§New... from the Mailbox menu.  The New Mailbox Dialog is displayed.

 

New mailbox dialog
Type in the new mailbox name and click OK. The mailbox is created and added to 
the Mailbox and Transfer menus.
You can also create mailboxes using the Mailboxes window under the Windows 
menu (see the “Mailboxes Window” section).  The Mailboxes window is most useful 
if you want to create several mailboxes at one time.

Creating a Mail Folder
xe "Mail folder:Creating"§Eudora allows you to create mail folders in which you 
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may keep one or more mailboxes and even other subfolders that hold additional 
mailboxes.  In other words, not only can mailboxes be organized into folders, but 
folders can be contained one within another.

To create a new mail folder, select xe "New... command"§New... from the Mailbox 
menu.  The New Mailbox Dialog is displayed. Type the name of the new mail folder 
and check the xe "Make it a Folder button"§Make it a Folder option.  Click OK to 
create the folder.

 

Creating a mail folder
The new folder name is displayed at the bottom of the list of mailbox names under 
the Mailbox and Transfer menus.  There is an arrow next to the name designating it 
as a folder and not as a mailbox.  You cannot transfer messages into this folder, 
however, since messages must be in mailboxes and you have not yet created a 
mailbox within the folder.  Therefore, the New Mailbox Dialog is displayed again.  
Now, type the name of the mailbox you want to create within the newly-created 
folder and click OK.
Creating a Mailbox Within a Folder
xe "Mailbox:Creating mailboxes in folders "§To create a new mailbox within a 
particular folder, select that folder from under the Mailbox menu and choose xe 
"New... command"§New... from the submenu that is displayed.  

 

Selecting the New... command from a submenu
The New Mailbox Dialog is displayed.  Type in the new mailbox name and click 
OK.  The mailbox is created and added to the Mailbox and Transfer menus.  You can
also create subfolders in the same manner.  Just check the xe "Make it a Folder 
button"§Make it a Folder option.

Anatomy of a Mailbox Window
xe "Mailbox:Mailbox window"§Mailbox windows are one of the most important 
elements of Eudora.  Each mailbox window consists of a title bar, icon bar, and list of
message summaries.

 

The mailbox window
Title Bar
xe "Mailbox:Mailbox window:Title Bar"§The title bar provides the mailbox name.

Icon Bar
xe "Mailbox:Mailbox window:Icon Bar"§The icon bar consists of seven buttons that 
are displayed just under the mailbox title.  Each button controls a specific action 
relating to the mailbox or any current (highlighted) message summaries.
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Mailbox Size Button
xe "Mailbox:Mailbox window:Icon bar:Mailbox Size Button"§The leftmost 
object in the icon bar is the mailbox size button.  Three numbers are displayed 
on this button.  The first is the xe "Mailbox:Number of messages in"§number of
messages in the mailbox; the second is the total amount of xe "Mailbox:Space 
messages require in"§space those messages require; and the third is the amount 
of disk space that is wasted in the mailbox.  The example mailbox above 
contains four messages which take 1K of disk space.  It also has 2K of wasted 
space.

Eudora occasionally recovers this xe "Mailbox:Waste space in"§wasted space 
on its own.  To force Eudora to recover this wasted space for the current 
mailbox, click on this button.  To force Eudora to recover this space for all 
mailboxes, select xe "Compact Mailboxes command"§Compact Mailboxes 
from the Special menu.

Trash Button
This button transfers all selected messages in the mailbox to the Trash mailbox. 
Its function is identical to the Delete command under the Message menu (see 
the “Deleting a Message” section).

Reply Button
xe "Mailbox:Mailbox window:Icon bar:Reply Button"§This button 
generates a reply to each selected message in the mailbox.  Its function is 
identical to the Reply command under the Message menu (see the “Replying to 
a Message” section).

Reply All Button
xe "Mailbox:Mailbox window:Icon bar:Reply All Button"§This button 
generates a reply to each selected message in the mailbox which includes the 
sender of the original message and everyone who received it.

Forward Button
xe "Mailbox:Mailbox window:Icon bar:Forward Button"§This button 
generates a forward message for each selected message in the mailbox.  Its 
function is identical to the Forward command under the Message menu (see the 
“Forwarding a Message” section).
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Redirect Button
xe "Mailbox:Mailbox window:Icon bar:Redirect Button"§This button 
generates a redirect message for each selected message in the mailbox.  Its 
function is identical to the Redirect command under the Message menu (see the 
“Redirecting a Message” section).

Print Button
xe "Mailbox:Mailbox window:Icon bar:Print Button"§This button prints 
each selected message in the mailbox.  Its function is identical to the Print... 
command under the File menu (see the “Printing” section).

Message Summaries
xe "Message Summary"§Each line in a mailbox window represents one message and 
is called a message summary.  To select a message summary, single-click on it.  
There are several ways to select more than one summary.  xe "Mailbox:Mailbox 
window:Range selection in"§You can select a summary and drag through the ones 
you want to select.  You can select one summary, hold down the [Shift] key, and 
select another summary to select both summaries and all the summaries between 
them.  Finally, you can hold down the [Ctrl] key and select individual summaries.  
This allows you to make xe "Mailbox:Mailbox window:Disjoint selection 
in"§“disjoint” selections.

 

Disjoint selections in a mailbox window
Message Summary Columns
Each message summary is divided into five columns:  Status/Priority, 
Sender/Recipient, Date, Size, and Subject.

 

Message summary columns for the In mailbox
The xe "Message Summary:Status of message"§xe "Message Summary:Priority 
of messages"§Status/Priority column displays two items.  The first is the message 
statusxe "Status, message"§, which is one of the following:
· The message has not been read (all mailboxes except Out), or is queueable but

has not been queued (Out mailbox only).

xe "Message Summary:Status of message:Read"§xe "Message Summary:Status of 
message:Not sendable"§<blank> The message has been read (all 
mailboxes except Out), or is not yet able to be queued because it has no 
recipients (Out mailbox only).

xe "R message status"§xe "Message Summary:Status of message:Replied"§R Reply has 
been chosen for the message.
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xe "Message Summary:Status of message:Forwarded"§xe "F Message status"§F
Forward has been chosen for the message.

xe "D message status"§xe "Message Summary:Status of message:Redirected"§D
Redirect has been chosen for the message.

xe "S message status"§xe "Message Summary:Status of message:Sent"§S
The message has been sent (outgoing messages only).

xe "- message status"§xe "Message Summary:Status of message:Unsent"§-
The message was transferred from the Out mailbox before being sent.

The xe "Message Summary:Priority of messages"§message priority is displayed 
as follows:

µ § Highest priority.

µ § High priority.

<blank> Normal priority.

µ § Low priority.

µ § Lowest priority.

For more information on message priorities, see the “Message Priorities” section.

The xe "Message Summary:Sender/Recipient in"§Sender/Recipient column shows the
sender of the message (for incoming messages) or the recipient or intended recipient 
(for outgoing messages).

The xe "Message Summary:Date in"§Date column displays the date and time the 
message was sent, or, for timed messages, the date and time the message is scheduled
to be sent.

Note: The xe "Date format"§date is formatted according to the date format 
specified in the Date/Time applet in the control panel .
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The xe "Message Summary:Size in"§Size column displays the size of the message, in 
K (K = 1024 bytes).

The xe "Message Summary:Subject in"§Subject column displays the subject of the 
message.  This information was typed into the message header by the sender.

Deleting a Message
xe "Message:Deleting"§As a safeguard against inadvertent deletions, two steps are 
required to delete a message in Eudora.  For any current message, choose xe "Delete 
command"§Delete from the Message menu.  This does not actually delete the 
message, but transfers it to the xe "Trash mailbox"§Trash mailbox.  To delete 
messages from the Trash mailbox, select xe "Empty Trash command"§Empty Trash 
from the Special menu.  xe "Quit command:And emptying Trash"§Quitting the 
program also empties the contents of the Trash mailbox when xe "Empty Trash on 
Quit option"§the Empty Trash on Quit option in the Switches dialog is turned on.  
Finally, if you want to delete just a few messages from the Trash mailbox, highlight 
them and select Delete from the Message menu or hit the Trash Button on the 
mailbox.  Deleting a message that’s already in the Trash removes it from Eudora 
completely.

xe "Message:Deleting:Unread/Queued"§Also, unless the xe "Easy Delete 
option"§Easy Delete option in the Switches dialog is turned on, any attempt to delete 
a message that you have never opened (or a Queued message that hasn’t been sent) 
results in Eudora asking for confirmation before proceeding with the deletion.

 
Warning for deleting unread or unsent messages

Compacting Mailboxes: Recovering Storage Space 
xe "Mailbox:Compacting"§xe "Mailbox:Waste space in"§Even after a message has 
been deleted with the two-step process described above, the storage space which that 
message originally required is still taken.  Normally, Eudora recovers this space 
automatically when it becomes troublesome.  However, if disk space is very tight, 
you can force this to happen earlier than usual.  In order to reclaim the wasted storage
space in all mailboxes, select the xe "Compact Mailboxes command"§Compact 
Mailboxes from the Special menu.

Mailboxes can also be compacted individually using the Mailbox Size button in the 
mailbox icon bar.  To force Eudora to recover wasted space for a current mailbox, 
click on this button.  

xe "Mailbox:Compacting:Thresholds for automatic"§Note: Eudora compacts 
mailboxes automatically when you close them under either of two 
conditions.  Mailboxes are compacted if the amount of wasted space in
the mailbox is greater than the amount of space the messages in the 
mailbox use, or if the amount of space wasted in the mailbox is greater
than 5% of the free space on the volume that contains it.
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Transferring a Message to a Different Mailbox
xe "Mailbox:Transferring messages between"§xe "Message:Transferring"§Messages 
may be transferred between any two mailboxes.  For any current message, select the 
mailbox to which the message should be transferred from the Transfer menu.  The 
message is transferred from its previous location to the selected mailbox.

 

Transferring a message
xe "Mailbox:Transferring messages between:Copying during"§xe 
"Message:Transferring:Copying during"§If you hold down the [Shift] key while 
transferring a message, the message is copied into the new mailbox instead of 
transferred.  This is useful if you want to file a message in more than one mailbox.
Creating a Mailbox During Transfer
xe "Mailbox:Transferring messages between:Creating mailboxes during"§xe 
"Message:Transferring:Creating mailboxes during"§To create a mailbox and transfer 
the current message into it at the same time, select xe "New... command"§New... 
from the Transfer menu instead of the name of a mailbox.  The New Mailbox Dialog
is displayed.

 

New mailbox dialog
Type in the new mailbox name and click OK.  The mailbox is created and added to 
the Mailbox and Transfer menus.  The current message is also transferred into the 
new mailbox.  However, if you check the xe "DonÕt transfer, just create 
button"§Don’t transfer, just create mailbox option, the mailbox is created but the 
message isn’t transferred into it.
You can also create mailboxes using the Mailboxes dialog under the Windows menu 
(see the “Mailboxes Window” section) or using the Mailbox menu (see the “Creating 
a New Mailbox” section).  The Mailboxes window is most useful if you want to 
create several mailboxes at one time.

Creating a Mailbox Folder During Transfer
xe "Mail folder:Creating during transfer"§xe "Mailbox:Transferring messages 
between:Creating mail folders during"§xe "Message:Transferring:Creating mail 
folders during"§Eudora allows you to create mail folders in which you may keep one 
or more mailboxes and even other subfolders that hold additional mailboxes.  In other
words, not only can mailboxes be organized into folders, but folders can be contained
one within another.

To create a new mail folder during message transfer, select xe "New... 
command"§New... from the Transfer menu instead of the name of a mailbox.  The 
new mailbox dialog is displayed.  Type the name of the new mail folder and check 
the xe "Make it a Folder button"§Make it a Folder option.  Click OK to create the 
folder.
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Creating a mail folder
Your message can’t be transferred, however, since messages must be in mailboxes 
and you have not yet created a mailbox.  Therefore, the new mailbox dialog is 
displayed again.  Now, type the name of the mailbox you want to create within the 
newly-created folder and click OK to complete the transfer.  
The new folder name is displayed at the bottom of the list of mailbox names under 
the Mailbox and Transfer menus.  There is an arrow next to the name designating it 
as a folder and not as a mailbox.  
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Mailboxes Window
xe "Mailboxes window"§Mailboxes and mail folders provide a structured way for 
Eudora users to organize received messages.  The Mailboxes window allows you to 
create new mailboxes and folders and to remove and rename them.  You may also 
want to move mailboxes and folders from one folder to another one.  

To accomplish any of these tasks, choose xe "Mailboxes command"§Mailboxes from
the Window menu.  The Mailboxes window is displayed.

 

The Mailboxes window
The window has two identical listings with scroll bars, each entitled Eudora (or 
whatever the name of the directory holding your mail is – see the “Mail Storage” 
section).  These list the names of the mailboxes and folders you have created (folders 
are identified by a folder icon to the left of the folder name).  This list is similar to 
that displayed under the Mailbox and Transfer menus, except that the In, Out, and 
Trash mailboxes aren’t included.  Underneath each of the lists are buttons labeled 
Rename, New, and Remove.  Between the lists are two additional buttons labeled 
Move, each pointing from one list to the other. 
xe "Mailboxes window:Opening a mailbox from"§Double-clicking on any of the 
mailboxes in a list opens that mailbox window on the screen.  Individual messages 
can be selected, opened, and otherwise manipulated from there.

Finding the Mailbox or Folder
xe "Mailboxes window:Moving around in"§If the Mailbox window isn’t big enough 
to display all of your created mailboxes and folders, use the scroll bar on the right 
side of either list to view the rest of the mailboxes and folders. 

Double-clicking on a folder (denoted with an icon of a folder to the left of its name) 
changes the current title of the list from Eudora to that of the chosen folder.  The 
contents of the list also change to the names of mailboxes and subfolders contained in
the chosen folder.

 

Opening a mail folder
To move back out of the subfolder to the folder that contains it, double-click on the 
entry at the top of the list consisting of two periods (..). 

 

Moving back out of a mail folder
Removing a Mailbox or Folder

xe "Mailboxes window:Removing mailboxes with"§xe "Mailboxes 
window:Removing mail folders with"§xe "Removing mailboxes"§xe "Removing mail
folders"§With the Mailboxes window open, use the scroll bar and selection tool to 
locate the name of the mailbox or folder that you want to remove.  
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Note: You can perform this function using either of the two lists in the 
Mailboxes window.  It is not necessary to locate a mailbox or folder in
both lists before deleting it.

Once the desired mailbox/folder is found, click on it once to select it.  Then, click on 
the Remove button that is located below the list.

 

Starting to remove a mailbox
A dialog is then displayed asking you to confirm the mailbox removal.  Click on the 
Remove It button to remove the mailbox.

 

Mailbox removal dialog
xe "Mailboxes window:Selecting multiple mailboxes"§If you press the [Ctrl] key 
while selecting from a list of mailboxes/folders, you can select more than one 
mailbox or folder simultaneously.  When you click on the xe "Mailboxes 
window:Remove button"§Remove button, the mailbox removal dialog is displayed to
verify the removal.  The dialog contains the name of the first mailbox you have 
selected.  If you click on xe "Remove It button"§Remove It, Eudora removes that 
mailbox, and then displays another dialog for the next mailbox.  If you click on xe 
"Remove All button"§Remove All, all of the selected items are removed without any 
further prompts.
If you choose to remove a mailbox in which messages are still stored, or a folder in 
which other mailboxes or folders are stored, all messages/mailboxes/folders 
contained within the selected mailbox are also removed.

 

Removing a mailbox with messages in it
Renaming a Mailbox or Folder
xe "Mailboxes window:Renaming a mailbox with"§xe "Mailboxes window:Renaming
a mail folder with"§xe "Renaming a mailbox"§xe "Renaming a mail folder"§With the
Mailboxes window open, use the scroll bar and mouse pointer to locate the name of 
the mailbox/folder that you want to rename.

Note: You can perform this function using either of the two lists in the 
Mailboxes window.  It is not necessary to locate a mailbox or folder in
both lists before renaming it.

Once the desired mailbox/folder is found, click on it once to select it.  Then, click on 
the Rename button that is located below the list.xe "Mailboxes window:Rename 
button"§  

A dialog is then displayed requesting the new name.  Type in the new name and click
on Rename to rename the mailbox/folder.

 

Renaming a mailbox or folder
Creating a New Mailbox or Folder
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xe "Mailboxes window:Creating a mailbox with"§xe "Mailboxes window:Creating a 
mail folder with"§xe "Mailbox:Creating with Mailboxes window"§xe "Mail 
folder:Creating with the Mailboxes window"§New mailboxes and folders can be 
created using the Transfer menu, as described in the “Creating Mailboxes During 
Transfers” section, or they can be created using the Mailboxes window.

With the Mailboxes window open, double-click on the folder in which the new 
mailbox/folder is to be created to open it.  Its name is displayed above the list, and its
contents are displayed therein.

Note: You can perform this function using either of the two lists in the 
Mailboxes window.  It is not necessary to locate a folder in both lists 
before creating a new mailbox or folder inside it.

Click on the xe "Mailboxes window:New button"§New button that is located below 
the list.  

 

Creating a new mailbox
A dialog is displayed requesting the name of the new mailbox.

 

Naming a new mailbox
Type in the new name, check the Make it a Folder option if you want to do so, and 
click OK.  The new mailbox/folder is displayed in the designated folder’s listing.  
The newly created mailbox/folder is also added to the Mailbox and Transfer menus.
Moving a Mailbox from one Folder to Another
xe "Mailboxes window:Moving a mailbox with"§xe "Mailbox:Moving with 
Mailboxes window"§The Mailboxes window provides the only means for moving 
mailboxes to other folder locations.  This is why there are two lists in the window.

To begin, locate in one of the lists the mailbox you want to move.  In the other list, 
find and open (by double-clicking on the name) the destination folder so that its name
is displayed above the list and its contents are displayed.  Then, select the mailbox 
you want to move.  Click on the xe "Move button"§Move button that points from the 
list containing the item you want to move to the list displaying the destination folder. 
The chosen mailbox is moved to its new location. 

 

 
Moving a mailbox, before and after
Attachments

xe "Messages:Outgoing:Attaching document to"§xe "Attachments"§Any document 
can be attached to and sent with a Eudora message.  To attach a document to a 
current outgoing message, select xe "Attach Document... command"§Attach 
Document... from the Message menu.  A standard file dialog is displayed.  Once the 
desired document is located, select it and click on the OK button to attach the 
document to the message. 
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Attaching a document

The attached document functions like a “rider” to the e-mail message, and thus it 
does not appear within the message text.  Instead, the full path name of the document 
is displayed automatically in the xe "Message:Outgoing:Attachments 
field"§Attachments: field of the message header.

 

An outgoing message with an attached document
Note: A document cannot be attached to a message through manual editing 

of the Attachments: field.
When the message is sent, the attached document is formatted according to the 
selection in the Attachment Type combo box in the message icon bar (see the “Icon 
Bar” section).

xe "BinHex:And plain TEXT documents"§If the chosen document is a plain text file 
(and if the xe "Always as Attachment option"§Always as Attachment option in the 
Switches dialog is turned off, or the Text as Document button in the icon bar is off 
and you cancel the attach as), it is not encoded in any special format before being 
sent, but rather it is added to your message as though you had typed it in manually.

Multiple Attachments
xe "Attachments:Multiple"§Multiple documents may be sent with a single message, 
but each document to be attached must be selected as described above.  

Detaching a Document
xe "Attachments:Detaching"§To detach a document before the message is sent out, 
click anywhere on the name of the document in the xe 
"Message:Outgoing:Attachments field"§Attachments: field of the composition 
window.  This selects the entire attachment name.  Then, press the xe "Delete 
key"§[Delete] or [Backspace] key or select xe "Clear command"§Clear from the 
Edit menu.

Receiving an Attachment
xe "Attachments:Receiving"§There are two primary ways you can receive an 
attachment from another Eudora user.  One way prompts you to choose what 
directory the attachment should be placed in and to assign the attachment’s name.  
The other way automatically receives all attachments in a pre-specified directory on 
your disk.  Both ways are described below.

Manual Receive of Attachments
xe "Attachments:Receiving:Manually"§Unless you choose the xe "Automatically 
save attachments to option"§Auto Receive Attachment Directory in the Configuration
dialog, whenever you receive a message with an attachment from another Eudora 
user a standard file dialog is displayed.  Use this dialog to choose where to put the 
document and what to call it.
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Manually receiving an attachment
Eudora automatically decodes the attachment, and it arrives on your disk just the way
it left the sender’s.

Not Saving an Attachment
xe "Attachments:Receiving in encoded form"§You may choose not to save the 
attached document.  This is done by clicking the Cancel button in the above dialog.  
In such a case, the attachment is included in the body of the message. The document 
has to be saved to a file and decoded manually to appear in its proper format.

Saving Attachments Automatically
xe "Attachments:Receiving automatically"§The most convenient way to save 
attachments is to a pre-specified directory on your disk.  To set this up, select 
Configuration... from the Special menu.  In the dialog, click on the large button next
to xe "Auto Receive Attachment Directory option"§Auto Receive Attachment 
Directory:.

 

Starting to select an attachments folder
A dialog is displayed through which you may choose a directory into which arriving 
attachments are automatically saved.

 
Selecting an attachments folder

Double-click on the name of the directory to select it (its name should be displayed 
above the list). Then, click on the xe "Use Directory button"§Use Directory button.  
The dialog then closes, leaving the Configuration dialog displayed.  The name of the 
directory you just selected now displayed in the button.  If you ever want to specify a 
different directory to receive attachments, simply click on this button and the dialog 
for choosing an attachments directory is redisplayed.  

In order for the directory to be used, the Auto Receive Attachment Directory: option 
must also be checked.  Eudora checks this for you when you select a directory.

 

An attachments folder is selected
Note: If at some future time Eudora cannot find your selected directory, it 

unchecks the Auto Receive Attachment Directory: option.  However, 
the name of the directory remains in the button until another directory 
is selected.

When invoking this option, attachments are decoded automatically and saved directly
into the selected directory.  The name given your attachments is recorded in the 
message from which they came.  xe "Attachments:And duplicate names"§If you 
receive multiple attachments with the same name, a number is added to each 
attachment’s name.

Non-Eudora Users Receiving Attachments
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If you send an attachment to someone who doesn’t use Eudora, the attached file is 
included at the end of the message in either MIME or xe "BinHex"§Bin Hex format, 
depending on how you choose to send it.  It is not usable until the recipient has 
decoded it using an appropriate decoding application.

Replying to, Forwarding, or Redirecting an Incoming Message
This section describes the Reply, Forward, and Redirect commands found in the 
Message menu.  These commands are different from the Reply To, Forward To, and 
Redirect To commands found in the same menu.  This latter set of commands is used 
with the Quick Recipient list (see the Using the Quick Recipient List section for 
descriptions of these commands).

Replying to a Message
xe "Message:Incoming:Replying to"§To reply to a current message, select xe "Reply 
command"§Reply from the Message menu.  A new message window is displayed, 
with the original sender’s address automatically placed in the xe 
"Message:Outgoing:To field"§To: field of the header.  The original sender’s text is 
also automatically included at the beginning of the reply message (prefixed by “>”  at
the beginning of each line).  This text may be edited or deleted as needed.   
Additional text may be entered into the reply just as in any outgoing message.  The 
reply can then be saved for further changes, or simply sent.

 

A message and its reply
An incoming message for which the xe "Reply command"§Reply command has been 
used is identified by an “xe "R message status"§R” in its message summary.

 

‘R’ indicates that the message has been replied to
Modified Forms of Reply
There are some variations of the Reply command.

Reply all:
xe "Message:Incoming:Replying to all"§xe "Reply All"§If you hold down the 
[Shift] key when selecting xe "Reply command"§Reply from the Message menu, the 
reply message is sent to the sender of the original message and to everyone who 
received it.  This is useful for carrying on group discussions electronically.  However,
if the xe "Reply All option"§Reply All option in the Switches dialog is turned on, 
reply all is the default, and you must hold down the [Shift] key to reply only to the 
message sender.
Don’t include self:
xe "Message:Incoming:Replying to all, but not self"§If the xe "Include Self 
option"§Include Self option in the Switches dialog is turned off, Eudora does not 
include your return address in the reply all (see the “Include Self” section for 
information on how Eudora determines who you are).
Forwarding a Message
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xe "Message:Incoming:Forwarding"§You may want to relay, or forward, messages to
other users.  To do this, select xe "Forward command"§Forward from the Message 
menu for any current received message.  This transfers the header and body of the 
received message, denoted with “xe "> markers"§>” markers at the beginning of each
line, to the body of a new message window.  There, you must fill in the empty xe 
"Message:Outgoing:To field"§To: field in the message header with the address of the 
person to whom you want the message forwarded.  The existing text may be edited, 
and more text may be added to the message.  A forwarded message is identified (in 
the xe "Message:Outgoing:From field"§From: field) as coming from you.

µ §

Forwarding a message
An incoming message for which the Forward command has been used is identified by
an “xe "F message status"§F” in its message summary.

 

‘F’ indicates that the message has been forwarded
Redirecting a Message
xe "Message:Incoming:Redirecting"§Eudora provides a way to redirect messages that
you decide were more appropriately sent to someone besides yourself.  To do this 
select xe "Redirect command"§Redirect from the Message menu for any current 
incoming message.  A new message window is displayed, and you should type in the 
appropriate recipient in the xe "Message:Incoming:To field"§To: field of the header.  
The address in the xe "Message:Outgoing:From field"§From: field is that of the 
person who originally sent the message, by way of your address.  In addition, there 
are no “>” markers at the beginning of each line of the original text.  However, you 
may edit or add more text to the message.

µ §

Redirecting a message
An incoming message for which the Redirect command has been used is identified by
a “xe "D message status"§D” in its message summary.

 

‘D’ indicates that the message has been redirected
Redirect and Signatures
xe "Signature:And redirect"§When you use Redirect, your signature file (described in
the “Creating a Signature” section) is not added to the message when it is sent, unless
the message was originally created by you.  Eudora considers the message to be 
originally from you if the address in the xe "Message:Incoming:Redirecting & From 
field"§From: field exactly matches your return address setting (or, if you have not 
entered a return address in the Configuration dialog, your POP account setting).  

Easy Repeat (“Canned”) Messages Using Redirect
xe "Messages:Using Redirect to repeat"§If you find yourself sending the same 
message over and over again to different people, you can keep a “canned” copy of 
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that message and send it easily using the Redirect command.  To do this, first 
compose a new message as you normally would, but leave the To: field blank.  Save 
the message, and, if desired, use the Transfer menu to move it from the Out mailbox 
into another mailbox (named “Canned Messages,” perhaps).  When you want to send 
the message to someone, locate the message and highlight it in the mailbox window 
(do not open it).  Then, select xe "Redirect command"§Redirect from the Messages 
menu, fill in the To: field, and send the message.

Creating and Using Nicknames
xe "Nicknames"§When addressing messages, Eudora supports the use of nicknames 
in place of full user names.  A nickname (sometimes called an alias) is an easily 
remembered, shorter substitute for an actual e-mail address or group of addresses.  
Typically, nicknames are created for persons with whom one has repeated 
correspondence, and hence serve as a typing and reference shortcut.  Eudora allows 
nicknames to be used in place of proper e-mail addresses in the To:, Cc:, and Bcc: 
fields in the headers of outgoing messages.

To create, edit, or remove a nickname, select xe "Nicknames... 
command"§Nicknames... from the Window menu.  The Nicknames window is then 
displayed.  This window is divided into three main fields.  The Nickname: field lists 
all your nicknames; the xe "Nicknames window:Address(es) box"§Address(es): field 
displays a selected nickname’s xe "Nicknames:Expansion"§expansion (the addresses 
that the nickname represents); and the xe "Nicknames window:Notes box"§Notes: 
field contains your private notes on a nickname.

 

The Nicknames window
Adding New Nicknames
xe "Nicknames window:Adding nicknames"§To add a new nickname, click on the xe 
"Nicknames window:New button"§New button.  The new nickname dialog is 
displayed prompting you for the name of the new nickname.

 

New nickname dialog
Type the name of the new nickname.  If you want this nickname to show up on the xe
"Quick Recipient list:Adding new nickname to"§Quick Recipient list under the 
Message menu (see the “Using the Quick Recipient List” section), click on the xe 
"Put it on the recipient list button"§Put it on the recipient list option.  Then, click 
OK.
The new nickname is displayed in the Nicknames: field of the Nicknames window, 
and the insertion point is placed in the Address(es): field.  Type the complete e-mail 
address of the person to be represented by the nickname.

 

Entering an address for a nickname
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xe "Nicknames window:Adding names to nicknames"§If you’d like to add someone’s
proper name to the address that you specify, just put it in parentheses after the e-mail 
address.
Note: Be aware that the proper name is put in the To: field of mail messages 

along with the full address.
You may also type a series of many e-mail addresses (and even other nicknames), 
separated by xe "Commas"§commas or returns ([Enter]), in the xe "Nicknames 
window:Address(es) box"§Address(es) section.  These multiple addresses are 
represented by the single entered nickname.  In this way, a nickname can be used for 
a group xe "Mailing list"§mailing list.

 

Using a nickname as a mailing list
Note: The Nicknames window is the only place where it is permissible to use 

the [Enter] key to separate addresses.  Everywhere else, you must use 
commas.

The xe "Nicknames window:Notes box"§Notes: field can be used to enter any text 
you’d like to associate with a nickname, such as the addressee’s company, title, or 
phone number.

 

Entering notes for a nickname
Note: The contents of the Notes field is not put in mail you send.
One nickname can point to another nickname, which can point to still another, and so
on; eventually, however, the nickname must end in a real address or group of 
addresses.  For example, Eudora Staff contains PJ in its expansion, and PJ is itself a 
nickname for pjp@muffininc.com in the following example.

 

 

One nickname using another nickname
Once you’ve finished typing addresses and notes, you can click the New button again
to make another nickname.
xe "Nicknames:Saving"§When finished making additions or changes, select xe "Save 
command"§Save from the File menu to save the changes.  If you close the 
Nicknames window without saving the changes, a dialog is displayed asking whether 
the additions/changes you just made should be saved or discarded.

 

Saving changes to Nicknames
Changing and Removing Nicknames
To change a nickname, select Nicknames from the Window menu.  Click once on 
the desired nickname in the Nickname: field to select it.  Then, click the Rename 
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button.  A dialog is displayed allowing you to change the nickname.  You may also 
add or remove the nickname from the xe "Quick Recipient list:Adding existing 
nickname to"§xe "Nicknames:Putting on recipient list"§Quick Recipient using the Put
it on the recipient list option.  Once the changes are completed, click OK.

 

Renaming a nickname
xe "Nicknames:Changing existing"§To change a nickname’s corresponding e-mail 
address(es) and notes,  click once on the desired nickname to select it.  The addresses 
and notes associated with the nickname are displayed in the Address(es): and Notes: 
fields, and may be directly edited.

 

Changing a nickname expansion
xe "Removing a nickname"§xe "Nicknames:Removing"§To remove the nickname, 
click once on the desired nickname to select it.  Click the Remove button.
xe "Nicknames:Saving"§When finished editing or making deletions, select xe "Save 
command"§Save from the File menu to save the changes.  If you close the 
Nicknames window without saving the changes, a dialog is displayed asking whether 
the changes/deletions you just made should be saved or discarded.

Make Nickname Command
The xe "Make Nickname command"§Make Nickname command can be used to make
a nickname in two different ways.

xe "Make Nickname command:Using in Nicknames window"§From the Nicknames 
window itself, use [Ctrl]+ click to select several different nicknames, and then choose
Make Nickname... from the Special menu.  The new nickname dialog is displayed 
prompting you for the name of the new nickname.  Once you have entered the name, 
click OK to create the new nickname with the selected nicknames in the Nicknames 
window as its addressees.  xe "Mailing list"§This is an easy way to make a group 
nickname out of existing nicknames.

 

Using Make Nickname... to make a mailing list
xe "Make Nickname command:Using with current messages"§Alternately, you can 
make a nickname out of the address list of a current message.  Open a mailbox and 
single-click on the desired message to make it current.  Select Make Nickname... 
from the Special menu.  The new nickname dialog is displayed prompting you for 
the name of the new nickname.  Once you have entered the name, click OK.  xe 
"Mailing list"§If multiple messages are current (i.e., you have several message 
summaries selected in a mailbox window), addresses are taken from each message 
and all are put in the new nickname’s expansion.
Note: When an incoming message is current, Make Nickname... pretends to 

do a Reply to the current message, and then takes all the recipients 
from the reply message and uses them in the nickname expansion.  
This means that Make Nickname... acts just like Reply in regard to the
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xe "Include Self option"§Include Self and xe "Reply All option"§Reply 
All options in the Switches dialog.  That is, if the Reply All option in 
the Switches dialog is turned on (or you hold down the [Shift] key), the
nickname is made for all of the recipients of the messages plus the 
sender, not just the sender.  Similarly, if the Include Self option in the 
Switches dialog is turned off, your address is not included in the new 
nickname’s expansion.

 

Making a nickname from current messages
Using the Nicknames Window to Address Mail
xe "Nicknames window:Using to send mail"§xe "Nicknames window:Using to add 
addressees to message"§xe "Message:Outgoing:Creating from Nicknames 
window"§xe "Message:Outgoing:Adding addressees to with Nicknames 
window"§The To:, Cc:, and Bcc: buttons in the Nicknames window can be used to 
start mail messages or to add addressees to existing current messages.  To create a 
new message from the Nicknames window, select the nickname to which you want to
address the mail (you can select multiple nicknames by holding down the [Ctrl] key 
and clicking on each nickname).  Then, click the xe "To button"§To: button.  

 

Starting a new message from the Nicknames window
A new composition window is displayed with the selected nickname(s) inserted in the
To: field.  Use the xe "To button"§To:, xe "Cc button"§Cc:, and xe "Bcc 
button"§Bcc: buttons to insert additional nicknames into the corresponding fields.
The Nicknames window can also be used to address existing.  Make sure the desired 
message is current (topmost), then open the Nicknames window and use the To:, Cc: 
and Bcc: buttons to address the message.

Nicknames and the Quick Recipient List
xe "Nicknames:vs Quick Recipient list"§xe "Quick Recipient list:vs 
Nicknames"§Nicknames and the Quick Recipient list are two separate entities.  
Nicknames are used as an abbreviation for an address or a list of addresses.  The 
Quick Recipient list is used to add addresses to messages via the Message menu.  
Nicknames do not need to be on the Quick Recipient list, and not everything on the 
Quick Recipient list needs to be a nickname.

However, you may have nicknames to which you often send mail, and it makes sense 
to add these nicknames to the Quick Recipient list.  This is easily done from the 
Nicknames window.  xe "Quick Recipient list:Adding existing nickname to"§xe 
"Nicknames:Putting on recipient list"§Double-click on a nickname to add it to or 
remove it from the Quick Recipient list.  A check mark next to the nickname 
indicates that it is on the list.xe "Nicknames:Removing from Quick Recipient list"§

 

The nickname is now on the Quick Recipient list
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The Quick Recipient list is discussed further in the “Using the Quick Recipient List” 
section.  xe "Nicknames:Renaming and Quick Recipient list"§xe 
"Nicknames:Removing and Quick Recipient list"§If you rename or remove a 
nickname that is also on the Quick Recipient list, the name on the Quick Recipient 
list is also changed or removed.

Quick Recipient List 
xe "Quick Recipient list"§It may be more convenient to address a message by 
selecting a nickname or full address from a predetermined Quick Recipient list.  This 
eliminates the need to type frequently used nicknames or addresses in the fields of 
outgoing message headers.  By selecting a nickname or address from the Quick 
Recipient list,  the address or nickname is automatically entered in the desired field.  
The list may also be used to more easily reply to, forward or redirect messages.

Eudora uses a single Quick Recipient list that can be accessed via the New Message 
To, Reply To, Forward To, and Redirect To selections under the Message menu, the 
Insert Recipient selection under the Edit menu, and the Remove Recipient selection 
under the Special menu.

 

The Quick Recipient list
Creating the Quick Recipient List
The Quick Recipient list should consist of the nicknames or addresses of common 
correspondents.  xe "Quick Recipient list:Adding existing nickname to"§To add a 
nickname to this list, choose Nicknames from the Special menu (see the “Creating 
and Using Nicknames” section for more details).  The Nicknames window is 
displayed.  xe "Quick Recipient list:Adding existing nickname to"§xe 
"Nicknames:Putting on recipient list"§Double-click on a nickname to add it to or 
remove it from the Quick Recipient list.  A check mark next to the nickname 
indicates that it is on the list.xe "Nicknames:Removing from Quick Recipient list"§

 

All nicknames are currently added to the Quick Recipient list
xe "Quick Recipient list:Adding email address to"§To add a full e-mail address to the
Quick Recipient list, select the text that makes up the full address in any current 
message header.  Then, select xe "Add As Recipient command"§Add As Recipient 
from the Special menu.

 

Adding an address to the Quick Recipient list
Using the Quick Recipient List
xe "Message:Outgoing:Addressing with Quick Recipient list"§The Quick Recipient 
list is displayed when you select xe "New Message To submenu"§New Message To, 
xe "Reply To submenu"§Reply To, xe "Forward To submenu"§Forward To, or xe 
"Redirect To submenu"§Redirect To from the Message menu.  To utilize the list, 
select a recipient using one of these commands.  Releasing the mouse button 
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performs the action (new message, reply, forward, redirect) and the chosen recipient 
is automatically inserted in the To: field of the new message header.

 

Starting a message with the Quick Recipient list
More than one nickname or address from the Quick Recipient list can be added to the
To:, Cc: and Bcc: fields of any message.  To do this, first place the blinking insertion 
point in the field where you want the nickname/address to be inserted.  Then, select 
the desired recipient from the xe "Insert Recipient submenu"§Insert Recipient list
under the Edit menu.  The chosen nickname/address is placed at the insertion point 
and a xe "Commas"§comma is added (if necessary) to separate the new address from 
the ones previously placed in the field.
Removing a Quick Recipient From the List
xe "Quick Recipient List:Removing entry from"§To remove a nickname/address 
entry from the Quick Recipient list, select it using the xe "Remove Recipient 
command"§Remove Recipient option under the Special menu.  When you release 
the mouse button, the selected recipient is deleted.

Note: Removing a nickname from the Quick Recipient list does not delete it 
from the Nicknames window, but removing a nickname from the 
Nicknames window deletes it from the Quick Recipient list.

Finding Text Within Messages
xe "Find"§Eudora incorporates a Find function that searches for specific text within a
single message, multiple messages, or even multiple mailboxes.  To display the Find 
submenu of commands, select Find from the Edit menu.

 

The Find submenu
Finding Text Within One Message
xe "Find:Within a message"§To search for text within a single message, open the 
message and make sure it is current.  Then, select Find from the Edit menu and 
select the Find command from the submenu.  The Find dialog is displayed, with the 
blinking insertion point located in the text field.  

 

The Find dialog
Type the text you want to find in the text field.  When finished entering the desired 
text, click the xe "Find button"§Find button.

 

Finding text
Starting at the beginning of the open message, Eudora searches the current message 
for the specified text.  If no match is found, the not found alert is displayed.
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Unsuccessful search
If the search is successful, the message is scrolled to the first point where the match is
found and the matching text is highlighted.

 

Successful search
To continue searching in the same message for the next occurrence of the text, click 
the xe "Find button"§Find button in the Find dialog, or select the Find Again 
command from the Find submenu.  These commands are equivalent and limit the 
search to the same message.  Repeating these commands cycles through the matches 
in the open message only.
Finding Text Among Multiple Messages and Mailboxes
xe "Find:Multiple messages"§The Next, Next Message, and Next Mailbox commands
are located in the Find submenu (under the Edit menu) or as buttons in the Find 
dialog.  

Next
xe "Next command"§xe "Next button"§xe "Find:Next button"§The Next button (or 
Next command) allows you to search for the next match of the specified text until it 
is found either in the same message or among all messages in the current mailbox.  

Note: The Next command initiated in an open mailbox (even with 
message[s] selected) searches for the specified text among all 
messages contained in that mailbox.  The search begins with the first 
message in the mailbox.

Next Message
The xe "Next Message command"§xe "Next Message button"§xe "Find:Next 
Message button"§Next Message button (or Next Message command) begins the 
search at the message after the current message.  Eudora continues to search until it 
finds a matching character string, even if it has to open more than one message or a 
new mailbox.

Next Mailbox
The xe "Next Mailbox command"§xe "Next Mailbox button"§xe "Find:Next Mailbox
button"§Next Mailbox button (or Next Mailbox command) begins the search for the 
specified text in the mailbox following the current mailbox.  The search is conducted 
among all messages in that mailbox and any subsequent mailboxes, including the In, 
Out, and Trash mailboxes.

Note: Mailboxes are searched in the order they are listed under the Mailbox 
menu until the current mailbox is reached.

Match Case
xe "Match Case option"§xe "Find:Match Case option"§Normally, Eudora ignores 
capitalization when searching.  If you want Eudora to consider capitalization when 
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searching, check the Match Case option in the Find dialog.  When this option is 
checked, Eudora searches for exact matches of character strings, including any 
capitalization.

Summaries Only
xe "Summaries Only option"§xe "Find:Summaries Only option"§If you know the text
you are searching for is included in a message summary, check the Summaries Only 
option in the Find dialog.  When you click the Find button, Eudora searches for the 
text only in the Sender and Subject fields of message summaries as they appear in 
mailbox windows.  Eudora searches much faster when this option is checked.

Enter Selection Command
If you don’t want to actually type the text in the Find dialog (for example, the text is 
very long or complex), highlight it in an existing message, and then select xe "Enter 
Selection command"§Enter Selection from the Find submenu.  This automatically 
inserts the selected text at the insertion point in the Find dialog.  Then, select the 
Find command from the Find submenu to start the search.

Stopping a Find
xe "Find:Stopping"§If you want to stop Eudora from continuing a search, press the 
[Esc] key. 
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Sorting Messages Within Mailboxes
xe "Sorting"§It is possible to sort the message summaries in a mailbox window 
according to their status, priority, sender, date, or subject.  These commands are 
listed in the Sort submenu under the Edit menu.

 

The Sort submenu
To use any of these commands, first open the mailbox to be sorted.  Then, select the 
appropriate command from the Sort submenu.  The messages are sorted when the 
mouse button is released.
Eudora sorts in ascending order; the smallest item first. To sort in descending order, 
hold down the [Shift] key while choosing the desired command from the Sort 
submenu.

Tip: Eudora’s sorting algorithm is “stable.”  This means that sorting on a 
particular column leaves items of the same value in the same order as 
they were before the sort.  This feature allows you to sort based on 
multiple criteria by using xe "Sorting:Multiple criteria"§multiple sort 
commands.  For example, if you want your messages sorted by subject,
and within each subject you want messages sorted by date, first choose
Sort by Date, then Sort by Subject.

Note: xe "Sorting:By date"§Sometimes Eudora does not sort by date 
properly.  This happens if the messages have incorrectly formatted 
date fields or unknown or incorrect time zones.  Also, since Eudora 
uses Greenwich Mean Time (GMT) when sorting by date, the 
messages may merely appear to be out of order because the time 
stamp is the local time at the location where the messages originated.  
For example, a message sent at 11:30 EST is listed before a message 
sent at 10:00 PST, because 11:30 EST actually occurs before 10:00 
PST.

Saving a Message to a File
xe "Messages:Saving to files"§Eudora allows you to save a current message(s) to a 
separate text file on your PC.  To do this, first display the desired message or 
highlight its summary in the mailbox window.  Then, select xe "Save As... 
command"§Save As... from the File menu.  The Save As dialog is displayed allowing
you to choose a name and location for the file.  

Note the two options at the bottom of the dialog.  xe "Guess Paragraphs 
option"§Guess Paragraphs instructs Eudora to remove extraneous carriage returns 
from the message, leaving returns only at the ends of paragraphs.  In addition, it 
converts multiple spaces into xe "Tabs:And Save As... command"§tabs. 

xe "Include Headers option"§Include Headers instructs Eudora to retain the 
message’s header information in the saved document.  If this is unchecked, only the 
body of the message is saved.   

QUALCOMM Incorporated 45



Appendix A – Sources Eudora User Manual

 

Saving a message to a text file
Once you’ve made all of your choices, click on the OK button in the dialog.   
If you select multiple messages from a mailbox window and select Save As..., all of 
the messages are saved to a single file.

 

Using “Save As...” to save several messages to one file
xe "Messages:Incoming:Recombining split messages"§Tip: When Eudora 

receives a very large message from the POP server, it splits that 
message into multiple smaller messages. If you need to reassemble the 
original message, use the Save As... command.

Resending Rejected Messages 
xe "Bounced mail"§xe "Rejected Mail"§xe "Message:Incoming:Sending again"§xe 
"Errors:Bounced mail"§Mail Transport Agents are computer programs responsible 
for routing e-mail messages through networks.  If for some reason an e-mail message 
can’t be delivered to an intended recipient, these programs return the message to the 
original sender.  A message is typically rejected because of an error in the recipient’s 
address, although there are many possible reasons.

The message sent back from the mail system usually includes cryptic information that
may allow you to determine the reason for the message being rejected.  It also 
includes the text of the original message.  

 

A rejected message
If you choose to resend the message, Eudora deletes the error messages and added 
text and recovers the original message so that you can make any corrections.  To do 
this for the current message, select xe "Send Again command"§Send Again from the 
Message menu.  This eliminates the inserted extra text and reformats the message as 
it originally appeared.   You can then make changes or additions and resend the 
message, if desired.

 

A rejected message, restored
Message Priorities

xe "Message:Priority"§xe "Priority"§Eudora allows you to assign priorities to your 
messages.  These priorities are for sender/recipient reference purposes only, and they 
do not affect the way Eudora handles the messages. 

There are five priority levels available, each represented by a small icon.  Priorities 
range from 1 (highest) to 5 (lowest).  Priority 3 is assumed for messages that have no 
assigned priorities, and it is not displayed.
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µ § Highest priority.

µ § High priority.

<blank> Normal priority.

µ § Low priority.

µ § Lowest priority.

Message priorities are displayed in the Status/Priority column of the mailbox 
window.

 

Message priorities displayed in the mailbox window
To change the priority of a message, open the message and choose the desired 
priority from the Priority combo box on the icon bar.  The selected priority icon is 
then displayed in the combo box.

 

 
Assigning a priority to a message

You can also change the priority of the current message(s) by holding down the [Ctrl]
key and pressing a number key from 1 to 5 (1 = Highest, 5 = Lowest).
xe "Priority:And Reply"§Note: All new messages are created with 

Normal priority, even replies to messages whose priority you have 
changed.  The exception to this is that, if the sender of a message gives
it a priority other than normal, Eudora insists on giving your reply the
same priority.  This occurs even if you reassign the priority of the 
sender’s message after you have received it.  You can, however, 
change the priority of your response by re-assigning it manually.

Editing Message Subjects
xe "Message Summary:Changing subject of"§xe "Subject:Changing"§Sometimes the 
subject of a message is not clear or descriptive.  Eudora allows you to edit the subject
of any incoming message.
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Note: The subjects of outgoing messages (messages sent by you) cannot be 
edited.

To edit the subject of an incoming message, open it from its mailbox window.  Notice 
that the subject is displayed below the title bar and above the message.  You can edit 
this text as you would any other text.  When editing is complete, close the message.  
The new subject is displayed in the message summary.  The contents of the Subject: 
field of the message header remain unchanged.

 

Editing the subject of an incoming message
 

After Editing the subject
Note: If you reply to the message, the original subject is used for the reply, 

not your changed subject.  This gives you the freedom to put 
information useful to you into the summary, without fear of your 
private notes being revealed to your correspondents.

Printing
Eudora can print a current message or messages, text files, signatures, or the contents 
of the Ph window.  To print from within Eudora, select xe "Print... 
command"§Print... from the File menu with the message or Ph window displayed.  
Eudora automatically prints headers and footers on each page, giving the window 
title, page number and your return address.

Using the Ph Window
Eudora can access two different directory services, xe "Ph"§Ph and xe 
"Finger"§Finger, via the Ph window.  To display the Ph window, select Ph from the 
Window menu.

 

The Ph window
The Ph window has two buttons (one for Ph and one for Finger), and three text fields:
one where you specify which server to use (Server)xe "Ph:Ph Server field"§; one 
where you type your query (Command)xe "Ph:Ph command field"§; and one where 
you see the response.

Using Ph
xe "Ph:Using Ph window for"§To use the Ph protocol, type the name of the Ph server
in the Server field or use the default server (the default is what is entered in the Ph 
Server field of the Configuration dialog).  Then, type the name of the person you 
want to look up in the Command field and click on the xe "Ph button"§Ph button.  
The server’s response is displayed in the response field.

 

A Ph query and its response
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Note: You can type any Ph command in the query field, except login 
commands or commands requiring login.  For more information about
the Ph server source code, see Appendix A.

Using Finger
xe "Finger:Using Ph window for"§To use the Finger protocol, type your query into 
the query field.  This query should be in the form “name@domain.”  If you omit the 
“@domain” segment, Eudora uses the server listed in the Server field.  Once the 
name is entered, click on the xe "Finger button"§Finger button.

The finger query is sent to the host specified in the “@domain” part, and the response
is displayed in the response field.

 

A Finger query and its response
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Creating a Signature
A “xe "Signature"§signature” is a brief message automatically added by Eudora to 
the end of outgoing messages.  It should consist of a few lines giving the sender’s full
name and e-mail address.  Other pertinent details, such as phone number, postal 
address, or place of employment are also sometimes included.

To create a signature, select xe "Signature:Menu command"§Signature from the 
Window menu.  A blank Signature window is displayed.  Type your text in this 
window.

 

Typing a signature
When you are finished typing the signature, close the Signature window.  An alert is 
displayed asking if you want to save the changes to your signature.  Click Save.  You
may modify your signature at any time by repeating this procedure.
In order to activate your signature on an outgoing message, select it from the 
Signature combo box on the icon bar.  

µ §

Activating your signature in the icon bar
Note: The signature text is not displayed at the end of messages you create, 

but your recipients see it.
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Configuration Dialog
In order for Eudora to work correctly, the program must be configured by providing 
it with some basic though important information.  To enter this information, select xe
"Configuration... command"§Configuration... from the Special menu.  The 
Configuration dialog is displayed.  

 

The Configuration dialog
The Configuration dialog is divided into two segments, Network Configuration and 
Message Configuration. 
Network Configuration
xe "Network Configuration"§Each of the fields in the Network Configuration 
segment of the Configuration dialog is described below.  The default settings are 
listed in brackets after the name of each field. 

 

The Network Configuration segment of the Configuration dialog
POP Account: [none]
xe "Network Configuration:POP Account setting"§To receive mail with Eudora, you 
must have an account on a computer that runs a POP 3 server.  This is the account to 
which your e-mail messages are delivered before they are transferred to the Eudora 
program on your PC.  Enter your login name for this account, followed by an “@” 
sign and the (domain) name of the computer.

For example, if the login name for your POP account is “carolyn,” and the name of 
the computer is “uxh.cso.uiuc.edu,” type carolyn@uxh.cso.uiuc.edu in this field.

Real Name: [none]
xe "Network Configuration:Real Name setting"§Type your real name here.  It is 
placed in parentheses after your return address in your outgoing mail.  It is also 
displayed in the Sender column of incoming message summaries.

SMTP Server: [none]
xe "Network Configuration:SMTP Server setting"§To send mail, a computer with an 
SMTP (Simple Mail Transfer Protocol) server program is necessary.  You need not 
have a login on this computer, but you must have access to it through your network.  
If the computer on which you have your POP account is also an SMTP server, leave 
this field blank.  Otherwise, specify the name of the computer which you want to use 
as your SMTP server.

Return Address: [none]
xe "Network Configuration:Return Address setting"§Normally, Eudora uses your xe 
"POP Account setting"§POP Account as your return address.  If you wish to use a 
return address other than your POP account, type it here.
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Important: If you do type an address in this field, first test the address to 
be sure that mail sent to it is indeed delivered to you.  If you use an 
invalid return address, no one can reply to your mail.

Check For Mail Every  ?  Minute(s) [0]
xe "Network Configuration:Check For Mail setting"§If you type a number in this 
field, Eudora checks your POP server for new mail at regular intervals and transfers 
any mail addressed to you to your PC.  The number you enter specifies the number of
minutes between checks of the POP server.  It’s a good idea to set this at no less than 
15 minutes.  Checking mail more frequently puts an unnecessary drain on your POP 
server.  This option only works when Eudora is running.  Leaving this field empty 
disables automatic checking.

Ph Server: [none]
xe "Network Configuration:Ph Server setting"§Type the host name of your Ph name 
server here.

Note: For more information on Ph servers, see Appendix A.
Message Configuration
xe "Message Configuration"§Each of the fields in the Message Configuration 
segment of the Configuration dialog is described below.  The default settings are 
listed in brackets after the name of each field. 

 

The Message Configuration segment of the Configuration dialog
Message Width: [80]
xe "Message Configuration:Message Width setting"§This field specifies the width of 
new and received message windows (in characters).  If you leave this field blank, the 
default value is 80.  This setting has no effect on what your mail looks like when it is 
sent.  When mail is sent, Eudora wraps at or before 76 columns.

Note: If you use a proportional font, Eudora sets the window width based on
the average width of the characters in the font.

Message Lines: [20]
xe "Message Configuration:Message Lines setting"§This field specifies the height of 
new and received message windows (in lines).  If you leave this field blank, the 
default value is 20.

Note: If the Zoom Windows option in the Switches dialog is turned on, 
received message window heights are automatically adjusted to the 
length of the message text.

Tab Stop: [8]
xe "Message Configuration:Tab Stop setting"§This field specifies the number of 
spaces between tab stops.

Screen Font, Size: [Courier New]
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xe "Message Configuration:Font settings:For screen"§This combo box allows you to 
select a screen font to be used for displaying the text of your Eudora messages and 
mailbox windows.  Type the size (in points) of the font you are using in the Size 
field.

Printer Font, Size: [Courier New]
xe "Message Configuration:Printer settings"§xe "Print... command:Font settings"§xe 
"Font Settings:for printing"§This combo box allows you to select a font to be used 
when you print messages using the Print... command.  Type the size (in points) of the
font you are using in the Size field.

Auto Receive Attachment Directory: [off, none]
xe "Message Configuration:Auto Receive Attachment Directory setting"§xe 
"Attachments:Receiving automatically"§If this option is checked, Eudora 
automatically places file attachments that come with messages into the specified 
directory.  To change the setting, single-click on the application name button (the 
default is blank).    A dialog is displayed allowing you to select the directory (see the 
“Saving Attachments Automatically” section).  
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Switches Dialog
xe "Switches... command"§You may tailor many aspects of Eudora to your own 
needs and preferences.  Some of these are set with the Configuration dialog described
in the previous section.  Others are set with the Switches dialog.  If the setting can be 
either on or off, it’s in the Switches dialog; if a choice beyond on or off is required, 
it’s in the Configuration dialog.  The one exception to this is the Encode With option 
in the Switches dialog.  To display the Switches dialog, select Switches... from the 
Special menu.

 

The Switches dialog
xe "Switches dialog"§The Switches dialog is divided into seven sections of options, 
with a descriptive heading above each section.  A check in the box next to the option 
indicates that the option is on.  Each of the options is described below.  The default 
settings are listed in brackets after the name of each option.
Composition Options
xe "Switches dialog:Composition options"§Many of the Composition options can be 
turned on and off for individual messages using the icon bar displayed at the top of 
the message composition window.  However, setting them here establishes these 
settings as the icon bar defaults for all new composition windows. 

 

The Composition section of the Switches dialog
Use Signature [on]
xe "Use Signature option"§xe "Signature:Enabling/disabling"§If Use Signature is on, 
Eudora automatically attaches your signature file (if you have one) to the end of 
outgoing messages.

May Use QP [on]
xe "May Use QP option"§xe "Quoted-printable encoding"§If May Use QP is on, 
Eudora uses quoted-printable encoding when necessary, such as when messages that 
contain long lines of text or special characters are sent.  If this option is off, quoted-
printable encoding is not used.

Word Wrap [on]
xe "Word Wrap option"§xe "Word Wrap"§If Word Wrap is on, a carriage return is 
not required at the end of each line of type in an outgoing message.  Eudora 
automatically wraps text to the next line, with line breaks at roughly 76 characters per
line.  This makes your mail more legible to recipients using line-oriented mail 
systems.  It is strongly recommended that you turn this option on.

Tabs in Body [on]
xe "Tabs in Body option"§xe "Tabs:Replaced with spaces"§If Tabs in Body is on, 
hitting the [tab] key within the message body results in Eudora inserting enough 
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spaces to move the insertion point to the next tab stop (as set in the Configuration 
dialog).  This mimics the way tabs work on many terminals.  If this option is off, 
hitting the [tab] key returns the cursor to the To: field of the message header.

Keep Copies [off] 
xe "Keep Copies option"§If Keep Copies is on, a copy of each sent message is kept in
the Out mailbox (their summaries are marked with an “S” in the Status/Priority 
column of the Out mailbox window).  If this option is off, Eudora moves outgoing 
messages to the Trash mailbox after they are sent.

Reply to All [off]
xe "Reply to All option"§xe "Message:Incoming:Replying to all"§If Reply to All is 
on, selecting Reply from the Message menu creates a message addressed not only to 
the sender of the original message, but also to all of its recipients.  If the option is off,
Reply addresses the new message only to the sender.

You can use the xe "Reply to All option:Option key and"§[Shift] key to reverse this 
setting for any given reply.  That is, if this option is off, holding down the [Shift] key
while choosing Reply replies to all, and vice-versa.

Note: This option setting also affects the xe "Make Nickname 
command"§Make Nickname command (see the “Make Nickname 
Command” section).

Include Self [off]
xe "Include Self option"§xe "Message:Incoming:Replying to all, but not self"§If 
Include Self is on, when you do a reply all (as described above) your address is left in
the address list of the new message and you receive a copy of your own reply.  If this 
option is off, your address is removed from the reply message.

To determine who you are, Eudora uses the contents of the POP Account and Return 
Address fields from the Configuration dialog.  xe "Me nickname"§xe "Nicknames:Me
nickname"§If you have additional addresses, you can create a “me” nickname using 
the Nicknames window.  List all of the addresses and aliases for yourself in the 
Address(es) field for the me nickname.  This gives Eudora a more complete listing of
who you are.  It also insures that when you reply to messages sent to you at an 
address other than what is listed in the Configuration dialog, the include self option 
works correctly.

Note: This option setting also affects the xe "Make Nickname 
command"§Make Nickname command (see the “Make Nickname 
Command” section).

Send Attachments Options
xe "Switches dialog:Send Attachments options"§These options define the way 
attachments are sent.
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The Send Attachments section of the Switches dialog
Always as Attachment [off]
xe "Always as Attachment option"§If Always as Attachment is on, text files 
attached to messages are sent as separate documents and encoded using the selected 
Encode With format.  If this option is off, text files are incorporated into the message
as part of the message body, which is plain text format.  If this option is off and the 
attachment is not a text file, it is still sent as a separate document and encoded using 
the selected format.

Encode With: [Bin Hex]
This option allows for the selection of what format documents you attach to outgoing
messages are encoded in: MIME or Bin Hex.  MIME is best for recipients with 
MIME and Bin Hex is most compatible with old Macintosh mailers and previous 
versions of Eudora.

Checking Options
xe "Switches dialog:Checking options"§These options determine the way Eudora 
checks for and receives mail.

 

The Checking section of the Switches dialog
Save Password [off]
xe "Save Password option"§xe "Password:Saving"§If Save Password is on, you never
have to enter your password to check your mail (even if you quit Eudora and restart 
it) because your password is stored on your PC.  Only use this option if your PC is in 
a secure place.

Leave Mail On Server [off]
xe "Leave Mail On Server option"§xe "Checking mail:Leave Mail On Server 
Option"§Eudora normally transfers your incoming messages from your account on 
the POP server to your PC, and deletes them from the POP server.  If Leave Mail On 
Server is on, Eudora transfers incoming messages to your PC and also keeps copies 
on the POP server (see the “Leave Mail on Server Option” section).

Skip Big Messages [off]
xe "Skip Big Messages option"§xe "Checking mail:Skip Big Messages option"§If 
Skip Big Messages is on, Eudora does not download the entire texts of very large 
messages from the POP server, but only downloads the first few lines.  This can be 
useful on slow connections (see the “Skip Big Messages Option” section).

Sending Options
xe "Switches dialog:Sending options"§These options determine the way Eudora sends
mail.
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The Sending section of the Switches dialog
Send On Check [on]
xe "Send On Check option"§xe "Checking mail"§xe "Sending mail"§If Send On 
Check is on, Eudora automatically sends any messages that are queued in the Out 
mailbox whenever it checks the POP Server for new mail. 

Immediate Send [on]
xe "Immediate Send option"§xe "Message:Outgoing:Sending, one-step"§xe 
"Message:Outgoing:Sending, two-step"§If Immediate Send is on, the rightmost 
button in the icon bar of the message composition window is labeled xe "Send 
button"§Send.  Clicking on this button immediately sends the message to the POP 
server.  If this option is off, the button is labeled Queue and clicking on it places the 
message in the Out mailbox marked ready for delivery (Q).

New Mail Notification Options
xe "Switches dialog:New Mail Notification options"§These options determine what 
Eudora does when new mail arrives.

 

The New Mail Notification section of the Switches dialog
Alert [on]
xe "Alert option"§xe "Alerts:Disabling"§If Alert is on, Eudora uses a dialog box to 
notify you when new mail arrives.

Sound [on]
xe "Sound option"§xe "Checking mail:Sound on new mail"§If Sound is on, Eudora 
makes a noise when new mail arrives.

Open ‘In’ Mailbox [on]
xe "Open ÔInÕ Mailbox option"§xe "Checking Mail:Automatically opening In 
mailbox"§xe "In mailbox:Opening on new mail"§If Open ‘In’ Mailbox is on, Eudora 
automatically opens the In mailbox when new mail arrives.  It also scrolls to the end 
of the mailbox and selects the first unread message of the last unread batch of 
messages.  If this option is off, Eudora doesn’t open the In mailbox when new 
messages arrive.  It does, however, place the messages in the mailbox in the same 
order.

Switch Messages With Options
xe "Switches dialog:Switch Messages With options"§These options allow you to use 
the arrow keys to toggle through messages.

 

The Switch Messages With section of the Switches dialog
Plain Arrows: [off]
xe "Arrow keys"§xe "Plain Arrows option"§xe "Next message, going to"§If Plain 
Arrows is on and there is a message window open on the screen, the arrow keys can 
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be used to close the current message and open the next or previous message in the 
mailbox.  The up or left arrow key opens the previous message; the down or right 
arrow key opens the next message.  If this option is off, the arrow keys can be used to
move the insertion point in messages.

xe "Arrow keys:Composition windows and"§Note: Even if Plain Arrows is 
on, the arrow keys do not switch messages if there is a message 
composition window topmost on the screen.

Ctrl-Arrows: [on]
xe "Arrow keys"§xe "Ctrl-Arrows option"§If Ctrl-Arrows is on, message switching 
using the arrow keys (as described in the Plain Arrows section above) is permissible 
only when the [Ctrl] key is depressed.

xe "Arrow keys:Composition windows and"§Note: The Ctrl-Arrows 
keystrokes do not work when composition windows are topmost on the 
screen.

Miscellany Options
xe "Switches dialog:Miscellany options"§These options control miscellaneous Eudora
functions.

 

The Miscellany section of the Switches dialog
Show All Headers [off]
xe "Show All Headers option"§xe "Message:Incoming:Headers"§If Show All 
Headers is on, Eudora displays the complete header, including routing information, 
with the message.  If this option is off, Eudora withholds this additional information.

Zoom Windows [off]
xe "Zoom Windows option"§If Zoom Windows is on, new message windows 
automatically open to their “zoomed” size.  The zoomed size is computed on a 
window-by-window basis.  xe "Message:Incoming:Zooming windows"§Zoomed size 
is just long enough to display all of the message (but no longer than the main 
window), and as wide as the xe "Message Window Width setting"§Message Window 
Width setting in the Configuration dialog.  xe "Message:Outgoing:Zooming 
window"§Composition windows zoom to the height specified by the xe "Message 
Window Height setting"§Message Lines setting in the Configuration dialog.

Easy Delete [off]
xe "Easy Delete setting"§xe "Message:Deleting:Unread/Queued"§If Easy Delete is 
on, Eudora does not alert you when you are deleting messages you haven’t read or 
transferring queued messages out of the Out mailbox.

Mailbox Superclose [off]
xe "Mailbox Superclose option"§xe "Message:Closing"§If Mailbox Superclose is on, 
closing a mailbox window closes all open messages from that mailbox.

58 QUALCOMM Incorporated



Eudora User Manual Appendix A – Sources

Empty Trash On Quit [on]
xe "Empty Trash On Quit option"§If Empty Trash On Quit is on, Eudora empties the 
xe "Trash mailbox"§Trash mailbox whenever you quit the application.  If this option 
is off, Eudora only empties the Trash when you select Empty Trash from the Special 
menu.

Note: If you want to remove some messages from the trash but don’t want to
empty it entirely, highlight the summaries you want to delete and 
select Delete from the Message menu.  The selected messages are 
deleted.

Easy Open [on]
xe "Easy Open option"§If Easy Open is on, deleting or transferring an open message 
opens the next message in the mailbox, but only if that next message is unread.

Show Progress [on]
xe "Show Progress option"§If Show Progress is on, Eudora displays a xe "Progress 
window:Enabling/disabling"§Progress window at the top of your screen to advise you
of progress made when making a network connection, transferring mail or some other
long operation.

Auto-Ok [on]
xe "Auto-Ok option"§xe "Alerts:Timing out"§Many network problems are 
temporary. When a problem occurs while Eudora is transferring or checking your 
mail, you are notified in the same way you would be if you were receiving new mail 
(see the “New Mail Notification: Options” section). If Auto-Ok is on, these 
notifications automatically go away after a couple of minutes. This allows Eudora to 
try the communication again. This setting is most useful if you have a non-zero value
for the Check for mail every ? minute(s) setting in the Configuration dialog.

Quitting Eudora
xe "Quitting"§To quit the Eudora program, select Exit from the File menu.  If you 
have queued messages, or timed messages due to be sent in the next 12 hours, you are
asked if you want to send them (see the “Quitting with Queued Messages” section).  
If the Empty Trash on Quit option in the Switches dialog is turned on, quitting 
Eudora also empties your Trash mailbox.
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Mail Storage
xe "Mail Storage"§When you install Eudora, it creates a number of files within the 
assigned directory.  In addition, Eudora creates additional files as needed for 
mailboxes, signatures, and other settings.  The Eudora files are described below.

 

Typical Eudora directory contents
eudora.ini
Your Configuration and Switches information is saved in the eudora.ini file, along 
with other information.  This file contains notes that describe each entry.

nndbase.txt
Your nicknames are saved in the nndbase.txt file.

nndbase.toc
This file is the table of contents for your nicknames.

in.mbx, out.mbx, trash.mbx
xe "Mail Storage:Mailboxes"§These files hold your mail.  You’ll see files like these 
for every mailbox you create.

Note: These files are in xe "UNIX mail"§UNIX mail format.
in.toc, out.toc, trash.toc
xe "Mail Storage:Mailboxes:Contents"§These files are the tables of contents for your 
mailboxes.  They make it much faster for Eudora to access your mail.  You’ll see 
files like these for every mailbox you create.

eudora.log, old.log
Eudora can keep records of all mail transfers.  These records are kept in the 
eudora.log and old.log files.  The old.log file is overwritten and a new eudora.log file
is created when the eudora.log file reaches its approximately 100K maximum size.  
To enable logging, set the LogLevel entry in the [Debug] section of the 
EUDORA.INI file.

signatur.pce
The signature is kept in the signatur.pce file.

descmap.pce
Mappings between mailbox names and DOS 8.3 file names are stored in the 
descmap.pce file.

Sharing a PC with Other Users
xe "Sharing a PC"§If you are sharing a PC with other users, make a separate mail 
directory and create a separate program item for each user.  The directories can be 
named whatever you like, and put anywhere you like, including on floppies or 
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network volumes.  To tell Eudora which directory to use, specify that directory as the
first parameter on the Command Line of the Program Item Properties dialog.

 

Specifying a mail directory

QUALCOMM Incorporated 61



Appendix A – Sources Eudora User Manual

Summary of Eudora Menu Commands
File
xe "File menu"§This menu provides basic file and mail program functions.

 
Close
Close the current window.

Save
Save changes to the contents of the topmost window.  
This applies to composition windows, signature 
windows, and the Nicknames window.

Save As...
Save the current message(s) to a plain text file.

Send Queued Messages
Send all messages that have been queued for delivery.

Check Mail
Pick up new mail from the POP server.  The time in 
parentheses indicates the next time Eudora will 
automatically check for mail.

Print Setup...
Set printing options.

Print...
Print the current message(s) or Ph window.

Exit
Exit the Eudora application.
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Edit
xe "Edit menu"§This menu provides text editing and sorting tools.  

 
Undo
Reverses the last editing action taken on a piece of 
text.

Cut
Delete selected text and place it on clipboard.

Copy
Copy selected text and place it on clipboard.

Paste
Place contents of clipboard at chosen insertion point 
in message.

Paste as Quotation
Place contents of clipboard at insertion point, with ‘>’
characters at the beginning of each line to denote 
quoted text.

Clear
Delete selected text.

Select All
Select entire contents of message or mailbox.

Show Insertion Point
Scroll selection or insertion point into view.

Insert Recipient
Insert the chosen nickname/address from the Quick 
Recipient list at the insertion point.

Find submenu
Search for designated text or character string within 
message(s).

Sort submenu
Sorts message summaries in a mailbox.  Hold down 
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the [Shift] key to reverse the order of the sort. 
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Mailbox
xe "Mailbox menu"§This menu lets you open a mailbox, or bring an open mailbox to the front.

 
In
Open mailbox where incoming messages are stored 
until deleted or transferred to another mailbox.

Out
Open mailbox where messages you compose are 
stored, and where queued messages are held until 
actually sent, and where copies of sent messages may 
be initially stored.

Trash
Open mailbox where deleted messages are stored. 

New...
Display New Mailbox dialog to create a new mailbox.

[Your Mailboxes]
Mailboxes you create are also displayed in this menu.
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Message
xe "Message menu"§This menu lets you create and delete messages.

 
New Message
Open new message composition window.

Reply
Reply to the sender of the current message.

Forward
Forward the current message to someone else.

Redirect
Forward the current message to someone else, but 
make the return address be the person who originally 
sent the message.

Send Again
Resend a message rejected by the mail system.  Be 
sure to fix whatever caused the problem.

New Message To
Send a message to someone on the Quick Recipient 
list.

Reply To
Reply to the current message, but send the reply to 
someone on the Quick Recipient list.

Forward To
Forward the current message to someone on the 
Quick Recipient list.

Redirect To
Redirect the current message to someone on the 
Quick Recipient list.

Queue For Delivery/Send Immediately
Save the message in the Out mailbox and mark it as 
queued (ready to be delivered), or send it 
immediately.

Change Queueing...

66 QUALCOMM Incorporated



Eudora User Manual Appendix A – Sources

Queue a message, unqueue a queued message, or set a
message for timed send.

Attach Document...
Attach file(s) to the current message.

Delete
Transfer the current message to the Trash mailbox; 
also used for deleting messages from the Trash 
mailbox.
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Transfer
xe "Transfer menu"§This menu lets you transfer current message(s) to the selected mailbox.

 
In
Transfer the current message(s) to the In mailbox.

Trash
Transfer the current message(s) to the Trash mailbox. 

New...
Display New Mailbox dialog to create a new mailbox;
current message(s) may be transferred into that 
mailbox. 

[Your Mailboxes]
Transfer the current message(s) to the selected 
mailbox that was previously created by you.
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Special
xe "Special menu"§This menu provides additional Eudora functions.

 
Make Nickname...
Create abbreviations for addresses in the current 
message.

Add As Recipient
Add selected text to the Quick Recipient list.

Remove Recipient
Select a recipient from this menu and the recipient is 
removed from the Quick Recipient list.

Empty Trash
Delete all messages from the Trash mailbox.

Compact Mailboxes
Reclaim unused space in mailboxes.  

Configuration...
Display the Configuration dialog.  

Switches...
Display the Switches dialog.

Forget Password
Make Eudora ask for your password the next time it 
checks for mail.

Change Password
Change your password on the POP server computer.  
This requires a special server.
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Window
xe "Window menu"§All Eudora window titles are listed in this menu.  Select one to open it or bring 
it to the front.

 
Cascade
Cascade open windows.

Tile
Tile open windows.

Arrange Icons
Arrange all icons at the bottom of the main window.

Send to Back
Send the topmost current window to the back of all 
displayed windows.

Mailboxes
Display the Mailboxes window.

Nicknames
Display the Nicknames window.

Ph
Display the Ph window.

Signature
Display the Signature window.

[Mailbox and Message Windows]
Toggle between open mailboxes.
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Help
xe "Help:Menu"§The Eudora Help menu and About Eudora screen are listed in this menu.

 
Contents...
Display the on-line help contents.

Search for Help on...
Display a list of search topics.

How to Use Help
Display the Microsoft Windows How to Use Help 
window.

QUEST Mailing List...
Subscribe to/unsubscribe from the QUEST mailing 
list.

About Commercial Eudora...
Display the About Commercial Eudora screen.

About Eudora...
Display the About Eudora screen.
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Anonymous ftp (ftp.qualcomm.com)

xe "ftp.qualcomm.com"§QUALCOMM has an anonymous ftp server 
(ftp.qualcomm.com) that has information and software related to Eudora.  These are 
located within the “quest” directory.  Included are POP3, Ph, and password changing 
servers, current product information and more.

Eudora Information
xe "Eudora Information"§The information in this manual was correct at the time of 
printing.  However, things happen very quickly in the electronic world, meaning that 
some of this information may already be out of date.  For the very latest information 
about Eudora, send e-mail to eudora-info@qualcomm.com.

Obtaining a POP Server
xe "POP:Server for"§xe "POP:Server for:UNIX"§If you would like to run a POP 
server on your own UNIX system, we suggest you use “xe "Popper"§popper.”  
Popper is available via anonymous ftp from ftp.qualcomm.com.

xe "POP:Server for:VAX/VMS"§VAX/VMS systems may try the “Multinet” package
from TGV, or IUPOP3, available via anonymous ftp from ftp.indiana.edu.

xe "POP:Server for:VM/CMS"§For VM/CMS users, there is a port of “popper” 
available via anonymous ftp from  vmd.cso.uiuc.edu (cd to the “POPD” directory).

Ph Server Source Code
xe "Ph:Server source code"§A server for the “Ph” protocol is available via 
anonymous ftp from ftp.qualcomm.com.

Password Change Server
xe "Password:Changing:Server source code for"§Three sample UNIX servers for 
Eudora’s “Change Password” command are available via anonymous ftp from 
ftp.qualcomm.com.

Windows Sockets Products
xe "Windows Sockets"§Demos of Windows Sockets 1.1 compliant stacks and 
applications are available via anonymous ftp from sunsite.unc.edu in the directory 
micro/pc-stuff/ms-windows/winsock.



Serial Line IP (SLIP)
xe "Serial Line IP (SLIP)"§xe "SLIP"§Information and applications regarding Serial 
Line IP (SLIP) are available via anonymous ftp from biochemistry.cwru.edu in the 
directory /slip.

PC Speaker
If you want the new mail sound notification to work with the speaker that comes with
your PC, you need to install the PC speaker driver.  This driver is available via 
anonymous ftp from ftp.qualcomm.com.  It’s the file SPEAK.EXE in the directory 
quest/eudora/windows/utils.  This is a self-extracting archive, so just run it on your 
PC to produce the necessary files and instructions.
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Modifier Keys

Many operations in Eudora can be affected by holding down one or more “modifier” 
keys.  Eudora uses the [Shift] and [Ctrl] keys as modifiers.

The [Shift] key is usually used to make an operation to reverse option settings.

· [Shift] + Queue or Send button brings up Change Queueing dialog.
· [Shift] + Reply toggles the “Reply to all” option in the Switches dialog.  If the 

Reply to all option is turned on, Shift + Reply generates a reply to the sender only.  
If the Reply to all option is turned off, Shift + Reply generates a reply to all 
addresses in the message header.

· [Shift] + Transfer sends a copy of the current message to the selected mailbox and 
retains the original message in the original mailbox.

· [Shift] + Open a message shows all headers.

Other Important keys
The arrow keys, depending on the settings in the Switches dialog, can move you 
from one message to another in a mailbox.  If the Plain Arrows or Ctrl-Arrows option
in the Switches dialog is turned on,

· up/left arrow or [Ctrl] + up/left arrow takes you to the previous message.
· down/right arrow or [Ctrl] + down/right arrow takes you to the next message.
The [Enter] key performs several different functions:

· It selects the outlined button in any dialog, alert, or window.
· It opens the selected message(s) in a mailbox.
The [Esc] key stops any operation currently in progress.

If you have an extended keyboard, the following keys are also useful:

· [Delete] deletes the character to the right of the insertion point.
· [Home] scrolls to the beginning of the window.
· [End] scrolls to the end of the window.
· [Page Up], [Page Down] scrolls up or down through the window.

[Ctrl] + Key Equivalents
[Ctrl] + [A] Select all

[Ctrl] + [B] Move window behind all other windows

[Ctrl] + [C] Copy 

[Ctrl] + [D] Delete message

[Ctrl] + [E] Queue/Send an outgoing message
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[Ctrl] + [F] Open Find window (search for message)

[Ctrl] + [G] Find again

[Ctrl] + [H] Attach document to outgoing message

[Ctrl] + [I] Open In mailbox

[Ctrl] + [K] Make nickname

[Ctrl] + [L] Open Nicknames window

[Ctrl] + [M] Check mail

[Ctrl] + [N] New message

[Ctrl] + [P] Print message

[Ctrl] + [Q] Quit Eudora

[Ctrl] + [R] Reply to message

[Ctrl] + [S] Save contents of topmost window

[Ctrl] + [T] Send queued messages

[Ctrl] + [U] Open Ph window

[Ctrl] + [V] Paste

[Ctrl] + [W] Close message

[Ctrl] + [X] Cut

[Ctrl] + [Z] Undo

[Ctrl] + ['] Paste as quote



Appendix C – Mail Transport
Introduction

Eudora uses Simple Mail Transfer Protocol (SMTP) xe "Simple Mail Transfer 
Protocol"§xe "SMTP"§to transfer your outgoing mail to your SMTP server machine, 
which in turn uses SMTP to send your mail to the world at large.  Mail from the 
world at large arrives on your Post Office Protocol (POP) serverxe "POP server"§, 
where it waits for Eudora to pick it up with Post Office Protocol, version 3 (POP3)xe
"POP3"§.  The mail Eudora sends and receives is constructed in accordance with 
RFC 822 and RFC 1521 (MIME).

µ §

Eudora mail transport overview
Outgoing Mail
When you send an e-mail message to someone, Eudora uses SMTP to send the mail 
to your local SMTP server computer.  That computer then sends the mail to your 
addressee’s computer, also (usually) by means of the SMTP protocol.

Why doesn’t Eudora talk directly to your addressee’s computer?  For one thing, it 
would take a lot longer for your mail to leave your PC, because your PC would have 
to call up each addressee’s computer and deliver your mail.  For another, some 
computers are “hard to find;” it’s much better to let another computer “hunt” for your
addressee than to make your PC do it.  Finally, sometimes your addressee’s 
computers won’t be available when you want to send mail.  The SMTP server 
handles this by holding your mail until the other computer is ready to accept  it, 
eliminating the inconvenience of having unsent messages hanging around on your 
PC. 

Incoming Mail
When somebody sends you mail, other computers use the SMTP protocol to deliver 
the mail to your POP server.  Your POP server puts mail in your “mail drop,” where 
it stays until the Eudora program picks it up.  When you check your mail, Eudora 
uses POP3 to pick up your mail and move it to your PC. 

Why doesn’t Eudora use SMTP to receive your mail?  xe "SMTP"§SMTP works best
when the computers it knows about are always ready for mail.  Unless you wanted to 
run Eudora and your PC 24 hours per day, seven days a week, SMTP wouldn’t work 
very well for you.  It also doesn’t work well in lab environments, where you might 
use any number of different PCs. 

More Information
If you want to know more about the Internet in general, consult the book 
Internetworking with TCP/IP, by Douglas Comer, 1988, Prentice-Hall ISBN 0-13-
470154-2 025.



If you want to know more about SMTP, RFC 822, POP3 and MIME, the official 
standards are: 

RFC 821, “Simple Mail Transfer Protocol,” by Jonathan B. Postel 

RFC 822, “Standard for the Format of Internet Text Messages,” by Dave Crocker

RFC 1225, “Post Office Protocol, Version 3,” by Marshall Rosexe "RFCs;RFC 1225,
ÒPost Office Protocol, Version 3,Ó by Marshall Rose"§

RFC 1521, “Multipurpose Internet Mail Extensions,” by Ned Freed and Nathaniel 
Borenstein

You can find the RFC’s by anonymous ftp to nic.ddn.mil; see Internetworking with 
TCP/IP for details. 



Appendix D – MIME and Mapping
What is MIME?

xe "MIME"§“MIME” stands for Multipurpose Internet Mail Extensionsxe 
"Multipurpose Internet Mail Extensions"§.  MIME serves two major purposes – it 
allows mail applications to tell one another what sort of data is in mail, and it also 
provides standard ways for mail applications to encode data so that it can be sent 
through the Internet mail system.

MIME Encoding
The Internet uses the “SMTP” protocol to move mail around.  xe "SMTP"§SMTP is 
limited to the US-ASCII character set (see Appendix C).  This is a problem for 
people who speak languages other than American English and so need accented 
characters or non-American letters, or for people who want to use special symbols 
like the bullet.

MIME provides a way around this restriction.  It offers two encodings, “quoted-
printable”xe "MIME:Quoted-printable encoding"§ and “base64.”xe "MIME:Base64 
encoding"§  These encodings use US-ASCII character codes to represent any sort of 
data you like, including special characters or even non-text data.

Quoted-printable is used for data that is mostly text, but has special characters or very
long lines.  Quoted-printable looks just like regular text, except when a special 
character is used.  The special character is replaced with an “=” and two more 
characters that represent the character code of the special character.  So, a bullet in 
quoted-printable looks like “=95.”  

However, there are some other things that quoted-printable does.  For one, since it 
uses an “=” to mean something special, equal signs must themselves be encoded (as 
“=3D”).  Second, no line in quoted-printable is allowed to be more than 76 characters
long.  If your mail has a line longer than 76 characters, the quoted-printable encoding
will break your line in two, and put an “=” at the end of the first line, to signal to the 
mail reader at the other end that the two lines are really supposed to be one.  Finally, 
a few mail systems either add or remove spaces from the ends of lines.  So, in 
quoted-printable, any space at the end of a line gets encoded (as “=20”) to protect it 
from such mail systems.

Let’s try an example.  Here’s a passage of text that you might type on your PC:
«Il est démontré, disait-il, que les choses ne peuvent être autrement; car tout étant fait pour une fin, 
tout est nécessairement pour la meillure fin.»

Without any encoding, this might show up on your recipient’s screen as:
+Il est dimontri, disait-il, que les choses ne peuvent btre autrement; car tout itant fait pour une fin, 
tout est nicessairement pour la meillure fin.;



This corruption happens because SMTP cannot handle the special characters.  
However, if you and your recipient both have MIME, quoted-printable encoding 
would be used, and your text would show up properly:
«Il est démontré, disait-il, que les choses ne peuvent être autrement; car tout étant fait pour une fin, 
tout est nécessairement pour la meillure fin.»Error: Reference source not found

While your mail was actually in transit, however, it would have looked like:
=ABIl est d=E9montr=E9, disait-il, que les choses ne peuvent =EAtre =
autrement; car tout =E9tant fait pour une fin, tout est n=E9cessairement =  pour la meillure fin.=BB

Base64 encoding is another way to protect binary data from the SMTP mail system.  
However, Base64 makes no attempt to be legible, and is most appropriate for non-
text data.

MIME Labelling
The other important part of MIME is that it lets mailers communicate what kind of 
data is in a message (or part of a message).  The primary mechanism used for this is 
the Content-Type headerxe "MIME:Content-type header"§:

Content-Type: text/plain; charset=iso-8859-1

A content-type header is divided into three parts; the content type, the content 
subtype, and the parameters.  In this case, the content type is “text,” meaning the 
message contains mostly legible text.  The content subtype is “plain,” which means 
there aren’t any formatting commands or anything like that embedded in the text.  
Finally, “charset=iso-8859-1” is a parameter; in this case, it identifies the character 
set the message uses.

The major content types are:

text legible text
image pictures and graphics
audio sound
video moving pictures
message messages or pieces of messages
multipart several different kinds of data in a single message

Practical Issues
There are really only two things you sometimes need to do with Eudora and MIME.  
One is that it may occasionally be necessary to turn off quoted-printable encoding.  
Another is that you may want to know how to define mappings between PC file 
extensions, MIME types, and Macintosh types.

Turning Off Quoted-Printable Encoding
xe "Quoted-printable:Turning off"§Eudora automatically uses quoted-printable 
encoding if your mail contains special characters.  Eudora also uses quoted-printable 
encoding for attached plain text files.  If your recipients don’t have MIME, quoted-
printable may hurt more than it helps.  If that’s the case, just turn off the QP button in



the message icon bar when you are sending text files to those recipients.

 

Turning off Quoted-Printable Encoding
Mapping Between File Extensions, MIME Types, and Macintosh Types
xe "MIME:Mapping"§xe "MIME:Types"§xe "MIME:Macintosh types"§Eudora has 
the ability to map between file extensions, MIME types and subtypes, and xe 
"MIME:Macintosh creators"§Macintosh creators and types.  Messages received by 
Eudora can grab the MIME type/subtype and/or Macintosh creator/type from an 
attachment and map that into the correct file extension.  Also, on outgoing messages, 
Eudora can make sure that attachments are encoded with the correct MIME 
type/subtype and/or Macintosh creator/type depending on the file extension of the 
attachment being sent.

Eudora knows about some MIME types.  However, since new MIME types are being 
defined all the time, it may be necessary to add to Eudora’s knowledge from time to 
time.  Adding new mappings between the various types only requires editing the 
EUDORA.INI file with a text editor (like the one that comes with Eudora).

There is a section in the EUDORA.INI file labelled [Mappings], followed by some 
entries, one per line.  Each entry is called a map.  A map defines when the mapping 
should occur (which can be “in,” “out,” or “both”), followed by an equal sign and 
five parameters.  These five parameters are (in order) the PC file extension, the 
Macintosh creator code, the Macintosh type, the MIME type, and the MIME subtype.
Here are some sample entries:
[Mappings]
both=gif,,,image,gif
both=mpg,,,video,mpeg
both=doc,MSWD,,,
in=xls,XCEL,,,
out=xls,XCEL,XLS4,,
both=eps,,EPSF,application,postscript

A map marked “in” only tries to match the map to messages that you receive.  A map
marked “out” only tries to match the map to messages that you send.  A map marked 
“both” tries to match the map to both incoming and outgoing messages.

The first map says that any incoming MIME message that has a part type of “image” 
and subtype of “gif” will get saved to a file with the extension “.gif.”  It also specifies
that outgoing messages that have an attachment with the file extension “.gif” will get 
the MIME type of “image” and subtype of “gif” if the encoding method of the 
message is MIME.  The second map is similar to the first map in structure, but uses a 
different file extension and MIME type and subtype.

You can use map entries to move between PC file extensions and Macintosh creator 
and type as well.  The third map says that if an incoming message has an attachment 
with the Macintosh creator “MSWD” (which is the Macintosh creator for Microsoft 
Word) then the file extension of the attachment when saved to disk should be “.doc” 



§
(the file extension that Word for Windows uses).  Since the map is marked as “both,”
it will also give attachments with the extension “.doc” on outgoing messages the 
Macintosh creator of “MSWD” if the encoding method of the message is BinHex.  

Note that the Macintosh type from this map is empty.  This allows multiple types to 
be recognized with just one mapping.  The is nice for “in” maps because it allows 
you to cover a range of creator/type pairs with one map.  You must be careful in 
using this type of map with an “out” or “both” mapping, though, because an outgoing
attachment that matched this map would have a Macintosh creator, but no Macintosh 
type.  Some Macintosh applications cannot open files with a missing type.  Microsoft 
Word for the Macintosh can open files without a type, so this map is fine being 
marked “both.”

Microsoft Excel for the Macintosh is an example of a program that can't open a file 
with an empty type.  This is why there are two maps for Excel (the fourth and fifth 
maps above).  The incoming map for Excel is like the one for Microsoft Word, but 
the outgoing map explicitly defines the Macintosh type.

The last map shows that you can have both Macintosh creator/type and MIME 
type/subtype in one entry.  This map says that if an incoming message has an 
attachment that is encoded in MIME and has the “application/postscript” 
type/subtype, or has a BinHex attachment with the Macintosh type of “EPSF,” then 
the resulting file will have an extension of “.eps.”  Similarly, if an outgoing message 
has an attachment with the extension “.eps” and if the MIME encoding is being used 
for the message, then the attachment will get the “application/postscript” MIME 
type/subtype.  If the message was using the BinHex encoding, then the attachment 
would get the Macintosh type of “EPSF.”

But what happens if an attachment matches more than one map?  Eudora will try and 
find the best match.  For example, if you had the following [Mappings] section:
[Mappings]
in=xls,XCEL,,,
in=xlc,XCEL,XLC3,,

and you received a message with an attachment that had a Macintosh creator of 
“XCEL” and a Macintosh type of “XLC3” (a Microsoft Excel Chart), then the file 
would get an extension of “.xlc” since the first map only matched the Macintosh 
creator, but the second map matched both the Macintosh creator and type.

Eudora can receive attachments that have both a MIME type/subtype and a 
Macintosh creator/type.  Eudora understands attachments with the MIME 
type/subtype “application/applefile,” which has Macintosh creator/type information 
embedded in it.  With this type of attachment, Eudora will consider a match with the 
Macintosh creator/type as a “better” match than a match with the MIME 
type/subtype.

Finally, if an incoming attachment matches two different maps to the same degree 
(e.g., both maps have the same MIME type/subtype with different file extensions), 
then Eudora will use the file extension in the first matching map.
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	To use Eudora, you must have an account on a computer that runs a POP3 server. This is the account to which your e-mail messages are delivered before they are transferred to the Eudora program on your PC. In the xe "POP Account setting"§POP account field, type your login name for this account and the full (domain) name of the computer, separating them with an “@” sign. For example, if your assigned login name is “carolyn,” and the name of the computer where you receive e-mail is “uxh.cso.uiuc.edu,” type "carolyn@uxh.cso.uiuc.edu" in this field.
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	At this point, it is best to leave the other items unchanged and click OK. You are now ready to use Eudora. For a quick introduction to the program’s basic functions, see the Tutorial chapter of this document; for detailed explanations of all available Eudora functions, see the Reference chapter.

	Tutorial
	Introduction
	This tutorial introduces Eudora’s basic functions. There are a host of other operations that are not described here. For detailed explanations of all available Eudora functions, see the “Reference” chapter of this document.
	Creating an Outgoing Message
	A good way to familiarize yourself with Eudora is to create an outgoing message. xe "Message:Outgoing"§An outgoing message is one that you send to someone else.
	From the Message menu, select xe "New Message command"§New Message. A new xe "Composition window"§composition window is displayed with the blinking cursor situated at the start of the To: xe "Field"§field.
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	Notice the icon bar of symbols between the title of the window and the To: field. You may ignore the icon bar for now; it is explained in the “Reference” chapter.
	Since it is easiest to experiment with Eudora by sending a message to yourself, type your own e-mail address in the To: field.
	Note that the xe "Message:Outgoing:From field"§From: field has been automatically filled in (and can’t be altered). This is the message xe "Return address"§return address; it should be your own Post Office Protocol (POP) server account address.
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	Move the cursor past the remaining Cc:, Bcc:, and Attachments: fields down into the large area below them. This area is reserved for the actual body of the message. Here you may type in whatever text you want. When you finish your message (referred to throughout this tutorial as your test message) the composition window should look something like the example below.
	
	Example test message, ready to send


	Sending a Message
	xe "Message:Outgoing:Sending"§Notice the xe "Send button"§Send button in the upper right hand corner of the composition window. To send a message in its current state, simply click on this button. Click it now.
	
	Clicking the Send button


	The composition window immediately closes, and the xe "Progress window"§progress window is momentarily displayed at the top of the screen. Eudora uses the progress window to report on the progress of lengthy operations. In this case, it indicates that the message is being transferred out onto the network.
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	Checking for and Receiving Mail
	xe "Checking mail"§There are two ways to check your POP server to see if you have any new mail. One way is automatic and is determined by the Check for mail every ? minutes setting in the Configuration dialog. The alternative is to check for mail manually whenever you want by selecting Check Mail from the File menu. Do this manual check now.
	xe "Checking mail:Entering password"§xe "Password:Entering"§Each time the Eudora program is opened, your password is requested prior to the first mail check, whether it is conducted automatically or manually. Upon the first check, such as now, a dialog is displayed requesting the password of your POP account.
	Note: Your POP account password is provided to you by your system administrator.
	
	Password dialog


	Type in the password and click OK. If you make a mistake before clicking OK, simply backspace and re-enter the password correctly. If your password is rejected, repeat the manual check by selecting Check Mail from the File menu and re-entering your password.
	Note: Remember that the Eudora password may be case-sensitive (depending on your POP server), so it must be typed in exactly or it is rejected. If you are having trouble entering your password, verify that the [Caps Lock] key is off.

	After successfully entering your password, a progress window is momentarily displayed at the top of the screen indicating that an attempt to reach your POP account is being made.
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	If there is a network problem between you and the POP server, an alert is displayed (see below). Consult with your Eudora support coordinator to rectify the problem.
	
	Problem transferring mail
	Note: If you ever have a problem of this type, the numbers in the ()’s are very important. Record these numbers for reference when reporting the problem.



	Keep selecting Check Mail from the File menu until your test message arrives. If the message doesn’t arrive in a minute or two, notify your Eudora support coordinator.
	When mail is found waiting in your POP account, the progress window remains at the top of your screen, allowing you to monitor the transfer of messages from the POP server to your PC.
	
	Progress window while downloading mail


	This is followed by the new mail alert.
	
	New mail alert

	Click OK. The In mailbox window is displayed with your test message summary listed inside.
	
	Message listed in the In mailbox


	Messages are listed in mailbox windows as individual xe "Message Summary"§message summaries. A message summary is divided into fields containing the status and priority of the message (these are discussed in the “Reference” chapter), the name or address of the sender, the time and date the message was sent, its size in K (K = 1024 bytes), and the contents of its Subject: field.
	To select (highlight) the message summary, single-click anywhere on the summary. xe "Mailbox:Opening a message from"§To open the message, double-click on its summary. Do this for your arrived test message to display it on your screen.
	
	Test message display


	Incoming messages are stored indefinitely in the In mailbox until they are deleted or transferred to another mailbox (as described later in this tutorial).
	To close the message, either double-click the close box in the upper left hand corner of the message window or select Close from the File menu. The In mailbox can also be closed in the same fashion.
	Current Messages
	Most Eudora commands can be applied either to an open message window or to highlighted message summaries in a mailbox window. This allows Eudora users to apply commands (such as Transfer, Forward, and Reply) to messages without opening them first. Whenever the term xe "Current message"§current message is used in this tutorial or in the “Reference” chapter, it refers to a message that is open and is in the topmost window or whose message summary is highlighted within a mailbox window (see the following examples).
	
	When a message window is front most, it is the current message

	
	A selected message summary is current
	Examples of current messages


	Replying To a Message
	xe "Message:Incoming:Replying to"§xe "Reply"§For any current incoming message (an xe "Message:Incoming"§incoming message is one that someone has sent to you), you may easily initiate a reply message to its sender without having to create a new message from scratch.
	Open the In mailbox by selecting In from the Mailbox menu. Single-click on the message summary of your test message to highlight it. From the Message menu, select Reply to initiate a reply to this message.
	Note: Select Reply, not Reply To; the Reply To menu item is for use with the quick recipients list, which is described in the “Reference” chapter.

	A new composition window is displayed, with the sender’s address (in this case, your own) automatically placed in the To: field of the header. xe "> markers"§The original sender’s text is automatically included in the body of the message (prefixed by “>” at the beginning of each line). This text may be edited as needed. You may enter more text in the reply message just as in any outgoing message. At this time, move the insertion point to the area below the original message and type in some additional text.
	
	Replying to a message


	Do not send the reply message at this time. Instead, save it as described in the “Saving an Outgoing Message” section.
	Saving an Outgoing Message
	xe "Message:Outgoing:Saving"§Sometimes it is convenient to save an outgoing message either as a safeguard when typing long messages, or for temporary storage so you can return to it at a later time for changes or additions before sending it.
	To save any current outgoing message, such as your new reply message, select xe "Save command"§Save from the File menu. This doesn’t close the composition window but it does save the version of the message (as it appears at the time of the save) in the xe "Out Mailbox"§Out mailbox, which holds all outgoing mail.
	As long as an outgoing message has not been sent out on the network, you can make changes to it. For example, if you want to also send the message to another person, you can add his/her address to the To: field (any two addresses in a single field must be separated by a comma). Having saved your reply message, close the reply message window. Open the Out mailbox (from the Mailbox menu, select Out) to view the message summary. Saved messages are identified by a bullet (o) in the far left column of the message summary.
	
	An outgoing message saved in the Out mailbox


	Transferring a Message Between Mailboxes
	xe "Mailbox:Transferring messages between"§Eudora helps you to organize your incoming mail by allowing you to create new mailboxes and easily transfer messages between them.
	First, create a new mailbox while simultaneously transferring your test message into it. From the Mailbox menu, select In to open the In mailbox. Single-click on your test message summary to highlight it (making it the current message). xe "Mailbox:Creating during transfer"§Then, select xe "New... command"§New... from the Transfer menu. The New mailbox dialog is displayed.
	
	New mailbox dialog


	Any name can be typed in the new mailbox title field, but for this example, type Testing. Click OK to create the new mailbox. Because your test message was highlighted when you selected New... from the Transfer menu, it is automatically transferred into the Testing mailbox. To verify this, select Testing from the Mailbox menu.
	Current messages can also be transferred between existing mailboxes. To demonstrate this, move your original test message from the Testing mailbox back into your In mailbox. Highlight the test message summary (click on it once in the Testing mailbox window) and then select In from the Transfer menu.
	µ §
	Message Transfer

	
	After Transfer
	Transferring a message


	Deleting a Message
	xe "Message:Deleting"§Messages are stored indefinitely in any mailbox until they are explicitly deleted or transferred to another mailbox. Outgoing messages that were saved for further changes remain in the Out mailbox until they are either sent or deleted. Any current message can be deleted.
	Open your test message from the In mailbox. Then, select Delete xe "Delete command"§from the Message menu. Next, open the Out mailbox and select (without opening) the message summary of the reply message you generated previously. Again, select Delete from the Message menu to remove the message from the Out mailbox.
	As a safeguard, the Delete command doesn’t actually delete messages but transfers them to the xe "Trash mailbox"§Trash mailbox. So, if you suddenly realize you mistakenly deleted a message, it can be recovered from and transferred out of the Trash mailbox. To manually delete messages held in the Trash mailbox, select xe "Empty Trash command"§Empty Trash from the Special menu.

	Reference
	Introduction
	This section provides detailed explanations of all available Eudora functions.
	Creating an Outgoing Message
	xe "Message:Outgoing:Creating"§xe "Message:Outgoing"§An outgoing message is a message you send to someone else.
	To create an outgoing message, select xe "New Message command"§New Message from the Message menu. A new xe "Composition window"§composition window entitled No Recipient, No Subject is displayed with the blinking insertion point situated at the start of the To: field. The composition window consists of the title bar, the icon bar, the message header, and the message body.
	
	The composition window

	Title Bar

	The title bar xe "Title bar"§provides information about incoming and outgoing messages, including the name of the sender (if it is an incoming message) or addressee (if it is an outgoing message), the time and date the message was delivered or sent, and a brief message summary. New messages are labeled No Recipient, No Subject until they are sent or queued. Queued message do not have a time stamp until they are sent.
	Icon Bar

	The xe "Icon bar"§icon bar consists of a series of objects that are displayed just under the title bar. It allows you to control your message’s priority, override some of your preference settings for that message only, and send or queue the message. There are three combo boxes and five buttons. Each of the five buttons may be turned on or off for the current message by clicking on it. If there is a shadow around the button (indicating that the button is depressed) the button is turned on. The popup menus and buttons are described below.
	
	The Icon Bar
	Note: The default settings for the icon bar are determined in the Switches dialog (see the “Switches Dialog” section).



	
	Priority Combo Box

	xe "Icon bar:Priority combo box"§The leftmost object in the icon bar is the Priority combo box. For most messages, the priority is (Normal). If you want to indicate that your message is of higher or lower priority than a normal message, use this combo box. Priorities are discussed in the “Message Priorities” section.
	
	Signature Combo Box

	xe "Icon bar:Signature combo box"§xe "Signature:Icon in icon bar"§The Signature combo box allows you to automatically attach your signature file to the end of each message you send. Signatures are discussed in the “Creating a Signature” section.
	
	Attachment Type Combo Box

	xe "Attachment Type:Button in icon bar"§xe "Icon bar:Attachment Type combo box"§The Attachment Type combo box allows you to select what format documents that you attach to outgoing messages are encoded in: Multipurpose Internet Mail Extensionsxe "Multipurpose Internet Mail Extensions"§ (MIMExe "MIME"§) or Bin Hex;;. MIME is best for recipients with MIME (for more information on MIME, see Appendix D) and Bin Hex is most compatible with old Macintosh mailers and previous versions of Eudora.
	
	Quoted-Printable Encoding

	xe "Quoted-Printable:Button in icon bar"§xe "Icon bar:Quoted-Printable"§If this button is on, quoted-printable encoding may be used when sending messages that contain long lines of text or special characters. When on, it is used for all attachments. It is recommended that this button always be on.
	
	Word Wrap

	xe "Icon bar:Word-Wrap"§xe "Word Wrap:Button in icon bar"§If this button is on, a carriage return is not required at the end of each line you type in an outgoing message; Eudora automatically wraps text to the next line, with line breaks at roughly 76 characters per line.
	
	Tabs in Body

	xe "Icon bar:Tabs in Body"§xe "Tabs:Button in icon bar"§If this button is on, hitting the [tab] key within the message body results in xe "Tabs:Replaced with spaces"§Eudora inserting enough spaces to move the insertion point to the next tab stop (as specified in the Configuration dialog). This mimics the way tabs work on many terminals. xe "Tab key:Switching fields with"§If this button is not on, hitting the [tab] key returns the cursor to the To: field of the message header.
	
	Keep Copy

	xe "Icon bar:Keep Copy"§xe "Keep Copies:Button in icon bar"§If this button is on, a copy of each sent message is kept in the Out mailbox (their summaries are marked with an “S” in the far left column of the Out mailbox window, indicating that they have been sent). These messages are saved until they are deleted or transferred to a different folder.
	
	Text As Document

	xe "Icon bar:Text As Document"§xe "Text As Document:Button in icon bar"§If this button is on, text files attached to messages are sent as separate documents. If this button is off, text files are incorporated into the message as part of the message body. The default for this button is set by the Always as Attachment option in the Switches dialog (see the “Switches Dialog" section).
	
	Send or Queue

	xe "Icon bar:Send button"§xe "Icon bar:Queue button"§If the Immediate Send option in the Switches dialog is turned on, the rightmost button in the icon bar is labeled Send. Clicking the Send button immediately sends the message. Otherwise, this button is labeled Queue, and has the same function as the Queue for Delivery command under the Message menu (upon clicking this button, the message window closes and the message is held in the Out mailbox, marked ready for delivery).
	Message Header

	xe "Message:Outgoing:Header"§xe "Message:Outgoing:Body"§Outgoing message headers consist of six fields: To:, From:, Subject:, Cc:, Bcc:, and Attachments:. Each field holds a different piece of information. The To:, Subject:, Cc:, and Bcc: fields can be directly edited.
	xe "Tab key:Switching fields with"§To move the insertion point from field to field, press the [tab] key or click in the desired field with the mouse. When entering information into the fields, you can use the standard Windows text-editing tools provided under the Edit menu. Here is a brief description of the intended contents of each field:
	To:

	xe "Message:Outgoing:To field"§The intended recipient’s e-mail address, or a nickname you have defined (see the “Creating and Using Nicknames” section). Multiple addresses are allowed, but must be separated by commas.
	From:

	xe "Message:Outgoing:From field"§The sender’s e-mail address. This is usually your POP account plus your real name. You can use a return address other than your POP account by entering the desired address in the Return Address field of the Configuration dialog (see the “Configuration Dialog” section).
	Subject:

	xe "Message:Outgoing:Subject field"§Brief text indicating the contents of the message. This field can be left blank (though it is a breach of e-mail etiquette to do so).
	Cc:

	xe "Message:Outgoing:Cc field"§E-mail address or nickname of person to whom a copy of the message is to be sent. Multiple addresses are allowed but must be separated by commas. This field may be left blank.
	Bcc:

	xe "Message:Outgoing:Bcc field"§“Blind” carbon copy. Like addresses listed in the Cc: field, addresses listed here receive copies of the message. Unlike addresses listed in the Cc: field, addresses listed here do not appear in the message header of the recipients. This is useful when you want to send a copy of a message to someone without everyone else knowing you did so. Multiple addresses are allowed but must be separated by commas. This field can be left blank.
	Attachments:

	xe "Message:Outgoing:Attachments field"§List of documents being sent along with the message. Specify these through the Attach Document command under the Message menu (see the “Attachments” section). To delete an attachment from a message, select it by single-clicking on the attachment title and press the [delete] key. You cannot enter information directly into this field. This field can be left blank.
	Message Body

	xe "Message:Outgoing:Body"§After filling in the fields, move the insertion point to the space below the message header. Type the body of the message here. Feel free to use the standard Windows text-editing tools provided under the Edit menu (see the “Summary of Menu Commands” section).
	xe "Word Wrap"§If the Word Wrap button on the icon bar is turned on, you don’t need to press [Enter] at the end of each line of text. The text wraps to the next line automatically. If this option is not set, be sure to type [Enter] at the end of each line or your message may not be legible on the recipient’s computer. To use tabs in the message body, press the Tabs in Body button in the icon bar.
	Saving an Outgoing Message for Later Changes
	xe "Message:Outgoing:Saving"§Sometimes it is convenient to save an outgoing message either as a safeguard when typing long messages, or so you can return to it later to edit or add more text.
	To save the message while the outgoing message window is open, select xe "Save command"§Save from the File menu. The message window does not close, but the current version of the message is saved in the Out mailbox. You might notice that the title appearing at the top of the message window changes from No Recipient, No Subject to what you typed in the To: and Subject: fields of the message.
	xe "Out Mailbox"§If you now close the message (by clicking the close box in the upper left-hand corner of the message window, or by selecting Close from the File menu), it can be re-opened from the Out mailbox for further changes. As with any message summary listed in a mailbox window, it can be identified by the contents of its To: and Subject: fields. xe "Message Summary:Status of message:Sendable"§A bullet (o) in the far left column of a message summary listed in the Out mailbox indicates that the message is being indefinitely held there and is queueable. Such messages remain in the Out mailbox until they are queued and sent or deleted.
	
	A sendable message saved in the Out mailbox


	xe "Message:Outgoing:Closing"§If you try to close an outgoing message window without specifically saving that version of the message, an alert is displayed asking if the message should be saved or the changes discarded. xe "Message:Outgoing:Deleting"§If you select Discard and the message has never been saved, the message is deleted.
	
	Closing an unsaved composition window


	Sending A Message
	One-Step Send

	xe "Message:Outgoing:Sending"§xe "Message:Outgoing:Sending, one-step"§If the Immediate Send option in the Switches dialog is turned on, select Send Immediately from the Message menu to immediately send a current message. xe "Send button"§Alternatively, the rightmost button appearing in the icon bar at the top of the current message window is labeled Send. Click this button to send the current message.
	
	Clicking the Send button


	xe "Show Progress option"§If the Show Progress option in the Switches dialog is turned on, a progress window is displayed momentarily at the top of the screen indicating the progress of the transmission.
	
	Progress Window

	Two-Step Send

	xe "Message:Outgoing:Sending, two-step"§Some people may prefer to compose many messages and transmit them all at once. Eudora lets you queue messages in the Out mailbox for delivery at a later time (this is particularly handy if you are not always connected to your network when using Eudora). However, this is only possible if the xe "Immediate Send option"§Immediate Send option in the Switches dialog is turned off.
	To accomplish the first step for any outgoing current message, select xe "Queue For Delivery command"§Queue For Delivery from the Message menu. Alternatively, the rightmost button appearing in the icon bar at the top of the current message window is labeled xe "Queue button"§Queue. Click this button to queue the current message for later delivery.
	
	Clicking the Queue button


	Either of these selections closes the message window (if it was open), xe "Message:Outgoing:Saving"§saves the message in the Out mailbox and marks it as queued, meaning ready to be delivered. Queued messages are marked by a xe "Message Summary:Status of message:Queued"§“Q” in the far left column of the Out mailbox.
	
	A Queued message in the Out mailbox


	For the second step, select xe "Send Queued Messages command"§Send Queued Messages from the File menu. This sends the queued message (or messages). xe "Show Progress option"§If the Show Progress option in the Switches dialog is turned on, a progress window is displayed momentarily at the top of the screen indicating the progress of the transmission.
	Timed Messages

	xe "Messages:Outgoing:Timed"§It is possible to tell Eudora to send a message at some specific time in the future. To do this for the current outgoing message, select xe "Change Queueing... command"§Change Queueing... from the Message menu. The Change Queueing dialog is then displayed.
	
	Change Queueing dialog


	If you choose xe "Right Now button"§Right Now, the message is sent immediately upon clicking the OK button. If you choose xe "Next timeÉ button"§Next Time Queued Messages are Sent, the message is sent the next time queued messages are sent. If you choose xe "On or After button"§On or After, you can use the time and date fields to fill in the time when the message should be sent. The message is saved in the Out mailbox with a xe "Message Summary:Status of message:Timed"§Q in the status column, just as if it were a normal queued message. However, the message is not actually sent until the specified time arrives.
	Note: For the message to be sent at the correct time, Eudora must be running when the message is due to be sent. If Eudora is not running, the message is sent the first time Eudora is run after the selected time has passed.
	Sending Queued Messages on Check

	If the Send on Check option in the Switches dialog is turned on, every time a manual or automatic mail check occurs, all queued messages are sent, thus saving you the step of selecting xe "Send Queued Messages command:Avoiding"§Send Queued Messages.
	Quitting with Queued Messages

	xe "Quit command:With queued messages"§If you quit Eudora after you have queued messages, but without sending them using Send Queued Messages, Eudora gives you the opportunity to send the messages before you quit.
	
	Quitting with queued messages


	xe "Quit command:With timed messages"§If you quit with timed messages, and the messages are due to be sent within the next 12 hours, Eudora warns you and gives you the opportunity to send them.
	
	Quitting with timed messages

	Editing a queued message

	To edit a queued message, open the Out mailbox and double-click on the desired message summary to open its composition window. Make the necessary edits and re-queue the new version of the message with the xe "Queue For Delivery command"§Queue For Delivery or xe "Change Queueing... command"§Change Queueing... commands from the Message menu or the Save command from the File menu. You can also re-queue the message using the Queue button on the icon bar. The message is returned to the Out mailbox with a queued status. xe "Message:Outgoing:Closing"§If you close the changed message without choosing one of these, an alert is displayed asking you to verify the changes.
	Changing the Status of a Queued Message

	xe "Message:Outgoing:Changing status of"§A message that is queued but as yet unsent may be unqueued using the xe "Change Queueing... command"§Change Queueing... command. Open the Out mailbox and select the desired message summary. Then, select Change Queueing... from the Message menu and click on Don’t Send. This changes the message status from queued (Q) to saved (o). The message is held in the xe "Out mailbox"§Out mailbox until it is either deleted or re-queued and sent.
	Note: You can also send a message immediately or change it to timed send using the Change Queueing... command.
	Keeping Copies of Outgoing Messages

	xe "Keep Copies"§Once a message is sent, it is put into the Trash mailbox unless the Keep Copies option in the Switches dialog is turned on or the Keep Copy button in the icon bar is on. In these cases, the message is left in the xe "Out mailbox"§Out mailbox and is annotated with an xe "Message Summary:Status of message:Sent"§S in the far left column of the Out mailbox indicating that the message has been sent.
	
	Copies of outgoing messages saved in the Out mailbox


	Password Protection
	xe "Checking mail:Entering password"§xe "Password:Entering"§There is password protection on mail checks to your account on the POP server. Each time the Eudora program is opened, your password is requested prior to the first mail check, whether it is conducted automatically or manually. If automatic checking is set (see the “Configuration Dialog” section), a dialog requesting your POP server account password is displayed upon first opening Eudora. If automatic checking is disabled, the same dialog is displayed at the time of your first mail check.
	
	Password dialog


	Type in your password and click OK. If you make a mistake before clicking OK, simply backspace and re-enter the password correctly.
	If your password is rejected, an error message is displayed indicating that you have entered the wrong password. Select Check Mail from the File menu to redisplay the password dialog.
	
	Wrong password
	Note: Remember that the Eudora password may be case-sensitive (depending on your POP server), so it must be typed in exactly or it is rejected.



	xe "Password:Remembering"§xe "Password:Forgetting"§As long as it is running, Eudora remembers your password. If you don’t want it to remember (when, for example, you are away from your PC), select xe "Forget Password command"§Forget Password from the Special menu. At your next mail check you are prompted for your password again.
	xe "Password:Saving"§Another password-related option is xe "Save Password option"§Save Password, which is in the Switches dialog. This option makes Eudora remember your password from one session to the next (you NEVER have to enter your password again, even if you quit and restart Eudora). This option should only be used if your PC is in a secure location.
	xe "Password:Changing"§Finally, the xe "Change Password... command"§Change Password... command in the Special menu can be used to change your POP server password if your POP server machine is running a compatible password-change server. You’ll be asked to enter your old password once, and your new password twice.
	
	Changing a password with Eudora
	Note: For information on password-change servers, see Appendix A of this manual.



	Checking For and Receiving Mail
	xe "Checking mail"§The xe "POP"§POP server is the machine where your mail is received and stored until it is transferred to the Eudora program on your PC. Your POP server account is specified in the xe "POP Account setting"§POP Account setting in the Configuration dialog (see the “Configuration Dialog” section).
	Note: To best understand the functioning of the POP server with respect to Eudora, please see Appendix C.

	There are two methods to check your designated POP server to see if you have new mail. One method is automatic and the other is manual. Both methods deliver any mail addressed to you from the POP server to your PC. Before any checks are made, however, the POP server requests your account password.
	Automatic Checking

	xe "Checking mail:Automatic"§Eudora automatically checks for mail if you tell it how often to do so. From the Special menu, select Configuration.... The Configuration dialog has a field entitled Check For Mail Every ? Minute(s). Type in a value and Eudora automatically checks for mail at the desired interval whenever it is running (even if you are using other applications on your PC). For example, if you type in 15, Eudora checks for mail every 15 minutes. In fact, 15 minutes is a good minimum intervalxe "Checking mail:Automatic:Minimum interval"§, as checking mail more frequently puts an unnecessary load on your POP server.
	Note: If automatic checking is set, the xe "Check Mail command"§Check Mail command under the File menu displays the next time that an automatic check is scheduled to occur.

	When Eudora does an automatic check, you can be notified of new mail in one or all of three different ways: an alert dialog, a special sound, or the opening of the In mailbox. These options are turned on or off in the Switches dialog (see the “Switches Dialog” section). In addition, if Eudora is minimized when new mail arrives, the minimize icon also changes when new mail arrives.
	Note: For the sound alert to work, you may need a sound driver for the PC speaker (see “Appendix A” for a source for this driver).

	When you receive notice that new mail has arrived, select Eudora from the task list or press [Alt] + [Tab] to switch to Eudora. Mail arrives in the In mailboxxe "In mailbox"§. The messages are listed in the order they are received, with the most recent message listed last.
	
	Unread messages in the In mailbox


	If the In mailbox is not already open, select In from the Mailbox menu. xe "Message Summary:Status of message:Unread"§Unread messages are designated by a bullet (o) in the far left column of the message summary. Double-click anywhere on a message summary to open the message. Incoming messages are saved indefinitely in the In mailbox until they are deleted or transferred to another mailbox.
	Manual Checking

	xe "Checking mail:Manual"§You may check for mail manually at any time by selecting xe "Check Mail command"§Check Mail from the File menu. If you haven’t successfully entered your password since opening the Eudora program, you are prompted for it.
	If the xe "Show Progress option"§Show Progress option in the Switches dialog is turned on, the Progress window is displayed momentarily at the top of the screen as the POP server is checked.
	
	The Progress window during a mail check


	If there is a problem reaching the POP server, an error message alert is displayed. To rectify the problem, review the POP server settings in the Configuration dialog for correctness. If there is no obvious error, contact your company’s Eudora support coordinator.
	
	Error while checking mail
	Note: If you ever have a problem of this type, the numbers in the ()’s are very important. Record these numbers for reference when reporting the problem.



	If there is new mail, it is transferred automatically from the POP server to Eudora on your PC. If the xe "Show Progress option"§Show Progress option in the Switches dialog is turned on, a progress window is displayed at the top of your screen allowing you to monitor the mail transfer.
	
	Progress window while downloading mail


	If the New Mail Notification: Alert option in the Switches dialog is turned on, the new mail dialog is displayed, stating that new messages have been delivered.
	
	New mail dialog


	Depending on your settings, the xe "In mailbox"§In mailbox window may display. Mail usually arrives in the In mailbox. xe "Message Summary:Status of message:Unread"§Unread messages in the In mailbox are designated by a bullet (o) in the far left column of the message summary. Double-click anywhere on a message summary to open the message. Incoming messages are saved indefinitely in the In mailbox until they are deleted or transferred to another mailbox.
	Leave Mail on Server Option

	xe "Leave Mail on Server option"§During a mail check, Eudora normally transfers your incoming messages from your account on the xe "POP server"§POP server to your PC, and deletes them from the POP server. This may prove awkward for people who sometimes want to read mail from a secondary PC. It results in non-consolidated storage of messages – if you read mail through a secondary PC, you wouldn’t be able to act on that mail from your primary PC.
	The Leave Mail on Server option in the Switches dialog solves this dilemma. If this option is turned on, Eudora transfers all of your new messages from the POP server to the PC you are presently using (presumably a secondary PC), while keeping copies of those messages in your account on the POP server. On the next mail check from the secondary PC, Eudora xe "Ignoring previously read messages"§ignores the copies of previously read messages and looks for new ones.
	When using your primary PC, you should turn the Leave Mail on Server option off, so that all messages (new ones as well as copies of old ones you read through other PC systems) are transferred to and consolidated on the one primary system. The Leave Mail on Server option should be used with care, since it can result in a buildup of messages on the POP server machine.
	xe "Leave Mail on Server option:Status header"§Note: Eudora looks for a xe "Status header"§Status: R header to determine if a message has been read. Your POP server must cooperate for this to work; most do.
	Skip Big Messages Option

	If the xe "Skip Big Messages option"§Skip Big Messages option in the Switches dialog is turned on, Eudora does not download large messages (40K or larger). Instead, it downloads only the first few lines of such messages and adds a note at the bottom stating that the whole message has not been transferred. This can be useful on slow connections.
	Note: xe "Skip Big Messages option:Status header and"§Eudora requires some help from your POP server to make Skip Big Messages work properly. Specifically, Eudora expects your server to add a xe "Status header"§Status: header once Eudora has downloaded the first few lines of the message. Eudora uses that line as a signal that it already has the first few lines and doesn’t need to download them again.
	Note: The large message threshold can be changed in the [Miscellaneous] section of the EUDORA.INI file using the BigMessageThreshold entry.
	Stopping a Mail Check

	xe "Checking mail:Stopping"§If you want to stop a mail check in the middle (because it is taking longer than anticipated), press the [Esc] key.
	Opening a Mailbox to Read a Message
	xe "Mailbox:Opening"§To open a mailbox, select the desired mailbox from the list of mailboxes under the Mailbox menu. The mailbox window is then displayed.
	
	Opening a mailbox window


	To open a “nested” mailbox (one that is contained within a mail folder), select the outermost folder from the Mailbox menu (folders are designated by an arrow next to their names). This displays the submenu of mailboxes and/or folders within the outer folder. Select the desired mailbox (or continue selecting subfolders until the mailbox can be selected).
	
	Opening a mailbox in a mail folder


	If any messages are stored in the mailbox, they are listed as individual message summaries. A message summary usually consists of the message status and priority, the sender/recipient of the message, the date it was received, its size and the subject heading. See the “Anatomy of a Mailbox Window” section for descriptions of these fields.
	
	Message summaries listed in the In mailbox


	To open a message, double-click on its message summary, or, if the message summary is current (highlighted), press the [xe "Enter key"§Enter] key.
	
	Incoming message example


	Creating a Mailbox
	xe "Mailbox:Creating"§To create a new mailbox, select xe "New... command"§New... from the Mailbox menu. The New Mailbox Dialog is displayed.
	
	New mailbox dialog


	Type in the new mailbox name and click OK. The mailbox is created and added to the Mailbox and Transfer menus.
	You can also create mailboxes using the Mailboxes window under the Windows menu (see the “Mailboxes Window” section). The Mailboxes window is most useful if you want to create several mailboxes at one time.
	Creating a Mail Folder

	xe "Mail folder:Creating"§Eudora allows you to create mail folders in which you may keep one or more mailboxes and even other subfolders that hold additional mailboxes. In other words, not only can mailboxes be organized into folders, but folders can be contained one within another.
	To create a new mail folder, select xe "New... command"§New... from the Mailbox menu. The New Mailbox Dialog is displayed. Type the name of the new mail folder and check the xe "Make it a Folder button"§Make it a Folder option. Click OK to create the folder.
	
	Creating a mail folder


	The new folder name is displayed at the bottom of the list of mailbox names under the Mailbox and Transfer menus. There is an arrow next to the name designating it as a folder and not as a mailbox. You cannot transfer messages into this folder, however, since messages must be in mailboxes and you have not yet created a mailbox within the folder. Therefore, the New Mailbox Dialog is displayed again. Now, type the name of the mailbox you want to create within the newly-created folder and click OK.
	Creating a Mailbox Within a Folder

	xe "Mailbox:Creating mailboxes in folders "§To create a new mailbox within a particular folder, select that folder from under the Mailbox menu and choose xe "New... command"§New... from the submenu that is displayed.
	
	Selecting the New... command from a submenu


	The New Mailbox Dialog is displayed. Type in the new mailbox name and click OK. The mailbox is created and added to the Mailbox and Transfer menus. You can also create subfolders in the same manner. Just check the xe "Make it a Folder button"§Make it a Folder option.
	Anatomy of a Mailbox Window
	xe "Mailbox:Mailbox window"§Mailbox windows are one of the most important elements of Eudora. Each mailbox window consists of a title bar, icon bar, and list of message summaries.
	
	The mailbox window

	Title Bar

	xe "Mailbox:Mailbox window:Title Bar"§The title bar provides the mailbox name.
	Icon Bar

	xe "Mailbox:Mailbox window:Icon Bar"§The icon bar consists of seven buttons that are displayed just under the mailbox title. Each button controls a specific action relating to the mailbox or any current (highlighted) message summaries.
	
	Mailbox Size Button

	xe "Mailbox:Mailbox window:Icon bar:Mailbox Size Button"§The leftmost object in the icon bar is the mailbox size button. Three numbers are displayed on this button. The first is the xe "Mailbox:Number of messages in"§number of messages in the mailbox; the second is the total amount of xe "Mailbox:Space messages require in"§space those messages require; and the third is the amount of disk space that is wasted in the mailbox. The example mailbox above contains four messages which take 1K of disk space. It also has 2K of wasted space.
	Eudora occasionally recovers this xe "Mailbox:Waste space in"§wasted space on its own. To force Eudora to recover this wasted space for the current mailbox, click on this button. To force Eudora to recover this space for all mailboxes, select xe "Compact Mailboxes command"§Compact Mailboxes from the Special menu.
	
	Trash Button

	..i.Mailbox:Mailbox window:Icon bar:Trash Button;This button transfers all selected messages in the mailbox to the Trash mailbox. Its function is identical to the Delete command under the Message menu (see the “Deleting a Message” section).
	
	Reply Button

	xe "Mailbox:Mailbox window:Icon bar:Reply Button"§This button generates a reply to each selected message in the mailbox. Its function is identical to the Reply command under the Message menu (see the “Replying to a Message” section).
	
	Reply All Button

	xe "Mailbox:Mailbox window:Icon bar:Reply All Button"§This button generates a reply to each selected message in the mailbox which includes the sender of the original message and everyone who received it.
	
	Forward Button

	xe "Mailbox:Mailbox window:Icon bar:Forward Button"§This button generates a forward message for each selected message in the mailbox. Its function is identical to the Forward command under the Message menu (see the “Forwarding a Message” section).
	
	Redirect Button

	xe "Mailbox:Mailbox window:Icon bar:Redirect Button"§This button generates a redirect message for each selected message in the mailbox. Its function is identical to the Redirect command under the Message menu (see the “Redirecting a Message” section).
	
	Print Button

	xe "Mailbox:Mailbox window:Icon bar:Print Button"§This button prints each selected message in the mailbox. Its function is identical to the Print... command under the File menu (see the “Printing” section).
	Message Summaries

	xe "Message Summary"§Each line in a mailbox window represents one message and is called a message summary. To select a message summary, single-click on it. There are several ways to select more than one summary. xe "Mailbox:Mailbox window:Range selection in"§You can select a summary and drag through the ones you want to select. You can select one summary, hold down the [Shift] key, and select another summary to select both summaries and all the summaries between them. Finally, you can hold down the [Ctrl] key and select individual summaries. This allows you to make xe "Mailbox:Mailbox window:Disjoint selection in"§“disjoint” selections.
	
	Disjoint selections in a mailbox window
	Message Summary Columns


	Each message summary is divided into five columns: Status/Priority, Sender/Recipient, Date, Size, and Subject.
	
	Message summary columns for the In mailbox

	The xe "Message Summary:Status of message"§xe "Message Summary:Priority of messages"§Status/Priority column displays two items. The first is the message statusxe "Status, message"§, which is one of the following:
	· The message has not been read (all mailboxes except Out), or is queueable but has not been queued (Out mailbox only).
	xe "Message Summary:Status of message:Read"§xe "Message Summary:Status of message:Not sendable"§<blank> The message has been read (all mailboxes except Out), or is not yet able to be queued because it has no recipients (Out mailbox only).
	xe "R message status"§xe "Message Summary:Status of message:Replied"§R Reply has been chosen for the message.
	xe "Message Summary:Status of message:Forwarded"§xe "F Message status"§F Forward has been chosen for the message.
	xe "D message status"§xe "Message Summary:Status of message:Redirected"§D Redirect has been chosen for the message.
	xe "S message status"§xe "Message Summary:Status of message:Sent"§S The message has been sent (outgoing messages only).
	xe "- message status"§xe "Message Summary:Status of message:Unsent"§- The message was transferred from the Out mailbox before being sent.
	Highest priority.
	High priority.
	Normal priority.
	Low priority.
	Lowest priority.
	For more information on message priorities, see the “Message Priorities” section.
	The xe "Message Summary:Sender/Recipient in"§Sender/Recipient column shows the sender of the message (for incoming messages) or the recipient or intended recipient (for outgoing messages).
	The xe "Message Summary:Date in"§Date column displays the date and time the message was sent, or, for timed messages, the date and time the message is scheduled to be sent.
	Note: The xe "Date format"§date is formatted according to the date format specified in the Date/Time applet in the control panel .

	The xe "Message Summary:Size in"§Size column displays the size of the message, in K (K = 1024 bytes).
	The xe "Message Summary:Subject in"§Subject column displays the subject of the message. This information was typed into the message header by the sender.
	Deleting a Message
	xe "Message:Deleting"§As a safeguard against inadvertent deletions, two steps are required to delete a message in Eudora. For any current message, choose xe "Delete command"§Delete from the Message menu. This does not actually delete the message, but transfers it to the xe "Trash mailbox"§Trash mailbox. To delete messages from the Trash mailbox, select xe "Empty Trash command"§Empty Trash from the Special menu. xe "Quit command:And emptying Trash"§Quitting the program also empties the contents of the Trash mailbox when xe "Empty Trash on Quit option"§the Empty Trash on Quit option in the Switches dialog is turned on. Finally, if you want to delete just a few messages from the Trash mailbox, highlight them and select Delete from the Message menu or hit the Trash Button on the mailbox. Deleting a message that’s already in the Trash removes it from Eudora completely.
	xe "Message:Deleting:Unread/Queued"§Also, unless the xe "Easy Delete option"§Easy Delete option in the Switches dialog is turned on, any attempt to delete a message that you have never opened (or a Queued message that hasn’t been sent) results in Eudora asking for confirmation before proceeding with the deletion.
	
	Warning for deleting unread or unsent messages
	Compacting Mailboxes: Recovering Storage Space

	xe "Mailbox:Compacting"§xe "Mailbox:Waste space in"§Even after a message has been deleted with the two-step process described above, the storage space which that message originally required is still taken. Normally, Eudora recovers this space automatically when it becomes troublesome. However, if disk space is very tight, you can force this to happen earlier than usual. In order to reclaim the wasted storage space in all mailboxes, select the xe "Compact Mailboxes command"§Compact Mailboxes from the Special menu.
	Mailboxes can also be compacted individually using the Mailbox Size button in the mailbox icon bar. To force Eudora to recover wasted space for a current mailbox, click on this button.
	xe "Mailbox:Compacting:Thresholds for automatic"§Note: Eudora compacts mailboxes automatically when you close them under either of two conditions. Mailboxes are compacted if the amount of wasted space in the mailbox is greater than the amount of space the messages in the mailbox use, or if the amount of space wasted in the mailbox is greater than 5% of the free space on the volume that contains it.

	Transferring a Message to a Different Mailbox
	xe "Mailbox:Transferring messages between"§xe "Message:Transferring"§Messages may be transferred between any two mailboxes. For any current message, select the mailbox to which the message should be transferred from the Transfer menu. The message is transferred from its previous location to the selected mailbox.
	
	Transferring a message


	xe "Mailbox:Transferring messages between:Copying during"§xe "Message:Transferring:Copying during"§If you hold down the [Shift] key while transferring a message, the message is copied into the new mailbox instead of transferred. This is useful if you want to file a message in more than one mailbox.
	Creating a Mailbox During Transfer

	xe "Mailbox:Transferring messages between:Creating mailboxes during"§xe "Message:Transferring:Creating mailboxes during"§To create a mailbox and transfer the current message into it at the same time, select xe "New... command"§New... from the Transfer menu instead of the name of a mailbox. The New Mailbox Dialog is displayed.
	
	New mailbox dialog


	Type in the new mailbox name and click OK. The mailbox is created and added to the Mailbox and Transfer menus. The current message is also transferred into the new mailbox. However, if you check the xe "DonÕt transfer, just create button"§Don’t transfer, just create mailbox option, the mailbox is created but the message isn’t transferred into it.
	You can also create mailboxes using the Mailboxes dialog under the Windows menu (see the “Mailboxes Window” section) or using the Mailbox menu (see the “Creating a New Mailbox” section). The Mailboxes window is most useful if you want to create several mailboxes at one time.
	Creating a Mailbox Folder During Transfer

	xe "Mail folder:Creating during transfer"§xe "Mailbox:Transferring messages between:Creating mail folders during"§xe "Message:Transferring:Creating mail folders during"§Eudora allows you to create mail folders in which you may keep one or more mailboxes and even other subfolders that hold additional mailboxes. In other words, not only can mailboxes be organized into folders, but folders can be contained one within another.
	To create a new mail folder during message transfer, select xe "New... command"§New... from the Transfer menu instead of the name of a mailbox. The new mailbox dialog is displayed. Type the name of the new mail folder and check the xe "Make it a Folder button"§Make it a Folder option. Click OK to create the folder.
	
	Creating a mail folder


	Your message can’t be transferred, however, since messages must be in mailboxes and you have not yet created a mailbox. Therefore, the new mailbox dialog is displayed again. Now, type the name of the mailbox you want to create within the newly-created folder and click OK to complete the transfer.
	The new folder name is displayed at the bottom of the list of mailbox names under the Mailbox and Transfer menus. There is an arrow next to the name designating it as a folder and not as a mailbox.
	Mailboxes Window
	xe "Mailboxes window"§Mailboxes and mail folders provide a structured way for Eudora users to organize received messages. The Mailboxes window allows you to create new mailboxes and folders and to remove and rename them. You may also want to move mailboxes and folders from one folder to another one.
	To accomplish any of these tasks, choose xe "Mailboxes command"§Mailboxes from the Window menu. The Mailboxes window is displayed.
	
	The Mailboxes window


	The window has two identical listings with scroll bars, each entitled Eudora (or whatever the name of the directory holding your mail is – see the “Mail Storage” section). These list the names of the mailboxes and folders you have created (folders are identified by a folder icon to the left of the folder name). This list is similar to that displayed under the Mailbox and Transfer menus, except that the In, Out, and Trash mailboxes aren’t included. Underneath each of the lists are buttons labeled Rename, New, and Remove. Between the lists are two additional buttons labeled Move, each pointing from one list to the other.
	xe "Mailboxes window:Opening a mailbox from"§Double-clicking on any of the mailboxes in a list opens that mailbox window on the screen. Individual messages can be selected, opened, and otherwise manipulated from there.
	Finding the Mailbox or Folder

	xe "Mailboxes window:Moving around in"§If the Mailbox window isn’t big enough to display all of your created mailboxes and folders, use the scroll bar on the right side of either list to view the rest of the mailboxes and folders.
	Double-clicking on a folder (denoted with an icon of a folder to the left of its name) changes the current title of the list from Eudora to that of the chosen folder. The contents of the list also change to the names of mailboxes and subfolders contained in the chosen folder.
	
	Opening a mail folder


	To move back out of the subfolder to the folder that contains it, double-click on the entry at the top of the list consisting of two periods (..).
	
	Moving back out of a mail folder


	xe "Mailboxes window:Removing mailboxes with"§xe "Mailboxes window:Removing mail folders with"§xe "Removing mailboxes"§xe "Removing mail folders"§With the Mailboxes window open, use the scroll bar and selection tool to locate the name of the mailbox or folder that you want to remove.
	Note: You can perform this function using either of the two lists in the Mailboxes window. It is not necessary to locate a mailbox or folder in both lists before deleting it.

	Once the desired mailbox/folder is found, click on it once to select it. Then, click on the Remove button that is located below the list.
	
	Starting to remove a mailbox


	A dialog is then displayed asking you to confirm the mailbox removal. Click on the Remove It button to remove the mailbox.
	
	Mailbox removal dialog


	xe "Mailboxes window:Selecting multiple mailboxes"§If you press the [Ctrl] key while selecting from a list of mailboxes/folders, you can select more than one mailbox or folder simultaneously. When you click on the xe "Mailboxes window:Remove button"§Remove button, the mailbox removal dialog is displayed to verify the removal. The dialog contains the name of the first mailbox you have selected. If you click on xe "Remove It button"§Remove It, Eudora removes that mailbox, and then displays another dialog for the next mailbox. If you click on xe "Remove All button"§Remove All, all of the selected items are removed without any further prompts.
	If you choose to remove a mailbox in which messages are still stored, or a folder in which other mailboxes or folders are stored, all messages/mailboxes/folders contained within the selected mailbox are also removed.
	
	Removing a mailbox with messages in it

	Renaming a Mailbox or Folder

	xe "Mailboxes window:Renaming a mailbox with"§xe "Mailboxes window:Renaming a mail folder with"§xe "Renaming a mailbox"§xe "Renaming a mail folder"§With the Mailboxes window open, use the scroll bar and mouse pointer to locate the name of the mailbox/folder that you want to rename.
	Note: You can perform this function using either of the two lists in the Mailboxes window. It is not necessary to locate a mailbox or folder in both lists before renaming it.

	Once the desired mailbox/folder is found, click on it once to select it. Then, click on the Rename button that is located below the list.xe "Mailboxes window:Rename button"§
	A dialog is then displayed requesting the new name. Type in the new name and click on Rename to rename the mailbox/folder.
	
	Renaming a mailbox or folder

	Creating a New Mailbox or Folder

	xe "Mailboxes window:Creating a mailbox with"§xe "Mailboxes window:Creating a mail folder with"§xe "Mailbox:Creating with Mailboxes window"§xe "Mail folder:Creating with the Mailboxes window"§New mailboxes and folders can be created using the Transfer menu, as described in the “Creating Mailboxes During Transfers” section, or they can be created using the Mailboxes window.
	With the Mailboxes window open, double-click on the folder in which the new mailbox/folder is to be created to open it. Its name is displayed above the list, and its contents are displayed therein.
	Note: You can perform this function using either of the two lists in the Mailboxes window. It is not necessary to locate a folder in both lists before creating a new mailbox or folder inside it.

	Click on the xe "Mailboxes window:New button"§New button that is located below the list.
	
	Creating a new mailbox


	A dialog is displayed requesting the name of the new mailbox.
	
	Naming a new mailbox


	Type in the new name, check the Make it a Folder option if you want to do so, and click OK. The new mailbox/folder is displayed in the designated folder’s listing. The newly created mailbox/folder is also added to the Mailbox and Transfer menus.
	Moving a Mailbox from one Folder to Another

	xe "Mailboxes window:Moving a mailbox with"§xe "Mailbox:Moving with Mailboxes window"§The Mailboxes window provides the only means for moving mailboxes to other folder locations. This is why there are two lists in the window.
	To begin, locate in one of the lists the mailbox you want to move. In the other list, find and open (by double-clicking on the name) the destination folder so that its name is displayed above the list and its contents are displayed. Then, select the mailbox you want to move. Click on the xe "Move button"§Move button that points from the list containing the item you want to move to the list displaying the destination folder. The chosen mailbox is moved to its new location.
	
	
	Moving a mailbox, before and after


	Attachments
	xe "Messages:Outgoing:Attaching document to"§xe "Attachments"§Any document can be attached to and sent with a Eudora message. To attach a document to a current outgoing message, select xe "Attach Document... command"§Attach Document... from the Message menu. A standard file dialog is displayed. Once the desired document is located, select it and click on the OK button to attach the document to the message.
	
	Attaching a document

	The attached document functions like a “rider” to the e-mail message, and thus it does not appear within the message text. Instead, the full path name of the document is displayed automatically in the xe "Message:Outgoing:Attachments field"§Attachments: field of the message header.
	
	An outgoing message with an attached document
	Note: A document cannot be attached to a message through manual editing of the Attachments: field.



	When the message is sent, the attached document is formatted according to the selection in the Attachment Type combo box in the message icon bar (see the “Icon Bar” section).
	xe "BinHex:And plain TEXT documents"§If the chosen document is a plain text file (and if the xe "Always as Attachment option"§Always as Attachment option in the Switches dialog is turned off, or the Text as Document button in the icon bar is off and you cancel the attach as), it is not encoded in any special format before being sent, but rather it is added to your message as though you had typed it in manually.
	Multiple Attachments

	xe "Attachments:Multiple"§Multiple documents may be sent with a single message, but each document to be attached must be selected as described above.
	Detaching a Document

	xe "Attachments:Detaching"§To detach a document before the message is sent out, click anywhere on the name of the document in the xe "Message:Outgoing:Attachments field"§Attachments: field of the composition window. This selects the entire attachment name. Then, press the xe "Delete key"§[Delete] or [Backspace] key or select xe "Clear command"§Clear from the Edit menu.
	Receiving an Attachment

	xe "Attachments:Receiving"§There are two primary ways you can receive an attachment from another Eudora user. One way prompts you to choose what directory the attachment should be placed in and to assign the attachment’s name. The other way automatically receives all attachments in a pre-specified directory on your disk. Both ways are described below.
	Manual Receive of Attachments

	xe "Attachments:Receiving:Manually"§Unless you choose the xe "Automatically save attachments to option"§Auto Receive Attachment Directory in the Configuration dialog, whenever you receive a message with an attachment from another Eudora user a standard file dialog is displayed. Use this dialog to choose where to put the document and what to call it.
	
	Manually receiving an attachment


	Eudora automatically decodes the attachment, and it arrives on your disk just the way it left the sender’s.
	Not Saving an Attachment

	xe "Attachments:Receiving in encoded form"§You may choose not to save the attached document. This is done by clicking the Cancel button in the above dialog. In such a case, the attachment is included in the body of the message. The document has to be saved to a file and decoded manually to appear in its proper format.
	Saving Attachments Automatically

	xe "Attachments:Receiving automatically"§The most convenient way to save attachments is to a pre-specified directory on your disk. To set this up, select Configuration... from the Special menu. In the dialog, click on the large button next to xe "Auto Receive Attachment Directory option"§Auto Receive Attachment Directory:.
	
	Starting to select an attachments folder


	A dialog is displayed through which you may choose a directory into which arriving attachments are automatically saved.
	
	Selecting an attachments folder


	Double-click on the name of the directory to select it (its name should be displayed above the list). Then, click on the xe "Use Directory button"§Use Directory button.
	The dialog then closes, leaving the Configuration dialog displayed. The name of the directory you just selected now displayed in the button. If you ever want to specify a different directory to receive attachments, simply click on this button and the dialog for choosing an attachments directory is redisplayed.
	In order for the directory to be used, the Auto Receive Attachment Directory: option must also be checked. Eudora checks this for you when you select a directory.
	
	An attachments folder is selected
	Note: If at some future time Eudora cannot find your selected directory, it unchecks the Auto Receive Attachment Directory: option. However, the name of the directory remains in the button until another directory is selected.



	When invoking this option, attachments are decoded automatically and saved directly into the selected directory. The name given your attachments is recorded in the message from which they came. xe "Attachments:And duplicate names"§If you receive multiple attachments with the same name, a number is added to each attachment’s name.
	Non-Eudora Users Receiving Attachments

	If you send an attachment to someone who doesn’t use Eudora, the attached file is included at the end of the message in either MIME or xe "BinHex"§Bin Hex format, depending on how you choose to send it. It is not usable until the recipient has decoded it using an appropriate decoding application.
	Replying to, Forwarding, or Redirecting an Incoming Message
	This section describes the Reply, Forward, and Redirect commands found in the Message menu. These commands are different from the Reply To, Forward To, and Redirect To commands found in the same menu. This latter set of commands is used with the Quick Recipient list (see the Using the Quick Recipient List section for descriptions of these commands).
	Replying to a Message

	xe "Message:Incoming:Replying to"§To reply to a current message, select xe "Reply command"§Reply from the Message menu. A new message window is displayed, with the original sender’s address automatically placed in the xe "Message:Outgoing:To field"§To: field of the header. The original sender’s text is also automatically included at the beginning of the reply message (prefixed by “>” at the beginning of each line). This text may be edited or deleted as needed. Additional text may be entered into the reply just as in any outgoing message. The reply can then be saved for further changes, or simply sent.
	
	A message and its reply


	An incoming message for which the xe "Reply command"§Reply command has been used is identified by an “xe "R message status"§R” in its message summary.
	
	‘R’ indicates that the message has been replied to
	Modified Forms of Reply


	There are some variations of the Reply command.
	Reply all:
	xe "Message:Incoming:Replying to all"§xe "Reply All"§If you hold down the [Shift] key when selecting xe "Reply command"§Reply from the Message menu, the reply message is sent to the sender of the original message and to everyone who received it. This is useful for carrying on group discussions electronically. However, if the xe "Reply All option"§Reply All option in the Switches dialog is turned on, reply all is the default, and you must hold down the [Shift] key to reply only to the message sender.
	Don’t include self:
	xe "Message:Incoming:Replying to all, but not self"§If the xe "Include Self option"§Include Self option in the Switches dialog is turned off, Eudora does not include your return address in the reply all (see the “Include Self” section for information on how Eudora determines who you are).
	Forwarding a Message

	xe "Message:Incoming:Forwarding"§You may want to relay, or forward, messages to other users. To do this, select xe "Forward command"§Forward from the Message menu for any current received message. This transfers the header and body of the received message, denoted with “xe "> markers"§>” markers at the beginning of each line, to the body of a new message window. There, you must fill in the empty xe "Message:Outgoing:To field"§To: field in the message header with the address of the person to whom you want the message forwarded. The existing text may be edited, and more text may be added to the message. A forwarded message is identified (in the xe "Message:Outgoing:From field"§From: field) as coming from you.
	µ §
	Forwarding a message


	An incoming message for which the Forward command has been used is identified by an “xe "F message status"§F” in its message summary.
	
	‘F’ indicates that the message has been forwarded

	Redirecting a Message

	xe "Message:Incoming:Redirecting"§Eudora provides a way to redirect messages that you decide were more appropriately sent to someone besides yourself. To do this select xe "Redirect command"§Redirect from the Message menu for any current incoming message. A new message window is displayed, and you should type in the appropriate recipient in the xe "Message:Incoming:To field"§To: field of the header. The address in the xe "Message:Outgoing:From field"§From: field is that of the person who originally sent the message, by way of your address. In addition, there are no “>” markers at the beginning of each line of the original text. However, you may edit or add more text to the message.
	µ §
	Redirecting a message


	An incoming message for which the Redirect command has been used is identified by a “xe "D message status"§D” in its message summary.
	
	‘D’ indicates that the message has been redirected
	Redirect and Signatures


	xe "Signature:And redirect"§When you use Redirect, your signature file (described in the “Creating a Signature” section) is not added to the message when it is sent, unless the message was originally created by you. Eudora considers the message to be originally from you if the address in the xe "Message:Incoming:Redirecting & From field"§From: field exactly matches your return address setting (or, if you have not entered a return address in the Configuration dialog, your POP account setting).
	Easy Repeat (“Canned”) Messages Using Redirect

	xe "Messages:Using Redirect to repeat"§If you find yourself sending the same message over and over again to different people, you can keep a “canned” copy of that message and send it easily using the Redirect command. To do this, first compose a new message as you normally would, but leave the To: field blank. Save the message, and, if desired, use the Transfer menu to move it from the Out mailbox into another mailbox (named “Canned Messages,” perhaps). When you want to send the message to someone, locate the message and highlight it in the mailbox window (do not open it). Then, select xe "Redirect command"§Redirect from the Messages menu, fill in the To: field, and send the message.
	Creating and Using Nicknames
	xe "Nicknames"§When addressing messages, Eudora supports the use of nicknames in place of full user names. A nickname (sometimes called an alias) is an easily remembered, shorter substitute for an actual e-mail address or group of addresses. Typically, nicknames are created for persons with whom one has repeated correspondence, and hence serve as a typing and reference shortcut. Eudora allows nicknames to be used in place of proper e-mail addresses in the To:, Cc:, and Bcc: fields in the headers of outgoing messages.
	To create, edit, or remove a nickname, select xe "Nicknames... command"§Nicknames... from the Window menu. The Nicknames window is then displayed. This window is divided into three main fields. The Nickname: field lists all your nicknames; the xe "Nicknames window:Address(es) box"§Address(es): field displays a selected nickname’s xe "Nicknames:Expansion"§expansion (the addresses that the nickname represents); and the xe "Nicknames window:Notes box"§Notes: field contains your private notes on a nickname.
	
	The Nicknames window

	Adding New Nicknames

	xe "Nicknames window:Adding nicknames"§To add a new nickname, click on the xe "Nicknames window:New button"§New button. The new nickname dialog is displayed prompting you for the name of the new nickname.
	
	New nickname dialog


	Type the name of the new nickname. If you want this nickname to show up on the xe "Quick Recipient list:Adding new nickname to"§Quick Recipient list under the Message menu (see the “Using the Quick Recipient List” section), click on the xe "Put it on the recipient list button"§Put it on the recipient list option. Then, click OK.
	The new nickname is displayed in the Nicknames: field of the Nicknames window, and the insertion point is placed in the Address(es): field. Type the complete e-mail address of the person to be represented by the nickname.
	
	Entering an address for a nickname


	xe "Nicknames window:Adding names to nicknames"§If you’d like to add someone’s proper name to the address that you specify, just put it in parentheses after the e-mail address.
	Note: Be aware that the proper name is put in the To: field of mail messages along with the full address.

	You may also type a series of many e-mail addresses (and even other nicknames), separated by xe "Commas"§commas or returns ([Enter]), in the xe "Nicknames window:Address(es) box"§Address(es) section. These multiple addresses are represented by the single entered nickname. In this way, a nickname can be used for a group xe "Mailing list"§mailing list.
	
	Using a nickname as a mailing list
	Note: The Nicknames window is the only place where it is permissible to use the [Enter] key to separate addresses. Everywhere else, you must use commas.



	The xe "Nicknames window:Notes box"§Notes: field can be used to enter any text you’d like to associate with a nickname, such as the addressee’s company, title, or phone number.
	
	Entering notes for a nickname
	Note: The contents of the Notes field is not put in mail you send.



	One nickname can point to another nickname, which can point to still another, and so on; eventually, however, the nickname must end in a real address or group of addresses. For example, Eudora Staff contains PJ in its expansion, and PJ is itself a nickname for pjp@muffininc.com in the following example.
	
	
	One nickname using another nickname

	Once you’ve finished typing addresses and notes, you can click the New button again to make another nickname.
	xe "Nicknames:Saving"§When finished making additions or changes, select xe "Save command"§Save from the File menu to save the changes. If you close the Nicknames window without saving the changes, a dialog is displayed asking whether the additions/changes you just made should be saved or discarded.
	
	Saving changes to Nicknames

	Changing and Removing Nicknames

	To change a nickname, select Nicknames from the Window menu. Click once on the desired nickname in the Nickname: field to select it. Then, click the Rename button. A dialog is displayed allowing you to change the nickname. You may also add or remove the nickname from the xe "Quick Recipient list:Adding existing nickname to"§xe "Nicknames:Putting on recipient list"§Quick Recipient using the Put it on the recipient list option. Once the changes are completed, click OK.
	
	Renaming a nickname


	xe "Nicknames:Changing existing"§To change a nickname’s corresponding e-mail address(es) and notes, click once on the desired nickname to select it. The addresses and notes associated with the nickname are displayed in the Address(es): and Notes: fields, and may be directly edited.
	
	Changing a nickname expansion


	xe "Removing a nickname"§xe "Nicknames:Removing"§To remove the nickname, click once on the desired nickname to select it. Click the Remove button.
	xe "Nicknames:Saving"§When finished editing or making deletions, select xe "Save command"§Save from the File menu to save the changes. If you close the Nicknames window without saving the changes, a dialog is displayed asking whether the changes/deletions you just made should be saved or discarded.
	Make Nickname Command

	The xe "Make Nickname command"§Make Nickname command can be used to make a nickname in two different ways.
	xe "Make Nickname command:Using in Nicknames window"§From the Nicknames window itself, use [Ctrl]+ click to select several different nicknames, and then choose Make Nickname... from the Special menu. The new nickname dialog is displayed prompting you for the name of the new nickname. Once you have entered the name, click OK to create the new nickname with the selected nicknames in the Nicknames window as its addressees. xe "Mailing list"§This is an easy way to make a group nickname out of existing nicknames.
	
	Using Make Nickname... to make a mailing list


	xe "Make Nickname command:Using with current messages"§Alternately, you can make a nickname out of the address list of a current message. Open a mailbox and single-click on the desired message to make it current. Select Make Nickname... from the Special menu. The new nickname dialog is displayed prompting you for the name of the new nickname. Once you have entered the name, click OK. xe "Mailing list"§If multiple messages are current (i.e., you have several message summaries selected in a mailbox window), addresses are taken from each message and all are put in the new nickname’s expansion.
	Note: When an incoming message is current, Make Nickname... pretends to do a Reply to the current message, and then takes all the recipients from the reply message and uses them in the nickname expansion. This means that Make Nickname... acts just like Reply in regard to the xe "Include Self option"§Include Self and xe "Reply All option"§Reply All options in the Switches dialog. That is, if the Reply All option in the Switches dialog is turned on (or you hold down the [Shift] key), the nickname is made for all of the recipients of the messages plus the sender, not just the sender. Similarly, if the Include Self option in the Switches dialog is turned off, your address is not included in the new nickname’s expansion.
	
	Making a nickname from current messages

	Using the Nicknames Window to Address Mail

	xe "Nicknames window:Using to send mail"§xe "Nicknames window:Using to add addressees to message"§xe "Message:Outgoing:Creating from Nicknames window"§xe "Message:Outgoing:Adding addressees to with Nicknames window"§The To:, Cc:, and Bcc: buttons in the Nicknames window can be used to start mail messages or to add addressees to existing current messages. To create a new message from the Nicknames window, select the nickname to which you want to address the mail (you can select multiple nicknames by holding down the [Ctrl] key and clicking on each nickname). Then, click the xe "To button"§To: button.
	
	Starting a new message from the Nicknames window


	A new composition window is displayed with the selected nickname(s) inserted in the To: field. Use the xe "To button"§To:, xe "Cc button"§Cc:, and xe "Bcc button"§Bcc: buttons to insert additional nicknames into the corresponding fields.
	The Nicknames window can also be used to address existing. Make sure the desired message is current (topmost), then open the Nicknames window and use the To:, Cc: and Bcc: buttons to address the message.
	Nicknames and the Quick Recipient List

	xe "Nicknames:vs Quick Recipient list"§xe "Quick Recipient list:vs Nicknames"§Nicknames and the Quick Recipient list are two separate entities. Nicknames are used as an abbreviation for an address or a list of addresses. The Quick Recipient list is used to add addresses to messages via the Message menu. Nicknames do not need to be on the Quick Recipient list, and not everything on the Quick Recipient list needs to be a nickname.
	However, you may have nicknames to which you often send mail, and it makes sense to add these nicknames to the Quick Recipient list. This is easily done from the Nicknames window. xe "Quick Recipient list:Adding existing nickname to"§xe "Nicknames:Putting on recipient list"§Double-click on a nickname to add it to or remove it from the Quick Recipient list. A check mark next to the nickname indicates that it is on the list.xe "Nicknames:Removing from Quick Recipient list"§
	
	The nickname is now on the Quick Recipient list


	The Quick Recipient list is discussed further in the “Using the Quick Recipient List” section. xe "Nicknames:Renaming and Quick Recipient list"§xe "Nicknames:Removing and Quick Recipient list"§If you rename or remove a nickname that is also on the Quick Recipient list, the name on the Quick Recipient list is also changed or removed.
	Quick Recipient List
	xe "Quick Recipient list"§It may be more convenient to address a message by selecting a nickname or full address from a predetermined Quick Recipient list. This eliminates the need to type frequently used nicknames or addresses in the fields of outgoing message headers. By selecting a nickname or address from the Quick Recipient list, the address or nickname is automatically entered in the desired field. The list may also be used to more easily reply to, forward or redirect messages.
	Eudora uses a single Quick Recipient list that can be accessed via the New Message To, Reply To, Forward To, and Redirect To selections under the Message menu, the Insert Recipient selection under the Edit menu, and the Remove Recipient selection under the Special menu.
	
	The Quick Recipient list

	Creating the Quick Recipient List

	The Quick Recipient list should consist of the nicknames or addresses of common correspondents. xe "Quick Recipient list:Adding existing nickname to"§To add a nickname to this list, choose Nicknames from the Special menu (see the “Creating and Using Nicknames” section for more details). The Nicknames window is displayed. xe "Quick Recipient list:Adding existing nickname to"§xe "Nicknames:Putting on recipient list"§Double-click on a nickname to add it to or remove it from the Quick Recipient list. A check mark next to the nickname indicates that it is on the list.xe "Nicknames:Removing from Quick Recipient list"§
	
	All nicknames are currently added to the Quick Recipient list


	xe "Quick Recipient list:Adding email address to"§To add a full e-mail address to the Quick Recipient list, select the text that makes up the full address in any current message header. Then, select xe "Add As Recipient command"§Add As Recipient from the Special menu.
	
	Adding an address to the Quick Recipient list

	Using the Quick Recipient List

	xe "Message:Outgoing:Addressing with Quick Recipient list"§The Quick Recipient list is displayed when you select xe "New Message To submenu"§New Message To, xe "Reply To submenu"§Reply To, xe "Forward To submenu"§Forward To, or xe "Redirect To submenu"§Redirect To from the Message menu. To utilize the list, select a recipient using one of these commands. Releasing the mouse button performs the action (new message, reply, forward, redirect) and the chosen recipient is automatically inserted in the To: field of the new message header.
	
	Starting a message with the Quick Recipient list


	More than one nickname or address from the Quick Recipient list can be added to the To:, Cc: and Bcc: fields of any message. To do this, first place the blinking insertion point in the field where you want the nickname/address to be inserted. Then, select the desired recipient from the xe "Insert Recipient submenu"§Insert Recipient list under the Edit menu. The chosen nickname/address is placed at the insertion point and a xe "Commas"§comma is added (if necessary) to separate the new address from the ones previously placed in the field.
	Removing a Quick Recipient From the List

	xe "Quick Recipient List:Removing entry from"§To remove a nickname/address entry from the Quick Recipient list, select it using the xe "Remove Recipient command"§Remove Recipient option under the Special menu. When you release the mouse button, the selected recipient is deleted.
	Note: Removing a nickname from the Quick Recipient list does not delete it from the Nicknames window, but removing a nickname from the Nicknames window deletes it from the Quick Recipient list.

	Finding Text Within Messages
	xe "Find"§Eudora incorporates a Find function that searches for specific text within a single message, multiple messages, or even multiple mailboxes. To display the Find submenu of commands, select Find from the Edit menu.
	
	The Find submenu

	Finding Text Within One Message

	xe "Find:Within a message"§To search for text within a single message, open the message and make sure it is current. Then, select Find from the Edit menu and select the Find command from the submenu. The Find dialog is displayed, with the blinking insertion point located in the text field.
	
	The Find dialog


	Type the text you want to find in the text field. When finished entering the desired text, click the xe "Find button"§Find button.
	
	Finding text


	Starting at the beginning of the open message, Eudora searches the current message for the specified text. If no match is found, the not found alert is displayed.
	
	Unsuccessful search


	If the search is successful, the message is scrolled to the first point where the match is found and the matching text is highlighted.
	
	Successful search


	To continue searching in the same message for the next occurrence of the text, click the xe "Find button"§Find button in the Find dialog, or select the Find Again command from the Find submenu. These commands are equivalent and limit the search to the same message. Repeating these commands cycles through the matches in the open message only.
	Finding Text Among Multiple Messages and Mailboxes

	xe "Find:Multiple messages"§The Next, Next Message, and Next Mailbox commands are located in the Find submenu (under the Edit menu) or as buttons in the Find dialog.
	Next

	xe "Next command"§xe "Next button"§xe "Find:Next button"§The Next button (or Next command) allows you to search for the next match of the specified text until it is found either in the same message or among all messages in the current mailbox.
	Note: The Next command initiated in an open mailbox (even with message[s] selected) searches for the specified text among all messages contained in that mailbox. The search begins with the first message in the mailbox.
	Next Message

	The xe "Next Message command"§xe "Next Message button"§xe "Find:Next Message button"§Next Message button (or Next Message command) begins the search at the message after the current message. Eudora continues to search until it finds a matching character string, even if it has to open more than one message or a new mailbox.
	Next Mailbox

	The xe "Next Mailbox command"§xe "Next Mailbox button"§xe "Find:Next Mailbox button"§Next Mailbox button (or Next Mailbox command) begins the search for the specified text in the mailbox following the current mailbox. The search is conducted among all messages in that mailbox and any subsequent mailboxes, including the In, Out, and Trash mailboxes.
	Note: Mailboxes are searched in the order they are listed under the Mailbox menu until the current mailbox is reached.
	Match Case

	xe "Match Case option"§xe "Find:Match Case option"§Normally, Eudora ignores capitalization when searching. If you want Eudora to consider capitalization when searching, check the Match Case option in the Find dialog. When this option is checked, Eudora searches for exact matches of character strings, including any capitalization.
	Summaries Only

	xe "Summaries Only option"§xe "Find:Summaries Only option"§If you know the text you are searching for is included in a message summary, check the Summaries Only option in the Find dialog. When you click the Find button, Eudora searches for the text only in the Sender and Subject fields of message summaries as they appear in mailbox windows. Eudora searches much faster when this option is checked.
	Enter Selection Command

	If you don’t want to actually type the text in the Find dialog (for example, the text is very long or complex), highlight it in an existing message, and then select xe "Enter Selection command"§Enter Selection from the Find submenu. This automatically inserts the selected text at the insertion point in the Find dialog. Then, select the Find command from the Find submenu to start the search.
	Stopping a Find

	xe "Find:Stopping"§If you want to stop Eudora from continuing a search, press the [Esc] key.
	Sorting Messages Within Mailboxes
	xe "Sorting"§It is possible to sort the message summaries in a mailbox window according to their status, priority, sender, date, or subject. These commands are listed in the Sort submenu under the Edit menu.
	
	The Sort submenu


	To use any of these commands, first open the mailbox to be sorted. Then, select the appropriate command from the Sort submenu. The messages are sorted when the mouse button is released.
	Eudora sorts in ascending order; the smallest item first. To sort in descending order, hold down the [Shift] key while choosing the desired command from the Sort submenu.
	Tip: Eudora’s sorting algorithm is “stable.” This means that sorting on a particular column leaves items of the same value in the same order as they were before the sort. This feature allows you to sort based on multiple criteria by using xe "Sorting:Multiple criteria"§multiple sort commands. For example, if you want your messages sorted by subject, and within each subject you want messages sorted by date, first choose Sort by Date, then Sort by Subject.
	Note: xe "Sorting:By date"§Sometimes Eudora does not sort by date properly. This happens if the messages have incorrectly formatted date fields or unknown or incorrect time zones. Also, since Eudora uses Greenwich Mean Time (GMT) when sorting by date, the messages may merely appear to be out of order because the time stamp is the local time at the location where the messages originated. For example, a message sent at 11:30 EST is listed before a message sent at 10:00 PST, because 11:30 EST actually occurs before 10:00 PST.

	Saving a Message to a File
	xe "Messages:Saving to files"§Eudora allows you to save a current message(s) to a separate text file on your PC. To do this, first display the desired message or highlight its summary in the mailbox window. Then, select xe "Save As... command"§Save As... from the File menu. The Save As dialog is displayed allowing you to choose a name and location for the file.
	Note the two options at the bottom of the dialog. xe "Guess Paragraphs option"§Guess Paragraphs instructs Eudora to remove extraneous carriage returns from the message, leaving returns only at the ends of paragraphs. In addition, it converts multiple spaces into xe "Tabs:And Save As... command"§tabs.
	xe "Include Headers option"§Include Headers instructs Eudora to retain the message’s header information in the saved document. If this is unchecked, only the body of the message is saved.
	
	Saving a message to a text file


	Once you’ve made all of your choices, click on the OK button in the dialog.
	If you select multiple messages from a mailbox window and select Save As..., all of the messages are saved to a single file.
	
	Using “Save As...” to save several messages to one file
	xe "Messages:Incoming:Recombining split messages"§Tip: When Eudora receives a very large message from the POP server, it splits that message into multiple smaller messages. If you need to reassemble the original message, use the Save As... command.



	Resending Rejected Messages
	xe "Bounced mail"§xe "Rejected Mail"§xe "Message:Incoming:Sending again"§xe "Errors:Bounced mail"§Mail Transport Agents are computer programs responsible for routing e-mail messages through networks. If for some reason an e-mail message can’t be delivered to an intended recipient, these programs return the message to the original sender. A message is typically rejected because of an error in the recipient’s address, although there are many possible reasons.
	The message sent back from the mail system usually includes cryptic information that may allow you to determine the reason for the message being rejected. It also includes the text of the original message.
	
	A rejected message


	If you choose to resend the message, Eudora deletes the error messages and added text and recovers the original message so that you can make any corrections. To do this for the current message, select xe "Send Again command"§Send Again from the Message menu. This eliminates the inserted extra text and reformats the message as it originally appeared. You can then make changes or additions and resend the message, if desired.
	
	A rejected message, restored


	Message Priorities
	xe "Message:Priority"§xe "Priority"§Eudora allows you to assign priorities to your messages. These priorities are for sender/recipient reference purposes only, and they do not affect the way Eudora handles the messages.
	There are five priority levels available, each represented by a small icon. Priorities range from 1 (highest) to 5 (lowest). Priority 3 is assumed for messages that have no assigned priorities, and it is not displayed.
	Highest priority.
	High priority.
	Normal priority.
	Low priority.
	Lowest priority.
	Message priorities are displayed in the Status/Priority column of the mailbox window.
	
	Message priorities displayed in the mailbox window


	To change the priority of a message, open the message and choose the desired priority from the Priority combo box on the icon bar. The selected priority icon is then displayed in the combo box.
	
	
	Assigning a priority to a message


	You can also change the priority of the current message(s) by holding down the [Ctrl] key and pressing a number key from 1 to 5 (1 = Highest, 5 = Lowest).
	xe "Priority:And Reply"§Note: All new messages are created with Normal priority, even replies to messages whose priority you have changed. The exception to this is that, if the sender of a message gives it a priority other than normal, Eudora insists on giving your reply the same priority. This occurs even if you reassign the priority of the sender’s message after you have received it. You can, however, change the priority of your response by re-assigning it manually.

	Editing Message Subjects
	xe "Message Summary:Changing subject of"§xe "Subject:Changing"§Sometimes the subject of a message is not clear or descriptive. Eudora allows you to edit the subject of any incoming message.
	Note: The subjects of outgoing messages (messages sent by you) cannot be edited.

	To edit the subject of an incoming message, open it from its mailbox window. Notice that the subject is displayed below the title bar and above the message. You can edit this text as you would any other text. When editing is complete, close the message. The new subject is displayed in the message summary. The contents of the Subject: field of the message header remain unchanged.
	
	Editing the subject of an incoming message

	
	After Editing the subject
	Note: If you reply to the message, the original subject is used for the reply, not your changed subject. This gives you the freedom to put information useful to you into the summary, without fear of your private notes being revealed to your correspondents.



	Printing
	Eudora can print a current message or messages, text files, signatures, or the contents of the Ph window. To print from within Eudora, select xe "Print... command"§Print... from the File menu with the message or Ph window displayed. Eudora automatically prints headers and footers on each page, giving the window title, page number and your return address.
	Using the Ph Window
	Eudora can access two different directory services, xe "Ph"§Ph and xe "Finger"§Finger, via the Ph window. To display the Ph window, select Ph from the Window menu.
	
	The Ph window


	The Ph window has two buttons (one for Ph and one for Finger), and three text fields: one where you specify which server to use (Server)xe "Ph:Ph Server field"§; one where you type your query (Command)xe "Ph:Ph command field"§; and one where you see the response.
	xe "Ph:Using Ph window for"§To use the Ph protocol, type the name of the Ph server in the Server field or use the default server (the default is what is entered in the Ph Server field of the Configuration dialog). Then, type the name of the person you want to look up in the Command field and click on the xe "Ph button"§Ph button. The server’s response is displayed in the response field.
	
	A Ph query and its response
	Note: You can type any Ph command in the query field, except login commands or commands requiring login. For more information about the Ph server source code, see Appendix A.


	Using Finger

	xe "Finger:Using Ph window for"§To use the Finger protocol, type your query into the query field. This query should be in the form “name@domain.” If you omit the “@domain” segment, Eudora uses the server listed in the Server field. Once the name is entered, click on the xe "Finger button"§Finger button.
	The finger query is sent to the host specified in the “@domain” part, and the response is displayed in the response field.
	
	A Finger query and its response


	Creating a Signature
	A “xe "Signature"§signature” is a brief message automatically added by Eudora to the end of outgoing messages. It should consist of a few lines giving the sender’s full name and e-mail address. Other pertinent details, such as phone number, postal address, or place of employment are also sometimes included.
	To create a signature, select xe "Signature:Menu command"§Signature from the Window menu. A blank Signature window is displayed. Type your text in this window.
	
	Typing a signature


	When you are finished typing the signature, close the Signature window. An alert is displayed asking if you want to save the changes to your signature. Click Save. You may modify your signature at any time by repeating this procedure.
	In order to activate your signature on an outgoing message, select it from the Signature combo box on the icon bar.
	µ §
	Activating your signature in the icon bar
	Note: The signature text is not displayed at the end of messages you create, but your recipients see it.



	Configuration Dialog
	In order for Eudora to work correctly, the program must be configured by providing it with some basic though important information. To enter this information, select xe "Configuration... command"§Configuration... from the Special menu. The Configuration dialog is displayed.
	
	The Configuration dialog


	The Configuration dialog is divided into two segments, Network Configuration and Message Configuration.
	Network Configuration

	xe "Network Configuration"§Each of the fields in the Network Configuration segment of the Configuration dialog is described below. The default settings are listed in brackets after the name of each field.
	
	The Network Configuration segment of the Configuration dialog
	POP Account: [none]


	xe "Network Configuration:POP Account setting"§To receive mail with Eudora, you must have an account on a computer that runs a POP 3 server. This is the account to which your e-mail messages are delivered before they are transferred to the Eudora program on your PC. Enter your login name for this account, followed by an “@” sign and the (domain) name of the computer.
	For example, if the login name for your POP account is “carolyn,” and the name of the computer is “uxh.cso.uiuc.edu,” type carolyn@uxh.cso.uiuc.edu in this field.
	Real Name: [none]

	xe "Network Configuration:Real Name setting"§Type your real name here. It is placed in parentheses after your return address in your outgoing mail. It is also displayed in the Sender column of incoming message summaries.
	SMTP Server: [none]

	xe "Network Configuration:SMTP Server setting"§To send mail, a computer with an SMTP (Simple Mail Transfer Protocol) server program is necessary. You need not have a login on this computer, but you must have access to it through your network. If the computer on which you have your POP account is also an SMTP server, leave this field blank. Otherwise, specify the name of the computer which you want to use as your SMTP server.
	Return Address: [none]

	xe "Network Configuration:Return Address setting"§Normally, Eudora uses your xe "POP Account setting"§POP Account as your return address. If you wish to use a return address other than your POP account, type it here.
	Important: If you do type an address in this field, first test the address to be sure that mail sent to it is indeed delivered to you. If you use an invalid return address, no one can reply to your mail.
	Check For Mail Every ? Minute(s) [0]

	xe "Network Configuration:Check For Mail setting"§If you type a number in this field, Eudora checks your POP server for new mail at regular intervals and transfers any mail addressed to you to your PC. The number you enter specifies the number of minutes between checks of the POP server. It’s a good idea to set this at no less than 15 minutes. Checking mail more frequently puts an unnecessary drain on your POP server. This option only works when Eudora is running. Leaving this field empty disables automatic checking.
	Ph Server: [none]

	xe "Network Configuration:Ph Server setting"§Type the host name of your Ph name server here.
	Note: For more information on Ph servers, see Appendix A.
	Message Configuration

	xe "Message Configuration"§Each of the fields in the Message Configuration segment of the Configuration dialog is described below. The default settings are listed in brackets after the name of each field.
	
	The Message Configuration segment of the Configuration dialog
	Message Width: [80]


	xe "Message Configuration:Message Width setting"§This field specifies the width of new and received message windows (in characters). If you leave this field blank, the default value is 80. This setting has no effect on what your mail looks like when it is sent. When mail is sent, Eudora wraps at or before 76 columns.
	Note: If you use a proportional font, Eudora sets the window width based on the average width of the characters in the font.
	Message Lines: [20]

	xe "Message Configuration:Message Lines setting"§This field specifies the height of new and received message windows (in lines). If you leave this field blank, the default value is 20.
	Note: If the Zoom Windows option in the Switches dialog is turned on, received message window heights are automatically adjusted to the length of the message text.
	Tab Stop: [8]

	xe "Message Configuration:Tab Stop setting"§This field specifies the number of spaces between tab stops.
	Screen Font, Size: [Courier New]

	xe "Message Configuration:Font settings:For screen"§This combo box allows you to select a screen font to be used for displaying the text of your Eudora messages and mailbox windows. Type the size (in points) of the font you are using in the Size field.
	Printer Font, Size: [Courier New]

	xe "Message Configuration:Printer settings"§xe "Print... command:Font settings"§xe "Font Settings:for printing"§This combo box allows you to select a font to be used when you print messages using the Print... command. Type the size (in points) of the font you are using in the Size field.
	Auto Receive Attachment Directory: [off, none]

	xe "Message Configuration:Auto Receive Attachment Directory setting"§xe "Attachments:Receiving automatically"§If this option is checked, Eudora automatically places file attachments that come with messages into the specified directory. To change the setting, single-click on the application name button (the default is blank). A dialog is displayed allowing you to select the directory (see the “Saving Attachments Automatically” section).
	Switches Dialog
	xe "Switches... command"§You may tailor many aspects of Eudora to your own needs and preferences. Some of these are set with the Configuration dialog described in the previous section. Others are set with the Switches dialog. If the setting can be either on or off, it’s in the Switches dialog; if a choice beyond on or off is required, it’s in the Configuration dialog. The one exception to this is the Encode With option in the Switches dialog. To display the Switches dialog, select Switches... from the Special menu.
	
	The Switches dialog


	xe "Switches dialog"§The Switches dialog is divided into seven sections of options, with a descriptive heading above each section. A check in the box next to the option indicates that the option is on. Each of the options is described below. The default settings are listed in brackets after the name of each option.
	Composition Options

	xe "Switches dialog:Composition options"§Many of the Composition options can be turned on and off for individual messages using the icon bar displayed at the top of the message composition window. However, setting them here establishes these settings as the icon bar defaults for all new composition windows.
	
	The Composition section of the Switches dialog
	Use Signature [on]


	xe "Use Signature option"§xe "Signature:Enabling/disabling"§If Use Signature is on, Eudora automatically attaches your signature file (if you have one) to the end of outgoing messages.
	May Use QP [on]

	xe "May Use QP option"§xe "Quoted-printable encoding"§If May Use QP is on, Eudora uses quoted-printable encoding when necessary, such as when messages that contain long lines of text or special characters are sent. If this option is off, quoted-printable encoding is not used.
	Word Wrap [on]

	xe "Word Wrap option"§xe "Word Wrap"§If Word Wrap is on, a carriage return is not required at the end of each line of type in an outgoing message. Eudora automatically wraps text to the next line, with line breaks at roughly 76 characters per line. This makes your mail more legible to recipients using line-oriented mail systems. It is strongly recommended that you turn this option on.
	Tabs in Body [on]

	xe "Tabs in Body option"§xe "Tabs:Replaced with spaces"§If Tabs in Body is on, hitting the [tab] key within the message body results in Eudora inserting enough spaces to move the insertion point to the next tab stop (as set in the Configuration dialog). This mimics the way tabs work on many terminals. If this option is off, hitting the [tab] key returns the cursor to the To: field of the message header.
	Keep Copies [off]

	xe "Keep Copies option"§If Keep Copies is on, a copy of each sent message is kept in the Out mailbox (their summaries are marked with an “S” in the Status/Priority column of the Out mailbox window). If this option is off, Eudora moves outgoing messages to the Trash mailbox after they are sent.
	Reply to All [off]

	xe "Reply to All option"§xe "Message:Incoming:Replying to all"§If Reply to All is on, selecting Reply from the Message menu creates a message addressed not only to the sender of the original message, but also to all of its recipients. If the option is off, Reply addresses the new message only to the sender.
	You can use the xe "Reply to All option:Option key and"§[Shift] key to reverse this setting for any given reply. That is, if this option is off, holding down the [Shift] key while choosing Reply replies to all, and vice-versa.
	Note: This option setting also affects the xe "Make Nickname command"§Make Nickname command (see the “Make Nickname Command” section).
	Include Self [off]

	xe "Include Self option"§xe "Message:Incoming:Replying to all, but not self"§If Include Self is on, when you do a reply all (as described above) your address is left in the address list of the new message and you receive a copy of your own reply. If this option is off, your address is removed from the reply message.
	To determine who you are, Eudora uses the contents of the POP Account and Return Address fields from the Configuration dialog. xe "Me nickname"§xe "Nicknames:Me nickname"§If you have additional addresses, you can create a “me” nickname using the Nicknames window. List all of the addresses and aliases for yourself in the Address(es) field for the me nickname. This gives Eudora a more complete listing of who you are. It also insures that when you reply to messages sent to you at an address other than what is listed in the Configuration dialog, the include self option works correctly.
	Note: This option setting also affects the xe "Make Nickname command"§Make Nickname command (see the “Make Nickname Command” section).
	Send Attachments Options

	xe "Switches dialog:Send Attachments options"§These options define the way attachments are sent.
	
	The Send Attachments section of the Switches dialog
	Always as Attachment [off]


	xe "Always as Attachment option"§If Always as Attachment is on, text files attached to messages are sent as separate documents and encoded using the selected Encode With format. If this option is off, text files are incorporated into the message as part of the message body, which is plain text format. If this option is off and the attachment is not a text file, it is still sent as a separate document and encoded using the selected format.
	Encode With: [Bin Hex]

	This option allows for the selection of what format documents you attach to outgoing messages are encoded in: MIME or Bin Hex. MIME is best for recipients with MIME and Bin Hex is most compatible with old Macintosh mailers and previous versions of Eudora.
	Checking Options

	xe "Switches dialog:Checking options"§These options determine the way Eudora checks for and receives mail.
	
	The Checking section of the Switches dialog
	Save Password [off]


	xe "Save Password option"§xe "Password:Saving"§If Save Password is on, you never have to enter your password to check your mail (even if you quit Eudora and restart it) because your password is stored on your PC. Only use this option if your PC is in a secure place.
	Leave Mail On Server [off]

	xe "Leave Mail On Server option"§xe "Checking mail:Leave Mail On Server Option"§Eudora normally transfers your incoming messages from your account on the POP server to your PC, and deletes them from the POP server. If Leave Mail On Server is on, Eudora transfers incoming messages to your PC and also keeps copies on the POP server (see the “Leave Mail on Server Option” section).
	Skip Big Messages [off]

	xe "Skip Big Messages option"§xe "Checking mail:Skip Big Messages option"§If Skip Big Messages is on, Eudora does not download the entire texts of very large messages from the POP server, but only downloads the first few lines. This can be useful on slow connections (see the “Skip Big Messages Option” section).
	Sending Options

	xe "Switches dialog:Sending options"§These options determine the way Eudora sends mail.
	
	The Sending section of the Switches dialog
	Send On Check [on]

	xe "Send On Check option"§xe "Checking mail"§xe "Sending mail"§If Send On Check is on, Eudora automatically sends any messages that are queued in the Out mailbox whenever it checks the POP Server for new mail.
	Immediate Send [on]

	xe "Immediate Send option"§xe "Message:Outgoing:Sending, one-step"§xe "Message:Outgoing:Sending, two-step"§If Immediate Send is on, the rightmost button in the icon bar of the message composition window is labeled xe "Send button"§Send. Clicking on this button immediately sends the message to the POP server. If this option is off, the button is labeled Queue and clicking on it places the message in the Out mailbox marked ready for delivery (Q).
	New Mail Notification Options

	xe "Switches dialog:New Mail Notification options"§These options determine what Eudora does when new mail arrives.
	
	The New Mail Notification section of the Switches dialog
	Alert [on]


	xe "Alert option"§xe "Alerts:Disabling"§If Alert is on, Eudora uses a dialog box to notify you when new mail arrives.
	Sound [on]

	xe "Sound option"§xe "Checking mail:Sound on new mail"§If Sound is on, Eudora makes a noise when new mail arrives.
	Open ‘In’ Mailbox [on]

	xe "Open ÔInÕ Mailbox option"§xe "Checking Mail:Automatically opening In mailbox"§xe "In mailbox:Opening on new mail"§If Open ‘In’ Mailbox is on, Eudora automatically opens the In mailbox when new mail arrives. It also scrolls to the end of the mailbox and selects the first unread message of the last unread batch of messages. If this option is off, Eudora doesn’t open the In mailbox when new messages arrive. It does, however, place the messages in the mailbox in the same order.
	Switch Messages With Options

	xe "Switches dialog:Switch Messages With options"§These options allow you to use the arrow keys to toggle through messages.
	
	The Switch Messages With section of the Switches dialog
	Plain Arrows: [off]


	xe "Arrow keys"§xe "Plain Arrows option"§xe "Next message, going to"§If Plain Arrows is on and there is a message window open on the screen, the arrow keys can be used to close the current message and open the next or previous message in the mailbox. The up or left arrow key opens the previous message; the down or right arrow key opens the next message. If this option is off, the arrow keys can be used to move the insertion point in messages.
	xe "Arrow keys:Composition windows and"§Note: Even if Plain Arrows is on, the arrow keys do not switch messages if there is a message composition window topmost on the screen.
	Ctrl-Arrows: [on]

	xe "Arrow keys"§xe "Ctrl-Arrows option"§If Ctrl-Arrows is on, message switching using the arrow keys (as described in the Plain Arrows section above) is permissible only when the [Ctrl] key is depressed.
	xe "Arrow keys:Composition windows and"§Note: The Ctrl-Arrows keystrokes do not work when composition windows are topmost on the screen.
	Miscellany Options

	xe "Switches dialog:Miscellany options"§These options control miscellaneous Eudora functions.
	
	The Miscellany section of the Switches dialog
	Show All Headers [off]


	xe "Show All Headers option"§xe "Message:Incoming:Headers"§If Show All Headers is on, Eudora displays the complete header, including routing information, with the message. If this option is off, Eudora withholds this additional information.
	Zoom Windows [off]

	xe "Zoom Windows option"§If Zoom Windows is on, new message windows automatically open to their “zoomed” size. The zoomed size is computed on a window-by-window basis. xe "Message:Incoming:Zooming windows"§Zoomed size is just long enough to display all of the message (but no longer than the main window), and as wide as the xe "Message Window Width setting"§Message Window Width setting in the Configuration dialog. xe "Message:Outgoing:Zooming window"§Composition windows zoom to the height specified by the xe "Message Window Height setting"§Message Lines setting in the Configuration dialog.
	Easy Delete [off]

	xe "Easy Delete setting"§xe "Message:Deleting:Unread/Queued"§If Easy Delete is on, Eudora does not alert you when you are deleting messages you haven’t read or transferring queued messages out of the Out mailbox.
	Mailbox Superclose [off]

	xe "Mailbox Superclose option"§xe "Message:Closing"§If Mailbox Superclose is on, closing a mailbox window closes all open messages from that mailbox.
	Empty Trash On Quit [on]

	xe "Empty Trash On Quit option"§If Empty Trash On Quit is on, Eudora empties the xe "Trash mailbox"§Trash mailbox whenever you quit the application. If this option is off, Eudora only empties the Trash when you select Empty Trash from the Special menu.
	Note: If you want to remove some messages from the trash but don’t want to empty it entirely, highlight the summaries you want to delete and select Delete from the Message menu. The selected messages are deleted.
	Easy Open [on]

	xe "Easy Open option"§If Easy Open is on, deleting or transferring an open message opens the next message in the mailbox, but only if that next message is unread.
	Show Progress [on]

	xe "Show Progress option"§If Show Progress is on, Eudora displays a xe "Progress window:Enabling/disabling"§Progress window at the top of your screen to advise you of progress made when making a network connection, transferring mail or some other long operation.
	Auto-Ok [on]

	xe "Auto-Ok option"§xe "Alerts:Timing out"§Many network problems are temporary. When a problem occurs while Eudora is transferring or checking your mail, you are notified in the same way you would be if you were receiving new mail (see the “New Mail Notification: Options” section). If Auto-Ok is on, these notifications automatically go away after a couple of minutes. This allows Eudora to try the communication again. This setting is most useful if you have a non-zero value for the Check for mail every ? minute(s) setting in the Configuration dialog.
	Quitting Eudora
	xe "Quitting"§To quit the Eudora program, select Exit from the File menu. If you have queued messages, or timed messages due to be sent in the next 12 hours, you are asked if you want to send them (see the “Quitting with Queued Messages” section). If the Empty Trash on Quit option in the Switches dialog is turned on, quitting Eudora also empties your Trash mailbox.
	Mail Storage
	xe "Mail Storage"§When you install Eudora, it creates a number of files within the assigned directory. In addition, Eudora creates additional files as needed for mailboxes, signatures, and other settings. The Eudora files are described below.
	
	Typical Eudora directory contents

	eudora.ini

	Your Configuration and Switches information is saved in the eudora.ini file, along with other information. This file contains notes that describe each entry.
	nndbase.txt

	Your nicknames are saved in the nndbase.txt file.
	nndbase.toc

	This file is the table of contents for your nicknames.
	in.mbx, out.mbx, trash.mbx

	xe "Mail Storage:Mailboxes"§These files hold your mail. You’ll see files like these for every mailbox you create.
	Note: These files are in xe "UNIX mail"§UNIX mail format.
	in.toc, out.toc, trash.toc

	xe "Mail Storage:Mailboxes:Contents"§These files are the tables of contents for your mailboxes. They make it much faster for Eudora to access your mail. You’ll see files like these for every mailbox you create.
	eudora.log, old.log

	Eudora can keep records of all mail transfers. These records are kept in the eudora.log and old.log files. The old.log file is overwritten and a new eudora.log file is created when the eudora.log file reaches its approximately 100K maximum size. To enable logging, set the LogLevel entry in the [Debug] section of the EUDORA.INI file.
	signatur.pce

	The signature is kept in the signatur.pce file.
	descmap.pce

	Mappings between mailbox names and DOS 8.3 file names are stored in the descmap.pce file.
	Sharing a PC with Other Users
	xe "Sharing a PC"§If you are sharing a PC with other users, make a separate mail directory and create a separate program item for each user. The directories can be named whatever you like, and put anywhere you like, including on floppies or network volumes. To tell Eudora which directory to use, specify that directory as the first parameter on the Command Line of the Program Item Properties dialog.
	
	Specifying a mail directory


	Summary of Eudora Menu Commands
	File

	xe "File menu"§This menu provides basic file and mail program functions.
	
	Close

	Close the current window.
	Save

	Save changes to the contents of the topmost window. This applies to composition windows, signature windows, and the Nicknames window.
	Save As...

	Save the current message(s) to a plain text file.
	Send Queued Messages

	Send all messages that have been queued for delivery.
	Check Mail

	Pick up new mail from the POP server. The time in parentheses indicates the next time Eudora will automatically check for mail.
	Print Setup...

	Set printing options.
	Print...

	Print the current message(s) or Ph window.
	Exit

	Exit the Eudora application.
	Edit

	xe "Edit menu"§This menu provides text editing and sorting tools.
	
	Undo

	Reverses the last editing action taken on a piece of text.
	Cut

	Delete selected text and place it on clipboard.
	Copy

	Copy selected text and place it on clipboard.
	Paste

	Place contents of clipboard at chosen insertion point in message.
	Paste as Quotation

	Place contents of clipboard at insertion point, with ‘>’ characters at the beginning of each line to denote quoted text.
	Clear

	Delete selected text.
	Select All

	Select entire contents of message or mailbox.
	Show Insertion Point

	Scroll selection or insertion point into view.
	Insert Recipient

	Insert the chosen nickname/address from the Quick Recipient list at the insertion point.
	Find submenu

	Search for designated text or character string within message(s).
	Sort submenu

	Sorts message summaries in a mailbox. Hold down the [Shift] key to reverse the order of the sort.
	Mailbox

	xe "Mailbox menu"§This menu lets you open a mailbox, or bring an open mailbox to the front.
	
	In

	Open mailbox where incoming messages are stored until deleted or transferred to another mailbox.
	Out

	Open mailbox where messages you compose are stored, and where queued messages are held until actually sent, and where copies of sent messages may be initially stored.
	Trash

	Open mailbox where deleted messages are stored.
	New...

	Display New Mailbox dialog to create a new mailbox.
	[Your Mailboxes]

	Mailboxes you create are also displayed in this menu.
	Message

	xe "Message menu"§This menu lets you create and delete messages.
	
	New Message

	Open new message composition window.
	Reply

	Reply to the sender of the current message.
	Forward

	Forward the current message to someone else.
	Redirect

	Forward the current message to someone else, but make the return address be the person who originally sent the message.
	Send Again

	Resend a message rejected by the mail system. Be sure to fix whatever caused the problem.
	New Message To

	Send a message to someone on the Quick Recipient list.
	Reply To

	Reply to the current message, but send the reply to someone on the Quick Recipient list.
	Forward To

	Forward the current message to someone on the Quick Recipient list.
	Redirect To

	Redirect the current message to someone on the Quick Recipient list.
	Queue For Delivery/Send Immediately

	Save the message in the Out mailbox and mark it as queued (ready to be delivered), or send it immediately.
	Change Queueing...

	Queue a message, unqueue a queued message, or set a message for timed send.
	Attach Document...

	Attach file(s) to the current message.
	Delete

	Transfer the current message to the Trash mailbox; also used for deleting messages from the Trash mailbox.
	Transfer

	xe "Transfer menu"§This menu lets you transfer current message(s) to the selected mailbox.
	
	In

	Transfer the current message(s) to the In mailbox.
	Trash

	Transfer the current message(s) to the Trash mailbox.
	New...

	Display New Mailbox dialog to create a new mailbox; current message(s) may be transferred into that mailbox.
	[Your Mailboxes]

	Transfer the current message(s) to the selected mailbox that was previously created by you.
	Special

	xe "Special menu"§This menu provides additional Eudora functions.
	
	Make Nickname...

	Create abbreviations for addresses in the current message.
	Add As Recipient

	Add selected text to the Quick Recipient list.
	Remove Recipient

	Select a recipient from this menu and the recipient is removed from the Quick Recipient list.
	Empty Trash

	Delete all messages from the Trash mailbox.
	Compact Mailboxes

	Reclaim unused space in mailboxes.
	Configuration...

	Display the Configuration dialog.
	Switches...

	Display the Switches dialog.
	Forget Password

	Make Eudora ask for your password the next time it checks for mail.
	Change Password

	Change your password on the POP server computer. This requires a special server.
	Window

	xe "Window menu"§All Eudora window titles are listed in this menu. Select one to open it or bring it to the front.
	
	Cascade

	Cascade open windows.
	Tile

	Tile open windows.
	Arrange Icons

	Arrange all icons at the bottom of the main window.
	Send to Back

	Send the topmost current window to the back of all displayed windows.
	Mailboxes

	Display the Mailboxes window.
	Nicknames

	Display the Nicknames window.
	Ph

	Display the Ph window.
	Signature

	Display the Signature window.
	[Mailbox and Message Windows]

	Toggle between open mailboxes.
	Help

	xe "Help:Menu"§The Eudora Help menu and About Eudora screen are listed in this menu.
	
	Contents...

	Display the on-line help contents.
	Search for Help on...

	Display a list of search topics.
	How to Use Help

	Display the Microsoft Windows How to Use Help window.
	QUEST Mailing List...

	Subscribe to/unsubscribe from the QUEST mailing list.
	About Commercial Eudora...

	Display the About Commercial Eudora screen.
	About Eudora...

	Display the About Eudora screen.

	Appendix A – Sources
	Anonymous ftp (ftp.qualcomm.com)
	xe "ftp.qualcomm.com"§QUALCOMM has an anonymous ftp server (ftp.qualcomm.com) that has information and software related to Eudora. These are located within the “quest” directory. Included are POP3, Ph, and password changing servers, current product information and more.
	Eudora Information
	xe "Eudora Information"§The information in this manual was correct at the time of printing. However, things happen very quickly in the electronic world, meaning that some of this information may already be out of date. For the very latest information about Eudora, send e-mail to eudora-info@qualcomm.com.
	Obtaining a POP Server
	xe "POP:Server for"§xe "POP:Server for:UNIX"§If you would like to run a POP server on your own UNIX system, we suggest you use “xe "Popper"§popper.” Popper is available via anonymous ftp from ftp.qualcomm.com.
	xe "POP:Server for:VAX/VMS"§VAX/VMS systems may try the “Multinet” package from TGV, or IUPOP3, available via anonymous ftp from ftp.indiana.edu.
	xe "POP:Server for:VM/CMS"§For VM/CMS users, there is a port of “popper” available via anonymous ftp from vmd.cso.uiuc.edu (cd to the “POPD” directory).
	Ph Server Source Code
	xe "Ph:Server source code"§A server for the “Ph” protocol is available via anonymous ftp from ftp.qualcomm.com.
	Password Change Server
	xe "Password:Changing:Server source code for"§Three sample UNIX servers for Eudora’s “Change Password” command are available via anonymous ftp from ftp.qualcomm.com.
	Windows Sockets Products
	xe "Windows Sockets"§Demos of Windows Sockets 1.1 compliant stacks and applications are available via anonymous ftp from sunsite.unc.edu in the directory micro/pc-stuff/ms-windows/winsock.
	Serial Line IP (SLIP)
	xe "Serial Line IP (SLIP)"§xe "SLIP"§Information and applications regarding Serial Line IP (SLIP) are available via anonymous ftp from biochemistry.cwru.edu in the directory /slip.
	PC Speaker
	If you want the new mail sound notification to work with the speaker that comes with your PC, you need to install the PC speaker driver. This driver is available via anonymous ftp from ftp.qualcomm.com. It’s the file SPEAK.EXE in the directory quest/eudora/windows/utils. This is a self-extracting archive, so just run it on your PC to produce the necessary files and instructions.

	Appendix B – Shortcuts
	Modifier Keys
	Many operations in Eudora can be affected by holding down one or more “modifier” keys. Eudora uses the [Shift] and [Ctrl] keys as modifiers.
	The [Shift] key is usually used to make an operation to reverse option settings.
	· [Shift] + Reply toggles the “Reply to all” option in the Switches dialog. If the Reply to all option is turned on, Shift + Reply generates a reply to the sender only. If the Reply to all option is turned off, Shift + Reply generates a reply to all addresses in the message header.
	· [Shift] + Transfer sends a copy of the current message to the selected mailbox and retains the original message in the original mailbox.
	Other Important keys
	The arrow keys, depending on the settings in the Switches dialog, can move you from one message to another in a mailbox. If the Plain Arrows or Ctrl-Arrows option in the Switches dialog is turned on,
	The [Enter] key performs several different functions:
	The [Esc] key stops any operation currently in progress.
	If you have an extended keyboard, the following keys are also useful:
	[Ctrl] + Key Equivalents
	[Ctrl] + [A] Select all
	[Ctrl] + [B] Move window behind all other windows
	[Ctrl] + [C] Copy
	[Ctrl] + [D] Delete message
	[Ctrl] + [E] Queue/Send an outgoing message
	[Ctrl] + [F] Open Find window (search for message)
	[Ctrl] + [G] Find again
	[Ctrl] + [H] Attach document to outgoing message
	[Ctrl] + [I] Open In mailbox
	[Ctrl] + [K] Make nickname
	[Ctrl] + [L] Open Nicknames window
	[Ctrl] + [M] Check mail
	[Ctrl] + [N] New message
	[Ctrl] + [P] Print message
	[Ctrl] + [Q] Quit Eudora
	[Ctrl] + [R] Reply to message
	[Ctrl] + [S] Save contents of topmost window
	[Ctrl] + [T] Send queued messages
	[Ctrl] + [U] Open Ph window
	[Ctrl] + [V] Paste
	[Ctrl] + [W] Close message
	[Ctrl] + [X] Cut
	[Ctrl] + [Z] Undo
	[Ctrl] + [']	Paste as quote

	Appendix C – Mail Transport
	Introduction
	Eudora uses Simple Mail Transfer Protocol (SMTP) xe "Simple Mail Transfer Protocol"§xe "SMTP"§to transfer your outgoing mail to your SMTP server machine, which in turn uses SMTP to send your mail to the world at large. Mail from the world at large arrives on your Post Office Protocol (POP) serverxe "POP server"§, where it waits for Eudora to pick it up with Post Office Protocol, version 3 (POP3)xe "POP3"§. The mail Eudora sends and receives is constructed in accordance with RFC 822 and RFC 1521 (MIME).
	µ §
	Eudora mail transport overview

	Outgoing Mail

	When you send an e-mail message to someone, Eudora uses SMTP to send the mail to your local SMTP server computer. That computer then sends the mail to your addressee’s computer, also (usually) by means of the SMTP protocol.
	Why doesn’t Eudora talk directly to your addressee’s computer? For one thing, it would take a lot longer for your mail to leave your PC, because your PC would have to call up each addressee’s computer and deliver your mail. For another, some computers are “hard to find;” it’s much better to let another computer “hunt” for your addressee than to make your PC do it. Finally, sometimes your addressee’s computers won’t be available when you want to send mail. The SMTP server handles this by holding your mail until the other computer is ready to accept it, eliminating the inconvenience of having unsent messages hanging around on your PC.
	Incoming Mail

	When somebody sends you mail, other computers use the SMTP protocol to deliver the mail to your POP server. Your POP server puts mail in your “mail drop,” where it stays until the Eudora program picks it up. When you check your mail, Eudora uses POP3 to pick up your mail and move it to your PC.
	Why doesn’t Eudora use SMTP to receive your mail? xe "SMTP"§SMTP works best when the computers it knows about are always ready for mail. Unless you wanted to run Eudora and your PC 24 hours per day, seven days a week, SMTP wouldn’t work very well for you. It also doesn’t work well in lab environments, where you might use any number of different PCs.
	More Information

	If you want to know more about the Internet in general, consult the book Internetworking with TCP/IP, by Douglas Comer, 1988, Prentice-Hall ISBN 0-13-470154-2 025.
	If you want to know more about SMTP, RFC 822, POP3 and MIME, the official standards are:
	RFC 821, “Simple Mail Transfer Protocol,” by Jonathan B. Postel
	RFC 822, “Standard for the Format of Internet Text Messages,” by Dave Crocker
	RFC 1225, “Post Office Protocol, Version 3,” by Marshall Rosexe "RFCs;RFC 1225, ÒPost Office Protocol, Version 3,Ó by Marshall Rose"§
	RFC 1521, “Multipurpose Internet Mail Extensions,” by Ned Freed and Nathaniel Borenstein
	You can find the RFC’s by anonymous ftp to nic.ddn.mil; see Internetworking with TCP/IP for details.

	Appendix D – MIME and Mapping
	What is MIME?
	xe "MIME"§“MIME” stands for Multipurpose Internet Mail Extensionsxe "Multipurpose Internet Mail Extensions"§. MIME serves two major purposes – it allows mail applications to tell one another what sort of data is in mail, and it also provides standard ways for mail applications to encode data so that it can be sent through the Internet mail system.
	MIME Encoding
	The Internet uses the “SMTP” protocol to move mail around. xe "SMTP"§SMTP is limited to the US-ASCII character set (see Appendix C). This is a problem for people who speak languages other than American English and so need accented characters or non-American letters, or for people who want to use special symbols like the bullet.
	MIME provides a way around this restriction. It offers two encodings, “quoted-printable”xe "MIME:Quoted-printable encoding"§ and “base64.”xe "MIME:Base64 encoding"§ These encodings use US-ASCII character codes to represent any sort of data you like, including special characters or even non-text data.
	Quoted-printable is used for data that is mostly text, but has special characters or very long lines. Quoted-printable looks just like regular text, except when a special character is used. The special character is replaced with an “=” and two more characters that represent the character code of the special character. So, a bullet in quoted-printable looks like “=95.”
	However, there are some other things that quoted-printable does. For one, since it uses an “=” to mean something special, equal signs must themselves be encoded (as “=3D”). Second, no line in quoted-printable is allowed to be more than 76 characters long. If your mail has a line longer than 76 characters, the quoted-printable encoding will break your line in two, and put an “=” at the end of the first line, to signal to the mail reader at the other end that the two lines are really supposed to be one. Finally, a few mail systems either add or remove spaces from the ends of lines. So, in quoted-printable, any space at the end of a line gets encoded (as “=20”) to protect it from such mail systems.
	Let’s try an example. Here’s a passage of text that you might type on your PC:
	Without any encoding, this might show up on your recipient’s screen as:
	This corruption happens because SMTP cannot handle the special characters. However, if you and your recipient both have MIME, quoted-printable encoding would be used, and your text would show up properly:
	While your mail was actually in transit, however, it would have looked like:
	Base64 encoding is another way to protect binary data from the SMTP mail system. However, Base64 makes no attempt to be legible, and is most appropriate for non-text data.
	MIME Labelling
	The other important part of MIME is that it lets mailers communicate what kind of data is in a message (or part of a message). The primary mechanism used for this is the Content-Type headerxe "MIME:Content-type header"§:
	Content-Type: text/plain; charset=iso-8859-1
	A content-type header is divided into three parts; the content type, the content subtype, and the parameters. In this case, the content type is “text,” meaning the message contains mostly legible text. The content subtype is “plain,” which means there aren’t any formatting commands or anything like that embedded in the text. Finally, “charset=iso-8859-1” is a parameter; in this case, it identifies the character set the message uses.
	The major content types are:
	text legible text
	image pictures and graphics
	audio sound
	video moving pictures
	message messages or pieces of messages
	multipart several different kinds of data in a single message
	Practical Issues
	There are really only two things you sometimes need to do with Eudora and MIME. One is that it may occasionally be necessary to turn off quoted-printable encoding. Another is that you may want to know how to define mappings between PC file extensions, MIME types, and Macintosh types.
	Turning Off Quoted-Printable Encoding

	xe "Quoted-printable:Turning off"§Eudora automatically uses quoted-printable encoding if your mail contains special characters. Eudora also uses quoted-printable encoding for attached plain text files. If your recipients don’t have MIME, quoted-printable may hurt more than it helps. If that’s the case, just turn off the QP button in the message icon bar when you are sending text files to those recipients.
	
	Turning off Quoted-Printable Encoding

	Mapping Between File Extensions, MIME Types, and Macintosh Types

	xe "MIME:Mapping"§xe "MIME:Types"§xe "MIME:Macintosh types"§Eudora has the ability to map between file extensions, MIME types and subtypes, and xe "MIME:Macintosh creators"§Macintosh creators and types. Messages received by Eudora can grab the MIME type/subtype and/or Macintosh creator/type from an attachment and map that into the correct file extension. Also, on outgoing messages, Eudora can make sure that attachments are encoded with the correct MIME type/subtype and/or Macintosh creator/type depending on the file extension of the attachment being sent.
	Eudora knows about some MIME types. However, since new MIME types are being defined all the time, it may be necessary to add to Eudora’s knowledge from time to time. Adding new mappings between the various types only requires editing the EUDORA.INI file with a text editor (like the one that comes with Eudora).
	There is a section in the EUDORA.INI file labelled [Mappings], followed by some entries, one per line. Each entry is called a map. A map defines when the mapping should occur (which can be “in,” “out,” or “both”), followed by an equal sign and five parameters. These five parameters are (in order) the PC file extension, the Macintosh creator code, the Macintosh type, the MIME type, and the MIME subtype. Here are some sample entries:
	A map marked “in” only tries to match the map to messages that you receive. A map marked “out” only tries to match the map to messages that you send. A map marked “both” tries to match the map to both incoming and outgoing messages.
	The first map says that any incoming MIME message that has a part type of “image” and subtype of “gif” will get saved to a file with the extension “.gif.” It also specifies that outgoing messages that have an attachment with the file extension “.gif” will get the MIME type of “image” and subtype of “gif” if the encoding method of the message is MIME. The second map is similar to the first map in structure, but uses a different file extension and MIME type and subtype.
	You can use map entries to move between PC file extensions and Macintosh creator and type as well. The third map says that if an incoming message has an attachment with the Macintosh creator “MSWD” (which is the Macintosh creator for Microsoft Word) then the file extension of the attachment when saved to disk should be “.doc” (the file extension that Word for Windows uses). Since the map is marked as “both,” it will also give attachments with the extension “.doc” on outgoing messages the Macintosh creator of “MSWD” if the encoding method of the message is BinHex.
	Note that the Macintosh type from this map is empty. This allows multiple types to be recognized with just one mapping. The is nice for “in” maps because it allows you to cover a range of creator/type pairs with one map. You must be careful in using this type of map with an “out” or “both” mapping, though, because an outgoing attachment that matched this map would have a Macintosh creator, but no Macintosh type. Some Macintosh applications cannot open files with a missing type. Microsoft Word for the Macintosh can open files without a type, so this map is fine being marked “both.”
	Microsoft Excel for the Macintosh is an example of a program that can't open a file with an empty type.  This is why there are two maps for Excel (the fourth and fifth maps above).  The incoming map for Excel is like the one for Microsoft Word, but the outgoing map explicitly defines the Macintosh type.
	The last map shows that you can have both Macintosh creator/type and MIME type/subtype in one entry. This map says that if an incoming message has an attachment that is encoded in MIME and has the “application/postscript” type/subtype, or has a BinHex attachment with the Macintosh type of “EPSF,” then the resulting file will have an extension of “.eps.” Similarly, if an outgoing message has an attachment with the extension “.eps” and if the MIME encoding is being used for the message, then the attachment will get the “application/postscript” MIME type/subtype. If the message was using the BinHex encoding, then the attachment would get the Macintosh type of “EPSF.”
	But what happens if an attachment matches more than one map? Eudora will try and find the best match. For example, if you had the following [Mappings] section:
	and you received a message with an attachment that had a Macintosh creator of “XCEL” and a Macintosh type of “XLC3” (a Microsoft Excel Chart), then the file would get an extension of “.xlc” since the first map only matched the Macintosh creator, but the second map matched both the Macintosh creator and type.
	Eudora can receive attachments that have both a MIME type/subtype and a Macintosh creator/type. Eudora understands attachments with the MIME type/subtype “application/applefile,” which has Macintosh creator/type information embedded in it. With this type of attachment, Eudora will consider a match with the Macintosh creator/type as a “better” match than a match with the MIME type/subtype.
	Finally, if an incoming attachment matches two different maps to the same degree (e.g., both maps have the same MIME type/subtype with different file extensions), then Eudora will use the file extension in the first matching map.
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